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Introduction

l aptop owners are special people.

You see, a laptop owner demands everything from a computer that a desktop
owner does: reliability, performance, expandability, and ease of use. Owners
of PowerMac desktop computers can draw the line right there, because their
computers are designed for a stationary existence. But, you and I are laptop
owners. We also need that same computer to be an inch thick. We demand
that it run for hours on a single battery charge. We require that it be light as a
feather.

Today’s Apple laptops deliver all that, and more! If you've bought one of
these modern masterpieces — or you're thinking about it right now — |
applaud your good taste, common sense, and discerning eye. Apple laptops
have everything: super performance, a top-shelf LCD screen, rugged reliabil-
ity, and a trouble-free, powerful operating system. Heck, your Intel-based
Apple laptop can even run . . . wait for it . . . Windows XP. (If you absolutely
have to, the option is there.)

[ wrote this book for myself — and for every other Apple laptop owner who
desires to become a laptop techno-wizard. In these pages, you'll find a guide
to both your laptop’s hardware and Mac OS X Tiger, the latest version of
Apple’s superb operating system. After I cover the basics that every laptop
owner should know, you find out how to accomplish all sorts of cutting-edge
audio, visual, and Internet projects. (Oh, and if you already have another of
my books, you know that I don’t skimp on the power user tips and tricks
that’ll save you time, effort, and money.)

Like my dozen-or-so other For Dummies titles, | respect and use the same
English language you learned in school, avoiding jargon, ridiculous computer
acronyms, and confusing techno-babble whenever possible. (Plus, [ try to
bring out the humor that’s hidden inside every computer. Finding out how to
use your Mac should be fun, and not a chore!)

What's Really Required

If you're not an engineer with a degree in Advanced Thakamology — imagine
that — there’s no need to worry! Here’s a reasonably complete list of what’s
not required to use this book:
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v [ make no assumptions about your previous knowledge of computers —
laptop or otherwise — and software. We start at the beginning, which is
where every book should start.

v~ Still considering buying a MacBook or MacBook Pro? Heck, you don’t
even need the computer! If you're evaluating whether or not a Mac
laptop is right for you, this book is a great choice — I introduce you to
both the hardware and software you’ll get, so you can easily determine
whether a Mac is the machine for you. (It is. Trust me.)

v Upgrading from the monster that is Windows XP? I have tips, tricks, and
entire sections devoted to the hardy pioneers called switchers! You'll dis-
cover the similarities and differences between the two operating sys-
tems, how you can make the switch as easy and quick as possible, and
how to run Windows on your new laptop, if you absolutely must.

v If your friends and family have told you that you're going to spend half
your savings on software — or that there’s no decent software available
for Mac computers — just smile quietly to yourself! These are two per-
sistent myths about Mac computers, and those same folks are going to
be blown away by the images, music, movies, and documents you pro-
duce. (Oh, by the way, your Mac laptop comes complete with about a
ton more software than any PC, laptop, and the iLife suite of applications
are better than anything available on a PC is!) To sum up: You can do vir-
tually everything in this book with the software that came with your Mac!

So what is required? Your Mac laptop and the desire to become a power
user — someone who produces the best work in the least amount of time
and has the most fun doing it!

This book has been written using the latest MacBook Pro computer, so
owners of older Mac laptops that aren’t running Intel processors may not be
able to follow along with everything [ cover. However, if you’ve upgraded an
older G4 laptop with Mac OS X Tiger and the iLife '06 application suite, you
should be able to use most of the book with no problem!

About This Book

Each chapter in this book has been written as a reference on a specific hard-
ware or software topic. Due to the hard work of my editors, you can begin
reading anywhere you like because each chapter is self-contained. However, |
recommend that you read from front to back, because the linear order of the
book makes a great deal of sense.
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Conventions Used in This Book

Even with a minimum of techno-speak, this book needs to cover the special
keys you have to press or menu commands you have to choose to make
things work — hence our short list of conventions.

Stuff you type

I may ask you to type a command in Mac OS X. That text often appears like
this:

Type me.
Or like this:
Type me.

Don’t forget that you usually have to press the Return key before anything
happens.

Menu command's

[ list menu commands using this format:
Edit=>Copy

This example of shorthand menu instruction indicates that you should click
the Edit menu and then choose the Copy menu item.

For the technically curious

Your MacBook is an elegant and sophisticated  disassembled alarm clocks as a kid, like | did.)
machine — and as easy-to-use as a computer  Tech stuff is formatted as a sidebar, like this one,
can be — but from time to time, you may be and you don't have to read it unless you want to
curious about the technical details surrounding  know what makes things tick. (Pun by accident.)
your hardware and software. (You probably

3
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Web addresses

No up-to-date book on a computer would be complete without a bag full of
Web addresses for you to check out. When you see these in the text, they’ll
look like this: www.mlcbooks . com.

How This Book Is Organized

After careful thought (read that “flipping a coin™), I divided this book into
seven major parts — plus an index, just because you deserve one! For your
convenience, cross-references to additional coverage of many topics are
sprinkled liberally throughout the book.

The Seven Parts Shall Be As Follows.

Part I: Tie Myself Down with
a Desktop? Preposterous!

Part I introduces you to the important features of your laptop — you'’ll find
out where all the cables connect — and helps you set up your system. | also
introduce Mac OS X Tiger, Apple’s operating system that comes preinstalled
on your MacBook or MacBook Pro.

Part II: Shaking Hands with Mac 0S X

Time to familiarize you with Tiger. In Part II, you find out how to take care of
mundane chores (such as moving your stuff), as well as how to customize
and personalize your system until it fits like the proverbial glove! Switchers
from the PC world will be especially interested in understanding the ins and
outs of Mac OS X — and friends, it ain’t hard. The Mac started out easier to
use than a Windows PC, and nothing’s changed.

Part I1I: Connecting and Communicating

In Part III, it’s time to jump into the one application you're likely to use every
day: your Safari Web browser! You'll also find out more about Apple’s .Mac
Internet subscriber service and how to connect your laptop for printing,
sharing information with your PDA or cell phone, and even videoconferenc-
ing! (I told you this thing was powerful, didn’t I?)
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Part IU: Living the iLife

Ah, readers, you can begin humming happily to yourself right this second!
Yep, Part IV provides complete coverage of the latest iLife '06 release, with
the names that are the envy of the Windows crowd: iTunes, iPhoto, iMovie
HD, iDVD, and GarageBand. You'll find out how to turn your mobile monster
computer into the hub for all your digital media — whether you listen to it,
display it, compose it, or direct it, this part of the book will explain it!

Part U: Sharing Access and Information

In Part V, I discuss how to share your Mac laptop among a group of people,
and how to connect your Mac to a network. (Wired or wireless, makes no dif-
ference to us!) I also cover how to share data among wireless devices using
Bluetooth technology and iSync, and how to broadcast your music around
your house like Wolfman Jack.

Part Ul: The Necessary Evils:
Troubleshooting, Upgrading, Maintaining

In Part VI, we cover the stuff my Dad used to call the Justin Case Guide — that
is, just in case, you want to upgrade your MacBook with more memory or
new hardware. If you need to troubleshoot a problem with your hardware or
software, check out my should-be-patented troubleshooting guide. Finally, I
describe what you can do to help keep your Mac running as fast and as trou-
ble-free as the day you took it out of the box!

Part VlI: The Part of Tens

The two chapters that make up the famous “Part of Tens” section are served
in classic Late Night style: Each chapter contains a quick reference of tips
and advice on a specific laptop or Macintosh topic. Each list has ten concise
tips, and one or two readers have told me that they make excellent tattoos.
(Personally, I'm not that much of a Mac guru.)

5
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Icons Used in This Book

\\3

Like other technology authors, I firmly believe that important nuggets of
wisdom should stand out on the page! With that in mind, this Dummies book
includes a number of margin icons for certain situations.

The most popular icon in the book, you’ll find it next to suggestions I make
that will save you time and effort — and once or twice, even cash!

These are my favorite recommendations — in fact; I'll bet just about any
laptop power user would tell you the same. Follow my Maxims, and you’ll
avoid the quicksand and pitfalls that I've encountered with all sorts of Macs
for well over a decade!

You don’t have to know this stuff, but the technologically curious love high-
tech details. (Of course, we're great fun at parties, too.)

Always read the information for this icon first! 'm discussing something that
could harm your hardware or throw a plumber’s helper into your software.

The highlighter stuff — not quite as universally accepted (or as important to
the author) as a Mark’s Maxim, but a good reminder! I use these icons to rein-
force that which should be remembered.

Where to Go from Here

My recommendations on how to proceed? I just happen to have three:

v If you're thinking about buying a new MacBook or MacBook Pro, the box
is still unopened in your living room, or you’d like help setting things up,
start with Part I.

v If you're already on the road with your laptop but you’d like guidance
with running Mac OS X — Windows switchers, take note — start with
Part IL

v For all other concerns, use the index or check out the table of contents
to jump straight to the chapter you need.
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A Final Word

I'd like to thank you for buying this book, and I hope that you find MacBook
For Dummies valuable! With this book in hand, I believe that you and your
Mac will bond as I have with mine. (That sounds somewhat wrong, but it’s
really not.)

Time for the first Mark’s Maxim in this book:
Take your time — finding out how to use your computer isn’t a race — and

don’t worry if you're not a graphic artist, a professional photographer, or a
video editor. With your Mac laptop and its software, you don’t have to be!
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Tie Myself Down
with a Desktop?
Preposterous!

The Sth Wave By Rich Tennant
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Good thing T had
my laptop with me.

Try turning it
over now/




In this part . . .

our journey as a Mac road warrior — pun intended —

begins with a description of your laptop itself, as well
as the details you need to know when unpacking and set-
ting up your newest family member. You’ll also find an
introduction to Mac OS X Tiger, the latest version of
Apple’s super-popular operating system.




Chapter 1

Hey, It Really Does Have
Everything | Need

In This Chapter

Identifying the important parts of your Mac laptop
Locating the right home for your computer
Plugging stuff in and getting hooked up

Playing with your bundled software

Buying additional stuff that you might need

M ost action films have one scene in common: I call it the “gear up” scene,
where the good guys strap on their equipment in preparation for battle.
(It doesn’t matter what era — you see “gear up” scenes in Gladiator, Aliens,
and virtually every movie Arnold has made.) You're sure to see lots of clicking
straps and equipping of offensive weapons (and sometimes even a dash of war
paint). The process usually takes a minute or so, all told with whiplash camera
work and stirring martial music in the background.

Well, fellow Macintosh road warrior, it takes only two seconds and one move
for you to gear up: closing the lid. That’s because your Mac is a self-contained
world, providing virtually everything you’ll find on a desktop Power Mac.
This is indeed the decade of the laptop, meshing nicely with your cell phone
and that wireless connection at your local coffee shop. You have selected the
right companion for the open road.

Unlike some of Apple’s other designs, such as the Mac Mini or the iMac, your
MacBook looks similar to a PC laptop running Windows. (In fact, an Intel-
based Mac laptop can run Windows, if you absolutely must.) But your laptop
holds a number of pleasant surprises that no PC laptop can offer! In this
chapter, I introduce you to the hardware and all the major parts of the
machine — and you’ll even find out how to unpack and connect your com-
puter. And, as frosting on the cake, I'll preview the software that Apple is so
proud of, as well as the accessories that you should buy now instead of later.

Welcome to your Mac laptop, good reader. Let’s gear up!
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An Overview of Your Mac Laptop

Sure, your MacBook Pro may be only an inch thin, but a lot of superb design
lives inside, and you’ll encounter the same parts that you'd find in a desktop
machine. In this section, [ discuss those important parts — both the stuff you
can see and the stuff that’s shoehorned within.

The parts you probably recognize

Every laptop requires some of the same gizmos. Figure 1-1 helps you track
them down. Of course, as you’'d expect, a computer has a body of sorts in
which all the innards and brains are stored, a display screen, a keyboard, a
mouse or other pointing device, and ports for powering and exchanging data
with outside toys.

That magnificent screen

What a view you have! Today’s Mac laptops feature a 13", 15", or 17" LCD
display.

LCD screens use far less electricity than their antique CRT ancestors do, and
they emit practically no radiation.

iSight camera

LCD screen

|
Figure 1-1:
The
charismatic
form of a
typical Mac
laptop.
|

Disc slot Remote

Keyboard Trackpad
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Feeling outdated? Never!

Are you using an older iBook or PowerBook? It
seems that Apple’s product line changes every
time you tear a page from your 12-month calen-
dar, and every new generation of laptops
includes new whiz-bang features. Sometimes
you can add those features separately to your
older machine — such as an external iSight
camera or an AirPort Extreme card — but you
can't update things like your iBook’s mother-
board. Sigh.

Here's my take on this situation: If your older
laptop does what you need at a pace you can
accept, there is no needto upgrade it.

Skeptical? Here's the proof: Before my recent
upgrade to a MacBook Pro, yours truly was lug-
ging a pristine iBook G3, which booted Tiger and
did absolutely everything that | demanded. (A little

more patience was required, certainly, but tech-
nology authors are simply brimming with
patience.) The moral is here too: Avoid the upgrade
fever unless you really need a new companion!

If your laptop bears the iBook or PowerBook
logo, you can still enjoy this book and discover
new tips and tricks from it! Unless the new
breed of Intel-based Mac laptops has a feature
that you absolutely can’t use on your iBook
(such as booting directly into Windows), you
can sail on with your current computer, fiercely
proud of The Bitten Apple that appears on the
cover. Although this book was written with the
MacBook and MacBook Pro lines in mind, vir-
tually everything you read here still applies to
your older laptop.

\\3

Apple’s laptop screens offer a widescreen aspect ratio (the screen is consider-

ably wider than it is tall), which augurs well for those who enjoy watching

DVD movies. (A favorite editor of mine loves it when I use the antique word

augur, meaning fo predict or foretell.)

That reminds me: Throw away your printed dictionary! You won’t need it
because Mac OS X Tiger includes the fantastic Sherlock application, which
uses the Internet to retrieve definitions from Dictionary.com. More on
Sherlock in Chapter 7. . . and yes, it does contain augur.

The keyboard and trackpad

Hey, here’s something novel for your laptop — unlike the external input
devices on a standard desktop computer, your Mac has a built-in keyboard

and trackpad (which does the job of a mouse). The keyboard is a particular

favorite of mine because from here

v You can either control the sound volume or mute all that noise

completely

v High-end Mac laptops have illuminated keyboards, which are perfect for

darkened dorm rooms and airplane flights

v A handy-dandy Media Eject key lets you eject a CD or DVD

13
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The disc slot

You'll notice a long groove at the bottom-right corner of your MacBook or
MacBook Pro. No, it’s not for your credit card. This slot accepts CDs and
DVDs into your optical drive. If the drive is empty, loading a disc is as simple
as sliding it in an inch or so; the drive sucks in the disc automatically. (And
we don’t need a stinkin’ floppy. Macs haven’t had floppy drives for years now,
and the PC types are just beginning to follow.)

“Luke, the printed label side of the disc should always be facing you when
you load a disc. Always.”

Food for your ears

A machine this nice had better have great sound, and the Mac doesn’t disap-
point. You have a couple of options for Mac laptop audio:

v Mac laptops sport built-in stereo speakers (and a microphone to boot).

v Use built-in optical/digital Line Out ports to connect your Mac’s audio to
a pair of headphones, or a more powerful (and expensive) external
speaker system, or a home stereo system.

The power cable

Sorry, can’t get a wireless power system . . . yet. (Apple’s working hard on
that one.) However, the MacBook Pro was the first major release of a laptop
with a magnetic power connector; the MacBook followed suit soon after. The
MagSafe connector reduces the chances of your pride and joy being yanked
off a desk when someone trips over the power cord. Now that’s sassy.

The Apple remote

Oh, here’s a pleasant surprise that you won'’t find with most PC laptop boxes:
the remote looks like an iPod Shuffle, but it allows you to control your laptop
wireless from across the room. (Think DVD viewings, presentations, and lazy
iTunes listening.)

The power button
Yep, you have one of these, too. It’s on the upper right, next to the keyboard.

The iSight camera

Have you noticed that tiny square lens above your screen? That’s a built-in
iSight camera, which allows you to chat with others in a videoconferencing
environment using Tiger’s iChat feature. You can even take photos with it,
using the PhotoBooth software that comes with your laptop, or set up a
travelin’ Webcam.



Chapter 1: Hey, It Really Does Have Everything | Need ’5

\\J

The battery compartment

You can open the cover on the bottom of your laptop to switch batteries.
Many road warriors who constantly use their laptops for extended periods
swear by extra batteries, especially if they’re on site in the middle of nowhere
and there’s not an AC outlet to be found.

Of course, your laptop automatically charges the battery while it’s plugged
in, so you shouldn’t have to remove the battery unless you're replacing it or
switching it with another battery.

The holes called ports

The next stop on your tour of Planet Laptop is Port Central — those rows of
holes on the sides of your computer. Each port connects a different type of
cable or device, allowing you to easily add all sorts of functionality to your
computer.

Each of these stellar holes is identified by an icon to help you identify it.
Here’s a list of what you'’ll find, and a quick rundown on what these ports do.

Connections for external devices and networking:

v FireWire: These ports are the standard in the Apple universe for con-
necting external hard drives and DVD recorders, but they do double-
duty as the connector of choice for peripherals like your iPod and your
digital video (DV) camcorder. (A peripheral is another silly techno-nerd
term that means a separate device you connect to your computer.)
Depending on the model of laptop you chose, you’ll have one of the
older FireWire 400 ports, and you may also have a much faster FireWire
800 port.

v USB: Short for Universal Serial Bus, the familiar USB port is the jack-of-
all-trades in today’s world of computer add-ons. Most external devices
that you want to connect to your laptop (such as portable hard drives,
scanners, and digital cameras) use a USB port. Depending on the model
of laptop, you’ll have either two or three USB 2.0 ports available. USB 2.0
connections are much faster than the old USB 1.1 standard, but they still
accept USB 1.1 devices running at the slower speed.

Get the lowdown on FireWire and USB ports in Chapter 20.

v Ethernet: Today’s Mac laptops include a standard 10/100/1000 Ethernet
port, so the laptop is ready to join your existing wired Ethernet network.
(Alternatively, you can go wireless for your network connection; more
on that in the next section and in Chapters 17 and 20.)
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v ExpressCard/34: When you need the absolute fastest performance pos-
sible from an external device, you can connect that device to your
laptop using the ExpressCard slot. These cards are the descendants of
the popular PCMCIA (or PC Card) cards, which many models of older
Mac PowerBooks and iBooks can use.

Connections for external video and audio:

v VGA/DVI connector: In case that splendid screen isn’t good enough, you
can buy an adapter for this port that allows you to send the video signal
from your laptop to another VGA or DVI monitor, or even S-Video output
for your TV and VCR.

v Headphone/Optical Output: You can send the high-quality audio from
your rectangular beast to a set of standard headphones or an optical
digital audio device such as a high-end home theater system.

v Optical Line In: Last (but certainly not least) is the optical audio Line In
jack, which allows you to pipe the signal from another audio device into
your laptop. This one comes in particularly handy when you record MP3
files from your old vinyl albums or when you want to record loops in
GarageBand.

Don’t forget the parts you can’t see
(/] p y

When you bought your new digital pride and joy, you probably noticed a
number of subtle differences between the low-end MacBook and the uber-
expensive top-end MacBook Pro model. I call these differences the Important
Hidden Stuff (or IHS, if you're addicted to acronyms already), and they’re just
as important as the parts and ports that you can see.

Internal storage devices:

v CPU: Today’s Mac laptops feature — gasp! — Intel processors, which
run faster and cooler than the old G4 processors that powered the iBook
and PowerBook models. Of course, the faster the processor, the better.
(Definitely not rocket science.)

v+ Hard drive: MacBook and MacBook Pro laptops use the latest in hard
drive technology: serial ATA hard drives, which are significantly faster
than the EIDE hard drives used in previous Mac laptop models. (You
don’t need to worry about what ATA and EIDE mean here. Really.) As you
might expect, the MacBook Pro laptop line has a larger capacity hard
drive as standard equipment, but you can special-order a MacBook from
Apple with a larger hard drive.
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v Optical drive: Okay, 'm cheating a little here. I mention the optical drive

in an earlier section, but all you can see is the slot, so it qualifies as an
[HS item. Depending on your Mac, your computer includes one of the
following:

e A DVD-R/CD-RW SuperDrive (which can play and record both CDs
and DVDs)

e ADVD/CD-RW combo drive (which can record CDs but only read
DVDs)

If your laptop can’t burn DVDs with the internal drive, don’t give
up hope of recording your own DVD movies. Thanks to those
handy FireWire ports, it’s child’s play to add an external DVD
recorder.

Time for a plug: If you're interested in recording your own audio and data
CDs, or you have an itch to burn DVD movies, I can highly recommend the
bestselling CD & DVD Recording For Dummies, Second Edition (Wiley). It’s
written by yours truly; hence the solid recommendation. You'll find every-
thing you need to know to use Roxio’s Toast recording software. In a few
minutes, you’ll be burning your own shiny digital treasures.

Wireless communications devices:

1 Wireless Ethernet: “Look, Ma, no wires!” As [ mention earlier, you can

connect your laptop to an existing wireless Ethernet network by adding
an AirPort Extreme card (either as an installed option or after you've
started using the computer). With wireless connectivity, you can share
documents with another computer in another room, share a single high-
speed Internet connection betwixt several computers, or enjoy wireless
printing. Truly sassy!

Although Apple would want you to build your wireless wonderland with
an Apple AirPort Extreme base station — go figure — you can use your
Mac with any standard 802.11g wireless network. And yes, PCs and Macs
can intermingle on the same wireless network without a hitch.
(Scandalous, ain’t it?)

v Bluetooth: Let’s get the old “digital pirate” joke out of the way: “Arrgh,

matey, | needs me a wireless parrot.” (Engineers again . . . sheesh.)
Although strangely named, Bluetooth is another form of wireless con-
nectivity. This time, however, the standard was designed for accessories
such as your keyboard and mouse, and devices such as a personal digi-
tal assistant (PDA) and a cell phone.

17
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Video display device:

v Video card: If your applications rely heavily on high-speed 3-D graphics,
you’ll be pleased as punch to learn that today’s MacBook Pro line of lap-
tops come equipped with cards such as the ATI Mobility Radeon X1600.
This card is well-suited to 3-D modeling, video editing, and well, hon-
estly, blasting the enemy into small smoking pieces with aplomb. As of
this writing, the MacBook line uses an integrated video card, so it’s not a
good choice for hard-core gaming or 3-D design.

Location, Location, Location!

If you choose the wrong spot to park your new laptop, I can guarantee that
you’ll regret it. Some domiciles and office cubicles don’t offer a choice — you
have one desk at work, for example, and nobody’s going to hand over
another one — but if you can select a home for your Mac, consider the
important placement points in this section:

P 1 Keep things cool. Your new laptop is silent, but that super fast Intel
Core Duo processor generates heat. Make sure the location you choose
is far from heating vents and shielded from direct sunlight. I also recom-
mend a laptop cooling pad, which elevates the base of your laptop to
allow air to circulate underneath.

v Outlets are key! Your computer needs a minimum of at least one nearby
outlet, and perhaps as many as three:

¢ A standard AC outlet

¢ A telephone jack (if you have an Apple modem for connecting to
the Internet or sending and receiving faxes)

¢ A nearby Ethernet jack (if you use the Mac’s built-in Ethernet port
for connecting to a wired Ethernet network)

\ . . .
) If you prefer to send your data over the airwaves, consider wire-

less networking for your Mac — I discuss everything you need to
know in Chapter 17.

* Don’t forget the lighting. Let me act as your Mom. (I know that’s a
stretch, but bear with me.) She’d say, “You can’t possibly expect to work
without decent lighting! You'll go blind!” She’s right, you know. You need
a desk or floor lamp at a minimum.

v Plan to expand. If your laptop hangs out on a desk, allow an additional
foot of space on each side. That way, you have room for external periph-
erals, more powerful speakers, and an external keyboard and mouse if
you need one.
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P If you want to keep an external keyboard handy, consider a laptop shelf —
these Plexiglas or metal stands elevate your laptop several inches above
the desk, putting the screen at a better ergonomic position and allowing
you to park your keyboard and external mouse underneath.

Unpacking and Connecting Vour Laptop

You're going to love this section — it’s short and sweet because the configu-
ration of a laptop on your desktop is a piece of cake. (Sorry about the cliché
overload, but this really is easy.)

Unpacking for the road warrior

Follow these guidelines when unpacking your system:

v Check for damage. I've never had a box arrive from Apple with shipping
damage, but I've heard horror stories from others (who claim that King
Kong must have been working for That Shipping Company).

\\J

Check all sides of your box before you open it. If you find significant
damage, take a photograph (just in case).

v Search for all the parts. When you’re removing those chunks o’
Styrofoam, make certain that you’'ve checked all sides of each foam
block for parts snuggled therein or taped for shipment.

v Keep all packing materials. Do not head for the trash can with the box
and packing materials. Keep your box and all packing materials for at
least a year, until the standard Apple warranty runs out. If you have to
ship the laptop to an Apple service center, the box and the original pack-
ing is the only way for your machine to fly.

And now, a dramatic Mark’s Maxim about cardboard containers:

Smart computer owners keep their boxes far longer than a year. If you
sell your laptop or move across the country, for example, you’ll want
that box. Trust me on this one.

v~ Store the invoice for safekeeping. Your invoice is a valuable piece of
paper, indeed.

Q@N\BER Save your original invoice in a plastic bag, along with your computer’s
& manuals and original software, and other assorted hoo-hah. Keep the
bag on your shelf or stored safely in your desk, and enjoy a little peace
of mind.

19
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+* Read the Mac’s manual. “Hey, wait a minute, Mark — why do I have to
read the manual from Apple along with this tome?” Good question, and
here’s the answer: The documentation from Apple might contain new and
updated instructions that override what I tell you here. (For example,
“Never cut the red wire. Cut the blue wire instead.” Or something to that
effect.) Besides, Apple manuals are rarely thicker than a restaurant menu.

Connecting cables 101

Your laptop makes all its connections simple, but your computer depends on
you to get the outside wires and thingamabobs where they go.

The absolutely essential connection

After your new Mac is resting comfortably in its assigned spot (I assume
that’s a desktop), you need to make just one required connection: the power
cable! Plug the cable into the corresponding socket on the Mac first, and then
plug ’er into that handy AC outlet.

Adding the Internet to the mix

If you have Internet access or a local computer network, you need to make at
least one of the following connections in this section.

If you don’t have any Internet service, start with local dialup Internet access.
(Owners of MacBook and MacBook Pro laptops will need an external USB
modem, because these models no longer have an internal modem.) You can
check high-speed options later — typically, your local cable and telephone
companies can provide you with more information on your long-term choices
for Internet service.

If you get on the Internet by dialing a standard phone number and your laptop
has an internal or external USB modem, just make two more connections:

1. Plug one of the telephone cable’s connectors into your external
modem port.

2. Plug the other telephone cable connector into your telephone line’s
wall jack.

After you get your account information from your ISP, Chapter 17 has the
details on configuring your modem and Internet settings for dialup access.

If you have high-speed Internet service, or if you're in an office or school with
a local computer network, you can probably connect through your laptop’s
built-in Ethernet port. You make two connections:
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1. Plug one end of the Ethernet cable into the Ethernet port on the Mac.

2. Plug the other end of the Ethernet cable into the Ethernet port from
your network.

Your network port is probably one of the following: an Ethernet wall
jack, an Ethernet hub or switch, or a cable or DSL Internet router (or
sharing device).

Will you be joining a wireless network? If so, you’ll find the information you
need on installing an AirPort Extreme wireless card in an older Mac laptop in
Chapter 20, and all the details you need to configure Tiger for wireless net-
working in Chapter 17.

Great, a Lecture about Handling
My Laptop

Proper handling of your laptop is important, so we’ll take a moment to cover
the Rules of Proper Laptop Deportment. Okay, perhaps I'm lecturing a bit, but
a little common sense goes a long way when handling any computer equip-
ment, and your laptop is no different. (Scolding mode off.)

Keep these rules in mind while opening and carrying your laptop:

v~ The cover is your friend. Open your laptop’s cover slowly, without jerk-
ing or bending it.

v Close it before you move it. By closing your laptop, you put your Mac
OS X operating system into sleep mode, and the hard drive automati-
cally spins down (making it safer to move). The laptop is still on, and
will spring back to life once you open the cover.

1+ Be nice to your keyboard. Don’t press too hard on those keys! Use the
same amount of pressure that you use with a desktop computer keyboard.

v Keep food and drinks far away. Care to turn your laptop into a very
expensive doorstop? Then go ahead and park your soda next to it. (Oh,
and crumbs are perfect if you're interested in buying replacement key-
boards.)

1 Keep your laptop as level as possible. Using your laptop while it’s tilted
too far in any direction can eventually cause problems with your hard
drive. I kid you not.
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An Overview of Mac Software Goodness

This section answers the most common of all novice computer questions:
“What the heck will I do with this thing?” You'll find additional details and
exciting factoids about the software that you get for free, software you’ll
want to buy, and stuff you can do on the Internet.

What comes with my laptop?

Currently, Apple laptops ship with the following major software applications
installed and ready to use:

v~ The iLife 2006 suite: You know you want these applications! They turn
your Mac into a digital hub for practically every kind of high-tech device
on the planet, including DV camcorders, digital cameras, portable music
players, PDAs, and even cell phones.

Chapters 11-15 focus on the major applications that make up iLife:
iMovie HD, iDVD, iTunes, iPhoto, and GarageBand.

v Office 2004 and iWork trial versions: You can try both of those produc-
tivity suites, but expect to buy the full shooting match if you want to
continue using either one.

v QuickBooks for Mac: Track your expenses, build a budget (and watch it
evaporate), and plan for your financial future. Your checkbook suddenly
becomes manageable and tax time becomes easier when you organize
your financial world with QuickBooks.

1 Photo Booth and Front Row: You'll discover more about these applica-
tions in Chapter 10 — for now, suffice it to say that Photo Booth works
with your laptop’s iSight camera, while Front Row is the remote-control

\BER software you’ll use with your Apple remote.
\}
‘{""‘\ The installed software on your Mac might change as new programs become
available.

Connecting to the Internet from your lap

What is a modern computer without the Internet? Apple gives you great tools
to take full advantage of every road sign and off-ramp on the Information
Superhighway right out of the box:

1 Web surfing: | use Tiger’s Apple Safari Web browser every single day. It’s
faster and better designed than Internet Explorer, with unique features
such as tabbed browsing and built-in RSS feeds.
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If tabbed browsing and RSS feeds sound like ancient Aztec to you, don’t
worry. Chapter 8 is devoted entirely to Safari.

1 Web searches: Sherlock can search the entire Internet for stocks, movie
listings, airline schedules, dictionaries, and foreign language transla-
tions. I explain this Internet sleuth in Chapter 7.

v Chat: iChat lets you use your Mac to chat with others around the world
for free using the Internet — by keyboard, voice, or full-color video. This
is awesome stuff straight out of Dick Tracy and Buck Rogers. If you've
never seen a video chat, you'll be surprised by just how good your

&‘“BER friends and family look!

Always wear a shirt when videoconferencing.

v E-mail: Soldier, Apple’s got you covered. The Mail application is a full-
featured e-mail system, complete with defenses against the torrent of
junk mail awaiting you. (Imagine a hungry digital saber-toothed tiger
with an appetite for spam.) Send pictures and attached files to everyone
on the planet, and look doggone good doing it.

Applications that rock

Dozens of small applications are built into Mac OS X. [ mention them in later
chapters, but here are four good examples to whet your appetite:

v~ iCal: Keep track of your schedule and upcoming events, and even share
your calendar online with others in your company or your circle of
friends. See how to keep your life in order in Figure 1-2.

v DVD Player: Put all that widescreen beauty to work and watch your
favorite DVD movies with DVD Player! You have all the features of
today’s most expensive standalone DVD players, too, including a spiffy
onscreen control that looks like a remote.

v Address Book: Throw away that well-thumbed collection of fading
addresses. Tiger’'s Address Book can store, search, and recall just about
any piece of information on your friends, family, and acquaintances.

v Chess: Ah, but this isn’t the chessboard your Dad used! Play the game of
kings against a tough (and configurable) opponent — your MacBook —
on a beautiful 3-D board. Heck, your Mac even narrates the game by
speaking the moves!

You can use the data you store in your Address Book in other Apple applica-
tions included with Tiger, such as Apple Mail and iChat.
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Boot Camp For Dummies

Although Mac OS X Leopard — the next version of Mac OS X — is still being
polished, one particularly exciting feature of this upcoming release is avail-
able now. You can use Apple’s Boot Camp utility and your licensed copy of
Windows XP to install and boot Windows on your Intel-based MacBook or
MacBook Pro laptop!

Boot Camp creates a Windows-friendly partition (or section) on your hard
drive, where all your Windows files are stored. Other than the slightly strange
key assignments you’ll have to remember, early adopters of Boot Camp
report that it’s surprisingly reliable and easy to use. However, [ strongly urge
that you back up your laptop on a regular basis; inviting Windows to your
Mac laptop also invites potential viruses as well.

For more information on Boot Camp and how you can download and install it,
visit Apple’s Mac OS X page at www.apple.com/macosx/.
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Other Stuff That Nearly Everyone Wants

No man is an island, and no computer is either. | always recommend the same
set of stuff for new PC and Mac owners. These extras help keep your new
computer clean and healthy (and some make sure you're happy as well):

1~ Surge suppressor: Even an all-in-one computer like your laptop can fall
prey to a power surge. [ recommend one of these:

¢ A basic surge suppressor with a fuse can help protect your Mac
from an overload.

e A UPS (uninterruptible power supply) costs a little more, but it
does a better job of filtering your AC line voltage to prevent
brownouts or line interference from reaching your computer.

Of course, your laptop’s battery immediately kicks in if you experi-
ence a blackout, so a UPS is less important for your computer.
However, any computer tech will tell you that filtered AC current is
far better for your laptop, and your UPS will also provide power for
external devices that don’t have a battery.

1 Screen wipes: Invest in a box of premoistened screen wipes. Your Mac’s
screen can pick up dirt, fingerprints, and other unmentionables faster

@\\\NG! than you think.
S Make sure your wipes are especially meant for LCD or laptop computer
screens.
1+ Blank CDs and DVDs: Depending on the type of optical drive installed in
your laptop — and the type of media you’re recording, such as com-
puter data CDs, DVD movies, or audio CDs — you’ll want blank discs for
¢ CD-R (record once)
e CD-RW (record multiple times)
¢ DVD-R (record once)
v~ Cables: Depending on the external devices and wired network connec-
tivity you’ll be using, these are
e A standard Ethernet cable (for wired networks or high-speed
Internet)
aLST, ¢ FireWire or USB cables for devices you already have
%,
S

Most hardware manufacturers are nice enough to include a cable
with their products, but there are exceptions, especially USB print-
ers. Shame on those cheapskates!
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»” A restraining cable: For those who are a little more security-conscious
or tend to use their laptops in public places, a standard Kensington
laptop lock slot is provided on your computer’s case. The principle is
the same as a bicycle cable lock: if your laptop is secured by a cable to a
sturdy fixture, it’s going to be nearly impossible for it to walk off with
someone else.

v A wrist rest: You might have many reasons to buy a new Mac laptop, but
[ know that a bad case of carpal tunnel syndrome is not one of them. Take
care of your wrists by carrying a keyboard wrist rest in your laptop bag.



Chapter 2

Turning On Your Portable
Powerhouse

In This Chapter

Turning on your laptop

Checking your Mac for proper operation
Monitoring your battery and heat level
Setting up Mac OS X Tiger

Registering your MacBook or MacBook Pro
Using Migration Assistant

Copying information from a Windows PC

In Chapter 1, you got as far as unpacking your Mac laptop and connecting a
number of cables to it, but unless you bought this computer solely as a
work of modern art, it’s time to turn on your Mac and begin living The Good
Life. (Plus, you still get to admire that Apple design whilst using iTunes.)
After you get your new beauty powered on, I will help you with an initial
checkup of your laptop’s health.

I also familiarize you with the initial chores that you need to complete —
such as using the Mac OS X Setup and moving the data and settings from
your existing computer to your MacBook or MacBook Pro — before you
settle in with your favorite applications.

In this chapter, [ assume that Mac OS X Tiger was preinstalled on your Mac
or that you just completed an upgrade to Tiger from an earlier version of
Mac OS X.
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Tales of the On Button

Your Mac’s power switch is located on the right side of the keyboard. Press it
now to turn on your Mac, and you will hear the pleasant startup tone that’s
been a hallmark of Apple computers for many years. The power button will
also light up. Don’t be alarmed if you don’t immediately see anything onscreen
because it takes a few seconds for the initial Apple logo to appear.

“\Q,N\BER In my experience, sometimes a simple quick press of the power button on

Y some Mac laptop models just doesn’t do it. Rather, you actually have to
hold the button down for a count of two or so before the computer turns on.
However, if your Mac laptop ever locks up tight (and you can’t quit an appli-
cation, as | demonstrate in Chapter 4), the power button gives you another
option: hold it down for a count of five and your Mac shuts off.

As the Apple logo appears, you see a twirling, circular high-tech progress
indicator that looks like something from a James Bond movie. That’s the sign
that your Mac is loading Tiger and checking your internal drive for problems.
Sometimes the twirling circle can take a bit longer to disappear. As long as it’s
twirling, though, something good is happening.

Next, Tiger displays the soon-to-be-quite-familiar Aqua Blue (yup, that’s its
name) background while it loads certain file sharing, networking, and print-
ing components (and such). This time, you get a more conservative progress
bar, but the result is the same. Just wait patiently a bit longer.

At last, your wait is rewarded, and you see the Tiger Setup Assistant.

Mark’s Favorite Signs of a
Healthy Laptop

Before you jump into the fun stuff, don’t forget an important step — a quick
prelim check of the signs that your new mobile Mac survived shipment intact
and happy.

If you can answer “yes” to each of these questions, your Mac likely made the
trip without serious damage:
1. Does the case show signs of damage?

It’s pretty easy to spot damage to your Mac’s svelte design. Look for
scratches and puncture damage.

2. Does the LCD screen work, and is it undamaged?
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Does the cover open smoothly? Are any individual dots (or pixels) on
your LCD monitor obviously malfunctioning? Bad pixels appear black or
in a different color than everything surrounding them. (Techs call these
irritating anarchists dead pixels. A 13" MacBook screen has literally hun-
dreds of thousands of pixels, and unfortunately, many new LCD screens
include one or two dead ones.

3. Do the keyboard and trackpad work?

Check your Mac’s built-in trackpad by moving your finger across its sur-
face; the cursor should move on your screen. To check the keyboard,
press the Caps Lock key on the left and observe whether the Caps Lock
light turns on and off.

If you do notice a problem with your laptop (and you can still use your Safari
browser and reach the Web), you can make the connection to an Apple sup-
port technician at www.apple. com. If your MacBook Pro remains dead —
like an expensive paperweight — and you can’t get to the Internet, you can
check your phone book for a local Apple service center. Chapter 19 also
offers troubleshooting information.

VYou're Not Going to Lecture Me
About Battevies, Are You?

No, this is not going to be a lecture. In fact, the only lecture I'll put you
through in this book concerns backing up. (Which you should do.) Instead,
consider these tips as your rules of the road for monitoring and charging
your battery:

+ Keep your laptop plugged into an AC socket when possible. I take
every opportunity to top off my laptop’s battery, and so should you.

* Your battery recharges faster when your laptop is off or in sleep
mode. Have only half an hour to charge your battery before you're away
from an AC socket? In that case, don’t use your MacBook whilst it’s
plugged in and charging. For the most juice you can scavenge, turn off
your laptop or leave it in sleep mode.

1 Monitor your battery level from the Finder menu. I love Tiger’s battery
monitoring system! Your laptop’s battery life is displayed in the Finder
menu as a percentage of power remaining (with a fully charged battery
registering at 100%). Keep in mind that the percentage shown is esti-
mated using your current System Preference settings and power usage,
so if you change your Energy Saver settings or remove a USB device that
draws power from your laptop, you'll see that change reflected in the
battery meter.
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Hot patootie, is my laptop steam-powered?

It's a well-known fact that laptops generate heat.
Today's super-fast multicore processors can
work up a head of steam — pun intended —
while you're using them, and even though your
laptop has a fan, some of that heat is simply radi-
ated from the bottom of the computer.

What you may not realize, however, is just how
much heat your MacBook or MacBook Pro can
produce! You're not going to be scalded if you
shift your MacBook from a desk to your lap
(Apple dislikes lawsuits as much as the next
company), but if you've been using that laptop

To avoid that burning sensation, buy a laptop
stand or cooling pad for your desk. These nifty
metal or Plexiglas pedestals raise your laptop
up off of your desk, allowing air to flow under
the bottom of the computer for better cooling.
Also, a laptop stand elevates the screen to a
more ergonomic position. (The keyboard may
suddenly be harder to use, naturally, but that's
yet another reason why | recommend an exter-
nal keyboard when you’re using your Mac
laptop at a semipermanent desk location; it
saves wear and tear on your laptop keyboard,
and you get a full-size keyboard.)

for hours, it will be uncomfortably hot!

v Turn off unnecessary hardware to conserve battery power. If you
want to conserve battery power as much as possible, disconnect any
USB or FireWire devices, and turn off your AirPort and Bluetooth wire-
less hardware if you're not connected to a network. You can save power
also by reducing the brightness of your display from your laptop’s key-
board, by using sleep mode, and by removing CDs and DVDs from your
drive.

v Calibrate your battery. You can “train” your battery to provide the max-
imum charge by calibrating it; Apple recommends that you recalibrate
your battery once a month. First, charge your battery until the Finder
menu battery meter indicates that the unit is fully charged at 100%, and
then keep your laptop connected to an AC socket for another two hours
to ensure a maximum charge. Now disconnect the power cord and use
your laptop on battery power until it’s fully discharged and it automati-
cally switches to sleep mode (make sure that you've closed all your
applications when you see the low battery warning dialog box, so you
don’t lose anything). Allow your laptop to sleep (or turn it off) for a full
five hours. Finally, reconnect the AC cord and fully charge your battery.
You're finished!

Setting Up and Registering Vour Laptop

After your Mac is running and you’ve given it the once-over for obvious ship-
ping damage, your next chore is to set up your laptop. Unlike other tasks in
this book, I won’t cover the setup process step-by-step. Apple contextually
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tweaks the questions that you see during setup on a regular basis, and the
questions are very easy to answer. Everything is explained onscreen, com-
plete with onscreen Help if you need it.

However, [ do want you to know what to expect as well as what information
you need to have at hand. I also want you to know about support opportuni-
ties like Apple’s .Mac Internet services. Hence this section: Consider it a
study guide for whatever your MacBook’s setup procedure has to throw

at you.

Setting up Mac 0S X Tiger

After you start your computer for the first time — or if you just upgraded
from Mac OS 9 or an earlier version of Mac OS X — your laptop will likely
launch Tiger Setup automatically. (Note that some custom install options,
such as the Archive and Install option, may not launch the setup procedure.)
The setup process takes care of a number of different tasks:

v Setup provides Tiger with your personal information. As | mention in
Chapter 1, your Mac ships with a bathtub full of applications, and many
of those use your personal data (such as your address and telephone
number) to automatically fill out your documents.

If that stored personal information starts you worrying about identity
theft, [ congratulate you. If you're using your common sense, it should.
However, in this case, Apple doesn’t disseminate this information any-
where else, and the applications that use your personal data won’t send
it anywhere, either. And Safari, the Apple Web browser, fills out forms on
a Web page automatically only if you give your permission.

1 Setup configures your language and keyboard choices. Mac OS X is a
truly international operating system, so you are offered a chance to con-
figure your laptop to use a specific language and keyboard layout.

1 Setup configures your e-mail accounts in Apple Mail. If you already
have an e-mail account set up with your ISP, keep the e-mail account
information that the ISP provided handy to answer these questions. The
info should include the incoming POP3 and outgoing SMTP mail servers
you’ll be using, your e-mail address, and your login name and password.

+* Setup allows you to open a trial subscription with Apple’s .Mac ser-
vice. Apple’s .Mac subscription service provides you with online file
storage, iSync capability across multiple computers, backups to your
online storage, Apple e-mail accounts (through both Web mail and the
Apple Mail application), photocasting, podcasting, and your own acre of
iWeb site on the Internet. I go into all these in detail in Chapter 9, but for
now, just sign up (or sign in, if you already have an existing account) and
take the opportunity to feel smug about owning an Apple computer.
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v Setup sends your registration information to Apple. As a proud owner
of a Mac laptop, take advantage of the year of hardware warranty sup-
port and the free 90 days of telephone support — but you have to regis-
ter to use ’em. Rest assured that all this info is confidential.

1 Setup launches Migration Assistant. This assistant guides you through
the process of migrating (an engineer’s term for moving) your existing
user data from your old Mac or PC to your new laptop. Naturally, if your
MacBook is your first computer, you can skip this step with a song in
your heart! (Read more on Migration Assistant in the section, “Importing
Stuff from Another Mac.”)

Registering your Mac

I'll be honest here: | know that many of us, myself included, don’t register
every piece of computer hardware we buy. For example, I didn’t register my
wireless Bluetooth adapter that I bought for my older iBook because the total
expenditure was only around $40, the gizmo has no moving parts, and I'm
never likely to need technical support to use it or get it fixed.

However, your MacBook is a different kettle of fish altogether, and I strongly
recommend that you register your purchase with Apple during the setup
process. You spent a fair amount on your computer, and it’s an investment
with a significant number of moving parts.

Even the hardiest of techno-wizards would agree with this important Mark’s
Maxim:

If you don’t register your new laptop, you can’t receive support.

And rest assured that Apple is not one of those companies that constantly
pesters you with e-mail advertisements and near-spam. I've registered every
Apple computer I've owned, and I've never felt pestered. (And I have an
extremely low tolerance for spam.)

Importing Stuff from Another Mac

If you're upgrading from an older Mac running Mac OS X to your new laptop, |
have great news for you: Apple includes Migration Assistant, a utility applica-
tion that can help you copy (whoops, | mean, migrate) all sorts of data from
your old Mac to your new machine. The list of stuff that gets copied over
includes the following:
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v~ User accounts: If you set up multiple user accounts (so that more than
one person can share the computer), the utility ports them all to your
new Mac.

v Network settings: Boy, howdy, this is a real treat for those with manual
network settings provided by an ISP or a network administrator!
Migration Assistant can re-create the entire network environment of
your old Mac on your new laptop.

v~ System Preference settings: If you're a fan of tweaking and customizing
Mac OS X to fit you like a glove, rejoice. Migration Assistant actually
copies over all the changes that you’ve made in System Preferences on
your old Mac! (Insert sound of angelic chorus: Hallelujah!)

v Documents: The files in your Documents folders are copied to your
new Mac.

1~ Applications: Migration Assistant tries its best to copy over the third-
party applications that you've installed in your Applications folder on the
older Mac. [ say tries its best because you might have to reinstall some
applications, anyway. Some developers create applications that spread
out all sorts of files across your hard drive, and Assistant just can’t keep
track of those nomadic files. And some other applications make the trek
just fine, but you might have to reenter their serial numbers.

Setup launches Migration Assistant automatically if you indicate that you need
to transfer stuff during the setup process, but you can always launch Migration
Assistant manually at any time. You'll find it in the Utilities folder inside your
Applications folder; just double-click the Migration Assistant icon.

To use Migration Assistant to copy your system from your older Mac, you
need a FireWire cable to connect the computers. If you don’t already have
one, you can pick one up at your local Maze o’ Wires electronics store or at
your computer store. (This cable will probably come in handy in the future
as well, so it’s not a one-use wonder.)

Follow these steps to use Migration Assistant:

1. Click Continue on the opening screen.

Assistant prompts you for the account name and password that you cre-
ated during the setup procedure, as shown in Figure 2-1. Your account is
an admin account, meaning that you have a higher security level that
allows you to change things in Tiger. (See Chapter 16 for much more
detail on user accounts.)

2. Type your password and then click OK.

Characters in your password are displayed as bullet characters for
security.
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3. Click From Another Mac and then click Continue.

4. Connect a FireWire cable between the two computers and then click

Continue.

. Restart your older Mac while holding down the T key. Continue hold-

ing down the T key until you see the FireWire symbol appear on your
older machine.

This restarts your older computer in FireWire Target Disk mode, in which
your older Mac essentially becomes a huge external FireWire hard drive.
(Neat trick.)

6. Click Continue.

7. Select the check boxes next to the user accounts that you want to

transfer from your older machine (see Figure 2-2) and then click
Continue.

The Assistant displays how much space is required to hold the selected
accounts on your new laptop’s hard drive.

. Select the check boxes next to the applications and files that you want

to copy (see Figure 2-3) and then click Continue.
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9. Select the check boxes next to the settings that you want to transfer
(see Figure 2-4).

Normally, you want to migrate all three groups of settings.
10. Click the Migrate button.

11. After everything is copied, press and hold the power button on your
older Mac to shut it off. Then disconnect the FireWire cable.
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If you're a Windows-to-Mac switcher, you made a wise choice, especially if
you're interested in the creative applications in the iLife suite! Although you
could choose to start your Apple computing life anew, you probably want to
migrate some of your existing documents and files from that tired PC to your
bright, shiny, new MacBook Pro.

Unfortunately, Mac OS X has no Windows Migration Assistant. However, if
you’re moving from a Windows PC to a Mac, you can copy your files manually
from a CD or DVD, a USB Flash drive, or over a network. (Note, however, that
today’s Mac laptops don’t come with a floppy drive. And trust me, you would-
n’t want to use one to move anything that matters, anyway.)

The Mac OS X Help system contains an entire subsection on specific tricks
you can use when switching from Windows to Mac, including how to connect
to a Windows network and how to connect the two computers together
directly.

Even with Boot Camp — Apple’s dual-boot feature that allows you to run
both Tiger and Windows XP on your MacBook or MacBook Pro — manually
moving existing Windows applications such as Paint Shop Pro to your
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laptop’s hard drive usually won’t work. That’s because most Windows soft-
ware installs all sorts of necessary files in several folders across your hard
drive. Instead, you’ll have to install Windows XP on your Mac laptop (using
Boot Camp) and then reinstall your Windows applications.

In general, however, you can move the document files you've created — such
as Office documents, movies, photos, and music — without a problem. Table
2-1 illustrates what can be moved between Windows XP and Mac OS X as well
as the application you use in Tiger to open those files and documents.

Table 2-1 Moving Media and Documents Betwixt Computers

File Type Windows XP Mac 0S X Mac App
Location Location

Music files My Music folder Music folder iTunes

Video and movie files My Videos folder =~ Movies folder ~ QuickTime/DVD
Player

Digital photos My Pictures folder  Pictures folder  iPhoto

Mac Office documents My Documents Documents Office/iWorks
folder folder

If you don’t mind investing around $50, use the Move2Mac software utility,
which does most of the work of Migration Assistant for those switching from
a Windows PC. From Detto Technologies (www.detto.com/move2mac),
Move2Mac comes complete with a special USB-to-USB cable that connects
your two computers for high-speed copying. You can choose what you want
to transfer to your new Mac (use Table 2-1 as a guide), and the copying is
performed automatically for you. Plus, Move2Mac transfers goodies such
as your home page and bookmarks from Internet Explorer, desktop back-
grounds, and even your Address Book contacts and account settings from
Outlook Express. Move2Mac makes switching much easier, and I can highly
recommend it.
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Chapter 3

The Laptop Owner's Introduction
to Mac 0S X

In This Chapter
Introducing Mac OS X Tiger
Appreciating the UNIX core underneath Tiger
Recognizing similarities between Windows XP and Tiger

Getting help while learning about Tiger

In the other books that I've written about Mac OS X Tiger, I use all sorts of
understated phrases to describe my operating system of choice, such as
elegantly reliable, purely powerful, and supremely user-friendly.

But why is Tiger such a standout? To be specific, why do creative profession-
als and computer techno-wizards across the globe hunger for the very same
Mac OS X that runs your Mac laptop? Why is Tiger so far ahead of Windows
XP in features and performance? Good questions, all!

In this chapter, [ answer those queries and satisfy your curiosity about your
new big cat. I introduce the main elements of the Tiger desktop, and [ show
you the fearless UNIX heart that beats underneath Tiger’s sleek exterior. |
also point out the most important similarities between Tiger and Windows
XP, and I outline the resources available if you need help with Mac OS X.

Oh, and I promise to use honest-to-goodness English in my explanations, with
a minimum of engineer-speak and indecipherable acronyms. (Hey, you've got
to boast about Tiger in turn to your family and friends. Aunt Harriet might
not be as technologically savvy as we are.)
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Tiger is a special type of software called an operating system. You know, OS,
as in Mac OS. That means Tiger essentially runs your MacBook Pro and also
allows you to run all your other applications, such as Keynote or Photoshop
CS2. Tiger is the most important computer application — or software — that
you run.

Think of a pyramid, with Tiger as the foundation and other applications run-
ning on top.

You're using the operating system when you aren’t running a specific applica-
tion, such as when you perform these actions:

v Copying files from a CD to your hard drive

v Choosing a different screensaver

Sometimes, Tiger even peeks through an application while it’s running. For
example, actions like these are also controlled by Tiger:

v The Open, Save and Save As dialog boxes you see when working with
files in Photoshop CS2

v The Print dialog that appears when you print a document in Microsoft
Word 2004

In this section, [ escort you around the most important hotspots in Tiger, and
you meet the most interesting onscreen thingamabobs that you use to con-
trol your laptop. (I told you [ wasn’t going to talk like an engineer!)

The Tiger desktop

The Tiger desktop isn’t made of wood, and you can’t stick your gum under-
neath. However, it does indeed work much like the surface of a traditional
desk. You can store things there, organize things into folders, and take care of
important tasks such as running other applications. Heck, you even have a
clock and a trash can.

Gaze upon Figure 3-1 and follow along as you venture to your desktop and
beyond.
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Dock Icons

Meet me at the dock

The dock is the closest thing to the dashboard of a car that you're likely to
find on a Macintosh. It’s a pretty versatile combination — it’s one part orga-
nizer, one part application launcher, and one part system monitor. From here,
you can launch applications, see what’s currently running, and display or
hide the windows shown by your applications.

Each icon in the dock represents one of the following:

v An application that you can run (or is currently running)
v An application window that’s minimized (shrunk)
v A Web page

v A document or folder on your system
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v A network server or shared folder

v Your trash
I cover the dock in more detail in Chapter 5.
The dock is highly configurable. You can

v Move it to different sides of the screen
v Make it disappear and call it back
1 Resize it

Dig those crazy icons
By default, Tiger always displays at least one icon on your desktop: your
Mac’s internal hard drive. To open a hard drive and view or use the contents,
you double-click the icon. Other icons that might appear on your desktop can
represent

v CDs and DVDs

v An iPod

v External hard drives or USB Flash drives

v Applications, folders, and documents

v Files you’'ve downloaded from the Internet

v Network servers you've accessed

Chapter 4 provides the good stuff on icons and their uses in Tiger.

This menu has no food

The Finder menu isn’t found in a restaurant. Instead, you find it at the top of
the desktop, where you can use it to control your applications. Virtually
every application that you run on your Mac has a menu. (Chapter 4 dives
deep into the depths of the Finder.)

To use a menu command, follow these steps:

1. Click the menu group (such as File or Edit).

2. Choose the desired command from the list that appears.

Only two menu groups are in every Mac OS X application: the Apple menu
(which is identified with that jaunty Apple Corporation icon, %) and the
application menu (which always bears the name of the active application).
For instance, the DVD Player menu group appears when you run Tiger’s DVD
Player, and the Word menu group appears when you launch Microsoft Word
2004. 1 cover these two common groups in more detail in Chapters 4 and 5.
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Isn't Windows XP the latest thing?

You've seen highly customized “pocket rocket”
compact cars with the flashy paint jobs, huge
noisy mufflers, and aerodynamic fiberglass
stuff. You might think that these cars are real
road racers, but what's underneath is different.
The 4-cylinder engine that you don‘t see is
stock. These cars don't perform any better than
a mundane model straight from the factory.

The same holds true for Microsoft Windows XP,
which was another attempt by the folks at
Redmond to put a modern face on an antique
operating system. Forget the flashy colors and

the visual effects: Windows XP is simply more
of the same (and it's now several years old to
boot). Sure, it's more reliable and faster than
Windows 98 and Windows ME, but you can
forget real performance or innovation.

Unfortunately, if you're running PC hardware,
the only other practical choice for a computing
novice is Linux, which is still regarded as too
complex by major manufacturers such as Dell
and Hewlett-Packard. Therefore, with a PC,
you're usually stuck with Windows XP, or you've
picked up an expensive paperweight.

There’s always room for one more window

You’re probably already familiar with the ubiquitous window itself. Both Tiger
and the applications that you run use windows to display things such as

v The documents that you create

v The contents of your hard drive

The window in Figure 3-1 is a Finder window, where Tiger gives you access to
the applications, documents, and folders on your system.

Windows are surprisingly configurable. I cover them at length in Chapter 4.

Why get so excited by Tiger?

How Tiger’s core is designed makes more of a difference than all the visual
bells and whistles, which tend to be similar between Windows XP and Mac
OS X Tiger (and Linux as well, for that matter). Time for a Mark’s Maxim:

Sure, Tiger’s elegant exterior is a joy to use, but Mac OS X is a better operating
system than Windows because of the unique UNIX muscle that lies underneath!

So what should you and I look for in Mac OS X? Keep in mind that today’s
computer techno-wizard demands three requirements for a truly high-pow-
ered software wonderland, and that Tiger easily meets all three:
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It's Apple to the rescue!

UNIX is the super-reliable operating system that
powers most of the high-performance servers
that make up the Internet. UNIX has built-in sup-
port for virtually every hardware device ever
wrought by the hand of Man (including all the
cool stuff that came with your laptop) and is well
designed and highly efficient to boot.

Unfortunately, standard UNIX looks as hideous
as DOS, complete with a confusing command
line, so ease-of-use for normal human beings
like you and | goes out the door. Enter the genius
types at Apple, who figured several years ago
that all UNIX needed was a state-of-the-art,
novice-friendly interface! To wit: Mac 0S X was
developed with a UNIX foundation (or core), so
it shares the same reliability and performance
as UNIX. However, the software engineers at
Apple (who know a thing or two about ease of
use) made it good looking and easy to use.

This is the secret to the worldwide fever over
Mac 0S X: It blends the best of UNIX (an estab-
lished super-powered operating system) with
the best of earlier Macintosh operating systems

such as Mac 0S 9. Mac 0S X is easy to use,
and it runs tight, concentric sassyrings around
anything that Microsoft is likely to offer for the
next several years.

That's as far as | delve into the foundation of
Tiger in this volume — which is understandable,
because there’s lots more laptop real estate to
cover! It's my job to help you use the features
and controls in Tiger, not turn you into a bearded
UNIX nerd with a pocket protector and sus-
penders. In fact, you never see the UNIX run-
ning underneath Tiger (unless you want to, by
running the Terminal application). Instead, Mac
laptop owners can stay safely in the elegant
world of drag-and-drop and point-and-click.

If you're interested in all the details about what
makes Mac 0S X tick, as well as its settings and
features, | can heartily recommend another of
my books, the bestselling (and extremely heavy)
Mac 0S X Tiger All-in-One Desk Reference For
Dummies. It comprehensively covers everything
Tiger — more than 700 pages devoted to Mac
0S X and its companion applications!

+ Reliability: Your operating system has to stay up and running reliably for

as long as necessary — I'm talking months here — without lockups or
error messages. If an application crashes, the rest of your work should

remain safe, and you should be able to shut down the offending software.

v Performance: If your computer has advanced hardware, your operating
system must be able to use those resources to speed things up big-time.
The operating system has to be highly configurable, and it has to be
updated often to keep up with the latest in computer hardware.

“Mark, what do you mean by advanced hardware?” Well, examples include

¢ True 64-bit computing
e Multiple processors (like more than one G5 chip in your computer)
¢ A huge amount of RAM (we’re talking 4GB or more)

¢ Enough hard drive space to make use of a RAID array
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If all that sounds like ancient Sumerian, gleefully ignore this technical
drabble and keep reading.

1 Ease of use: All the speed and reliability in the world won’t help an oper-
ating system if it’s difficult to use.

DOS was the PC operating system of choice before the arrival of Windows.
It was doomed because it wasn’t intuitive or easy to master, requiring a PC
owner to remember all sorts of commands that looked like hieroglyphics.
(This is one of the reasons why the Macintosh was so incredibly popular
in the days of DOS-based PCs — Macs had a mouse, and they were a snap
to learn and use.)

All the Features of Windows
(Just Better)

You might have heard of the Windows switcher: an intelligent species that’s
becoming more and more common these days. Switchers are former PC owners
who have abandoned Windows and bought a Macintosh, thereby joining the
Apple faithful running Mac OS X. (Apple loves to document this migration on its
Web site.) Because today’s Macintosh computers are significantly faster than
their PC counterparts — and you get neat software such as Tiger and the iLife
suite when you buy a new Mac — switching makes perfect sense.

Like Windows done vight

Switchers aren’t moving to totally unfamiliar waters. Windows XP and Tiger
share a number of important concepts. Familiarizing yourself with Tiger takes
far less time than you might think.

Here’s an overview of the basic similarities between the two operating systems:
v The desktop: The Tiger desktop is a neat representation of a real physi-

cal desktop, and Windows XP uses the same idea:

¢ You can arrange files, folders, and applications on your desktop to
help keep things handy.

e Application windows appear on the desktop.

v Drives, files, and folders: Data is stored in files on your hard drive(s),
and those files can be organized in folders. Both Tiger and Windows XP
use the same file/folder concept.

b5
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v~ Specific locations: Both Windows XP and Tiger provide every user with
a set of folders to help keep various types of files organized. For exam-
ple, the My Videos folder in Windows XP corresponds to the Movies
folder that you find in your Home folder in Tiger.

+* Running programs: Both Tiger and Windows XP run programs (or appli-
cations) in the same manner:

¢ Double-clicking an application icon launches that application.

¢ Double-clicking a document runs the corresponding application
and then automatically loads the document.

1+ Window control: Yep, both operating systems use windows, and those
windows can be resized, hidden (or minimized), and closed in similar
fashions. (Are you starting to see the connections here?)

v Drag-and-drop: One of the basics behind a GUI (a ridiculous acronym
that stands for graphical user interface) like Windows XP and Tiger is the
ability to drag documents and folders around to move, delete, copy, and
load them. Drag-and-drop is one of the primary advantages of both of
these operating systems — copying a file by dragging it from one
window to another is intuitive and easy enough for a kid to accomplish.

v~ Editing: Both Tiger and Windows XP offer similar cut-and-paste editing
features. You've likely used cut, copy, and paste for years, so this is
familiar stuff.

Loading the truck

Most folks use a high-capacity external hard drive when moving their docu-
ments from a PC to a laptop. If you're a Windows switcher, remember that
you won'’t have to copy any applications or support files, so you’ll be trans-
ferring only the files you created. For example, a Switcher is likely to copy
media files (such as music tracks and video clips), word-processing and
spreadsheet documents, and the like.

Keep in mind that a folder you’ve created on your PC’s hard drive copies just
fine under Tiger, so you can leave your files arranged in their current folders
to help keep them organized. For example, if you stored all your Quicken data
files for the last few years in a folder named Financial Archives, go ahead and
copy that entire folder to the external drive.

If you're undertaking a switch from Windows XP to Tiger, I highly recommend
using Move2Mac ($150) from Detto Technologies (www.detto.com). This
application automatically takes care of most migration chores, such as
moving the files that you select from XP to their corresponding locations in
Tiger. Move2Mac also transfers your contacts, e-mail settings, and Internet
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configuration to your new Mac. The package comes complete with a specially
designed USB cable for connecting the two computers, so you don’t even
need an external hard drive to make the switch.

Wondering what you can do about Windows-only applications that you leave
behind if you switch? Are you a Mac owner who must run a program that’s
available only for Windows? If you're running a MacBook or MacBook Pro,
you can use Boot Camp to install and run Microsoft Windows XP directly.
But what if you’re running an older iBook or PowerBook? Believe it or not,
Microsoft comes to the rescue with Virtual PC 7 (as shown in Figure 3-2).
Virtual PC allows your Mac laptop to run multiple virtual copies of Windows
98, Me, 2000, or XP . . . you can even run Linux! (The operating system and
software that you install and run within your virtual PC hardware environ-
ment can’t tell the difference.)
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And Just in Case Vou Need Help . . .

You can call on the resources in this section if you need additional help while
you’re learning to tame the Tiger. Some of the help resources are located on
the Internet, so your Web browser will come in handy.
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Tiget’s built-in Help system

Sometimes the help you need is as close as the Help group on the menu. You
can get help for either

1 A specific application: Just click Help.

1 Actions and functions in Tiger: Click a Finder window and then press
&+? to summon the top-level Mac OS Help menu.

After the Help viewer appears on your screen, click in the Ask a Question box
and type a short phrase that sums up your query (such as startup keys).
Press Return to list the topics that most closely match your search phrase.
To display the Help text for an entry in the topic list, just double-click it.

Apple’s Web-based support center

Apple has online product support areas for every hardware and software
product that it manufactures. Visit www . apple.com and click the Support
tab at the top of the Web page. The Search box works just like the Mac OS
Help system, but the knowledge base that Apple provides online has a lot
more answers.

Magazines

Many magazines (both in print and online) offer tips and tricks on using
and maintaining Mac OS X Tiger. My online favorites are Macworld (www .
macworld.com) and MacAddict (www.macaddict.com).

Mac support Web sites

A number of individuals and groups offer support forums on the Web, and
you can often find help from other Mac owners on these sites within a few
hours of posting a question. I'm fond of MacFixlIt (www.macfixit.com) and
MacMinute (www.macminute.com).
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Mac newsgroups on Usenet

You can find lots of help (typically dispensed with a healthy dose of opinion)
in Usenet newsgroups such as comp . sys.mac.systemand comp. sys.mac.
applications. Simply post a message and then check back within a few
hours to read the replies.

Local Mac user groups

[ would be remiss if I didn’t mention your local Mac user group. Often a user
group maintains its own Web site and discussion forum. If you can wait until
the next meeting, you can even ask your question and receive a reply from a
real-live human being . . . quite a thrill in today’s Web-riffic world!
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Part I

Shaking Hands
with Mac 0S X

The 5th Wave By Rich Tennant

AFTER INSTALLING 0SX TIGER,
NED AND LORETTA SELECT THE
COMPUTERS BACKGROUND

“Oh - I like this background much better than
the basement?



In this part . . .

t’s time to delve deeper into the workings of Mac OS X

Tiger. I'll show you how to perform all sorts of common
tasks, as well as how to customize your system, how to
change settings in System Preferences, where your per-
sonal files are stored, and how to use the latest Spotlight
search technology to find anything you’ve stored on your
MacBook or MacBook Pro!




Chapter 4

Working Magic with the
Keyboard and Trackpad

In This Chapter
Introducing the highlights of the Finder

Discussing that missing mouse button
Launching and quitting applications
Identifying and selecting icons

Using keyboard shortcuts to speed things up

Managing windows in Tiger

A h, the Finder — many admire its scenic beauty, but you shouldn’t ignore
its unsurpassed power nor its many moods. And send a postcard while
you're there.

Okay, so Tiger’s Finder might not be guite as majestic as the mighty Mississippi
River, but it’s the basic toolbox that you use every single day while piloting
your laptop. The Finder includes the most common elements of Mac OS X:
window controls, common menu commands, icon fun (everything from launch-
ing applications to copying files), network connections, keyboard shortcuts,
and even emptying the trash. In fact, one could say that if you master the
Finder and use it efficiently, you’re on your way to becoming a power user! (My
editor calls this the Finder “window of opportunity.” She’s a hoot.)

This chapter is your Finder tour guide. Grab your laptop and we’re ready to roll.

Using the All-Powerful Finder

This is a hands-on tour, with none of that “On your right, you'll see the his-
toric Go menu” for you! Time to get off the bus and start the tour with Figure
4-1, in which I show you around the most important elements of the Finder.
(In the final section, “Performing Tricks with Finder Windows,” I give you a
close-up view of window controls.)
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The popular attractions include

v+ The Finder menu bar: Whenever the Finder itself is ready to use (or, in
Mac-speak, whenever the Finder is the active application), the Finder
menu bar appears at the top of your screen. You know the Finder is active
and ready when the word Finder appears to the left of the menu bar.

A menu is simply a list of commands. When you click a menu (such as
the File menu), it extends down so that you can see the commands it
includes. While the menu is extended, you can choose any enabled
menu item (just click it) to perform that action. You can tell that an item
is enabled if its name appears in black; conversely, a menu command is
disabled if it’s grayed-out — clicking it does nothing.

A menu path like Filem>Save is just a visual shortcut that tells you to click
the File menu and then click Save from the drop-down menu that appears.

1+~ The Apple menu (®): This is a special menu because it appears both in
the Finder and in every application menu that you run. It doesn’t matter
whether you're in iTunes or Photoshop or Word — if you can see a menu
bar, the Apple menu is there. No matter where you are in Tiger, the
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Apple menu contains common commands to use, such as Restart, Shut
Down, and System Preferences.

P [ should point out that some applications, such as Front Row and
Apple’s DVD Player, may hide the Finder menu bar when they’re in full-
screen mode. However, you can still access the menu bar, even when it’s
not visible: Just move your cursor to the top edge of the screen, and the
menu bar will usually burst forth.

v The Finder desktop: Your Finder desktop serves the same purpose as
your physical desktop: You can store stuff here (files, alias icons, and so
on), and it’s a solid, stable surface where you can work comfortably:.
Application windows as well as other applications such as your Stickies
notes and your DVD player appear on the desktop. Just click an applica-
tion there to launch it.

® Your desktop is easy to customize. For instance, you can use your own
images to decorate the desktop, organize it to store new folders and doc-
uments, arrange icons how you like, or put the dock in another location.
Don’t worry — I cover all this in other areas of the book — I just want
you to know that you don’t have to settle for what Apple gives you as a
default desktop.

v All sorts of icons: This is a Macintosh computer, after all, replete with
tons of make-your-life-easier tools. Check out the plethora of icons on
your desktop as well as icons in the Finder window itself. Each icon is a
shortcut of sorts to a file, folder, network connection, or device in your
system, including applications that you run and documents that you
create. Refer to Figure 4-1 to see the icon for my Mac’s hard drive,
labeled Macintosh HD. Sometimes you click an icon to watch it do its
thing (like icons on the dock, which I cover next), but usually you
double-click an icon to make something happen.

v The dock: The dock is a launching pad for your favorite applications,
network connections, and Web sites. You can also refer to it to see what
applications are running. Click an icon there to open the item (for exam-
ple, the postage stamp icon represents Apple’s Mail application, while
the spiffy compass will launch your Safari Web browser).

v The Finder window: Finally! The simple Finder window in Figure 4-1 dis-
plays the contents of my Applications folder. You'll use Finder windows
to launch applications, perform disk chores such as copying and moving
files, and navigate your hard drive.

Wait a Second. Where the Heck
Is the Right Button?

Tiger takes a visual approach to everything, and what you see in Figure 4-1 is
designed for point-and-click convenience because the trackpad is your primary
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navigational tool while you’re using your MacBook or MacBook Pro. You move
your finger over the surface of the trackpad, and the cursor follows like an
obedient pup. The faster you move your finger, the farther the cursor goes.
You click an item, it opens, you do your thing, and life is good.

Never use any object other than your finger on the trackpad! No pencils
(including the eraser end), pens, or chopsticks; they can damage your track-
pad in no time at all.

If you've grazed on the other side of the fence — one of Those Who Were
Once Windows Users — you’re probably accustomed to using a trackpad or
mouse with at least two buttons. This brings up the nagging question: “Hey,
Mark! Where the heck is the right button?”

In a nutshell, the right mouse button simply ain’t there. At least, if you're
using your Mac laptop’s trackpad, it simply ain’t there. The entire bottom of
the trackpad is one huge button, and you click something by pressing down
anywhere on the top surface of the aforementioned bump.

Lean in closer, and I'll tell you a secret. (Dramatic pause.) This is one of the
few disagreements that I have with my friends at Apple Computer, Inc. Apple
once felt that a mouse needed but one button, and until the arrival of the
Mighty Mouse on Apple’s desktop models, it was the only button you got.
And you liked it. And you still do, if you're using a Mac laptop’s trackpad.

In fact, you don’t even need to press the trackpad button to perform magic: If
you tap the trackpad quickly, your Mac laptop counts that as a click. Two fast
taps act as a double-click. Also, if you move two fingers over the surface of
the trackpad at once, the Finder window or application scrolls the contents of
the window up or down. (For example, you can use the scroll function to
move up and down through the pages of a document or to move up and
down through a long Web page.) You can control the sensitivity and opera-
tion of your trackpad from the Keyboard & Mouse pane in System
Preferences.

If you're like me, you feel that a right button is pretty doggone essential. In
fact, when my laptop is on my desk at home, I plug in a Logitech optical track-
ball (a really fancy mouse, in effect). This neat device has both a right mouse
button and a scroll wheel. So here’s a Mark’s Maxim that I think you'll appre-
ciate more and more as you use your laptop:

If you can afford a new USB mouse or trackball with more than one button,
buy it. You can thank me later with an e-mail message, which you can send to
mark@mlcbooks.com.

In fact, a new industry is springing up for tiny USB mousing devices espe-
cially made for laptops. Some devices are smaller than a business card, but
they still carry a full complement of two buttons and a scroll wheel. You can
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carry one of these mini-mice in your laptop bag and eschew your trackpad
completely. In fact, in this book I'm going to refer to the pointer as the
“mouse pointer,” whether you’re using your trackpad or a mouse.

Clicking the right mouse button performs the same default function in Tiger
that it does in Windows. Namely, when you click the right mouse button on
most items — icons, documents, even your desktop — you get a contextual
menu of things. That is, you get more commands specific to that item. (Boy
howdy, I hate that word contextual, but that’s what engineers call it. I call it
the right-click menu, and I promise to refer to it as such for the rest of the
book.) Figure 4-2 illustrates a typical convenient right-click menu with all
sorts of cool items at my disposal.

If you're using your laptop’s trackpad or one-button mouse, don’t despair.
You can still display a right-click menu: Just hold down the Control key while
you click. (The cursor gains a tiny, funky looking menu sidecar when you
hold down Control to indicate that you're going to right-click something.)

Pressing an extra key, as you might imagine, can be a real downer, especially
if your non-trackpad-using hand is busy doing something else. Hence my pre-
ceding Mark’s Maxim. Someday, Apple will finally throw in the towel and add
a second trackpad button to their laptops.

(@ Finder File Edit View Go Window Help 7 ™ 4 Mon45LPM % @
|
—
kst (318
(DTS
fana  Dacuments —
A =
™ sk = e |
- 1L Open E
Ei HNenwork iChats Open With > :
Print |
B oo o _ Getlnfo |
.'_'j- Johann (= Show Package Contents
Corverted|  Move to Trash
Desktop z
E Duplicate
(j.': markchambers Make Alias
i Create Archive of "My Great DVD.dvdproj”
/‘-\ Applications
. . Copy "My Great DVD.dvdpro]”
& Documents
8 e | I
&Movles Ea R RN
é Ml Automator >
™ Actures Enable Folder Actions
i Configure Folder Actions.,
LUrilities
: v

1 0f 7 selocred, 47,9 MR availabln e

KOOEROUNIPER Qg O W

57



58

Part II: Shaking Hands with Mac 0S X

Launching and Quitting Applications
with Aplomb

\\J

|
Figure 4-3:
Clicking a
dockiconto
launch that
application.
|

Now it’s time for you to pair your newly found trackpad acumen with Tiger’s
Finder window. Follow along with this simple exercise. Move your cursor
over the iTunes icon on the dock. (This icon looks like an audio CD with a
green musical note on it.) Click the trackpad button (or tap your finger on the
trackpad) once. Whoosh! Tiger launches, or starts, the iTunes application,
and you see a window much like the one in Figure 4-3.

If an application icon is already selected (which I discuss in the next section),

you can simply press 8+0 to launch it. The same keyboard shortcut works
with documents, too.

Close window
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In addition to the dock, you have several other ways to launch an application
or open a document in Tiger:

»* From the Apple menu (#): A number of applications can always be
launched anywhere in Tiger from the Apple menu:

e System Preferences: This is where you change all sorts of settings,
such as your display background and how icons appear.

¢ Software Update: This uses the Internet to see whether update
patches are available for your Apple software.

® Mac OS X Software: This launches the Safari browser and displays
software you can download for your Mac.

+ From the desktop: If you have a document that you've created or an
application icon on your desktop, you can launch or open it here by
double-clicking that icon (clicking the trackpad button twice or tapping the
trackpad twice in rapid succession when the cursor is on top of the icon).

P Double-clicking a device or a network connection on your desktop opens
the contents in a Finder window. This works for CDs and DVDs that
you've loaded as well as external hard drives and USB Flash drives. Just
double-click '’em to open them and display their contents in a Finder
window. Applications and documents launch from a CD, a DVD, or an
external drive just like they launch from your internal drive (the one
that’s named Macintosh HD), so you don’t have to copy stuff from the
external drive just to use it. (You can’t change the contents of most CDs
and DVDs; they’re read-only, so you can’t write to them.)

+* From the Recent Items selection: When you click the Apple menu and
hover your mouse over the Recent Iltems menu item, the Finder displays
all the applications and documents you’ve used over the last few com-
puting sessions. Click an item in this list to launch or open it.

v From the Login Items list: Login Items are applications that Tiger
launches automatically each time you log in to your user account. |
cover Login Items in detail in Chapter 16.

v From the Finder window: You can also double-click an icon in the con-
fines of a Finder window to open it (for documents), launch it (for appli-
cations), or display its contents (for a folder).

After you finish using an application, you can quit that application to close its
window and return to the desktop. Here are a number of ways to quit an
application:

59
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v Press 88+Q. This keyboard shortcut quits virtually every Macintosh
application on the planet.

v Choose the Quit command in the menu. To display the Quit command,
click the application’s name — its menu — from the menu bar. This
menu is always to the immediate right of the Apple menu. (For example,
Safari displays a Safari menu, and that same spot in the menu bar is
taken up by iCal when iCal is the active application. In Figure 4-3, look
for the iTunes menu, right next to 6.)

1 Choose Quit from the dock. You can Control-click (or right-click) an
application’s icon on the dock and choose Quit from the right-click menu
that appears.

A running application displays a small black triangle under its icons on
the dock.

 Click the Close button on the application window (refer to Figure 4-3).
Some applications quit entirely when you close their window, such as
the System Preferences window or Apple’s DVD Player. Other applica-
tions might continue running without a window, such as Safari or iTunes;
to close these applications, you have to use another method in this list.

v Choose Force Quit from the Apple menu, or press 8+Option+Esc. This
is a last-resort measure! Use this only if an application has frozen and
you can’t use another method in this list to quit. Force-quitting an applica-
tion doesn’t save any changes to any open documents in that application!

Juggling Folders and Icons

Finder windows aren’t just for launching applications and opening the files
and documents you’ve created. You can use the icons in a Finder window to
select one or more specific items or to copy and move items from place to
place within your system.

A field observer’s guide to icons

All icons are not created equal. Earlier in this chapter, [ introduced you to
your MacBook’s hard drive icon on the desktop. Here is a little background on
the other types of icons that you may encounter during your laptop travels:

v Hardware: These are your storage devices, such as your hard drive and
DVD drive, as well as external peripherals such as your iPod and printer.

v~ Applications: These icons represent the applications (or programs) that
you can launch. Most applications have a custom icon that incorporates



|
Figure 4-4:
A collection
of some of

my favorite ||

application

icons. |

Chapter 4: Working Magic with the Keyboard and Trackpad

the company’s logo or the specific application logo, so they’re very easy
to recognize, as you can see in Figure 4-4. Double-clicking an application
usually doesn’t load a document automatically; you typically get a new
blank document, or an Open dialog box from which you can choose the
existing file you want to open.
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v Documents: Many of the files on your hard drive are documents that can

be opened in the corresponding application, and the icon usually looks
similar to the application’s icon. Double-clicking a document automati-

cally launches the required application (as long as Mac OS X recognizes
the file type).

v~ Files: Most of the file icons on your system are mundane things (such as

preference and settings files, text files, log files, and miscellaneous data
files), yet most are identified with at least some type of recognizable
icon that lets you guess what purpose the file serves. You also come
across generic file icons that look like a blank sheet of paper (used when
Tiger has no earthly idea what the file type is).

v Aliases: An alias acts as a link to another item elsewhere on your

system. For example, to launch Adobe Acrobat, you can double-click an
Adobe Acrobat alias icon that you created on your desktop instead of
the actual Acrobat application icon. The alias essentially acts the same
way as the original icon, but it doesn’t take up the same space — only a
few bytes for the icon itself, compared with the size of the application.
Plus, you don’t have to go digging through folders galore to find the orig-
inal application icon. (For you Windows switchers, an alias is the same

01
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as a shortcut. But Macs had it first. Harrumph.) You can always identify
an alias by the small curved arrow at the base of the icon — and the
icon might also sport alias at the end of its name.

You can create an alias in two ways. Here’s one:

1. Select the item.
The following section has details about selecting icons.
2. Choose File=>Make Alias, or press 88+L.

Figure 4-5 illustrates a number of aliases, arranged below their linked files.
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Here’s the other way to create an alias:
1. Hold down $+Option.
2. Drag the original icon to the location where you want the alias.
Note that this funky method doesn’t add the alias tag to the end of the
W alias icon name!

So why bother to use an alias? Two good reasons:

v+ Launch an application or open a document from anywhere on your
drive. For example, you can start Apple’s Pages application directly from
the folder where you store the documents for your current Pages project.

+ Send an alias to the Trash without affecting the original item. When
that Pages project is finished, you can safely delete the entire folder
without worrying about whether Pages will run the next time you
double-click the application icon!
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If you move or rename the original file, Tiger is smart enough to update the
alias, too! However, if the original file is deleted (or if the original is moved to
a different volume, such as an external hard drive), the alias no longer works.

Selecting items

Often, the menu commands or keyboard commands that you perform in the
Finder need to be performed on something: Perhaps you’re moving an item to
the trash or getting more information on the item or creating an alias for that
item. To identify the target of your action to the Finder, you need to select
one or more items on your desktop or in a Finder window. In this section, I
show you just how to do that.

Selecting one thing

Tiger gives you a number of options when selecting just one item for an
upcoming action:

»* Move your mouse pointer over the item and click. A dark border, or
highlight, appears around the icon, indicating that it’s selected.

v Type the first few letters of the icon’s name. As soon as you type
enough letters to match an item name uniquely, Tiger highlights (and
selects) that item.

v~ If an icon is already highlighted on your desktop or in a window,
move the selection highlight to another icon in the same location by
using the arrow keys. To move through the icons alphabetically, press
Tab to go forward or Shift+Tab to go backward. To shift the selection
highlight alphabetically, press Tab (to move in order) or Shift+Tab (to
move in reverse order).

Selecting items in the Finder doesn’t actually do anything to them. You have
to perform an action on the selected items to make something happen.

Selecting a whole bunch of things
You can also select multiple items with aplomb by using one of these methods:

v~ Drag a box around adjacent items. If that sounds like ancient Sumerian,
here’s the explanation: Click a spot above and to the left of the first item;
then hold down the trackpad button and drag down and to the right.
(This is dragging in Mac-speak.) A box outline like the one in Figure 4-6
appears to indicate what you're selecting. Any icons that appear within
the box outline are selected when you release the mouse button.
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Figure 4-6:
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v Click the first item to select it and then hold down the Shift key while
you click the last adjacent item. Tiger selects both items and everything
between them.

v Press 38+A to select all the items in a window.

+* Hold down the & key while you click each item. This method works
with nonadjacent items.

Check out the status line at the bottom of a Finder window. It tells you how
much space is available on the drive you’re working in as well as how many
items are displayed in the current Finder window. If you've selected items, it
also shows you how many you’ve highlighted.

Copying items

Want to copy items from one Finder window to another, or from one location
(such as a CD-ROM) to another (such as your desktop)? Trés easy. Just use
one of these methods:
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My, what an attractive sidebar. .. and so useful!

| like as few icons on my desktop as possible. | sidebar so that it's available immediately from
created a separate folder, named Incoming, and  any Finder window. To do this, just drag the
put all the items that might otherwise end up on  folder into the column at the left side of the
my desktop into that folder. In fact, | recently Finder window and drop it in the sidebar’s list of
added my Incoming folder to my Finder window  folder icons.

\\J

” To copy one item to another location on the same drive: Hold down
the Option key (you don’t have to select the icon first) and then click
and drag the item from its current home to the new location.

To put a copy of an item in a folder, just drop the item on top of the

receiving folder. If you hold the item that you're dragging over the desti-

nation folder for a second or two, Tiger opens up a new window so you
can see the contents of the target.

+ To copy multiple items to another location on the same drive: Select
them all first (see the preceding section, “Selecting a whole bunch of
things™), hold down the Option key, and then drag-and-drop one of the
selected items where you want it. All the items that you selected follow
the item you drag. (Rather like lemmings. Nice touch, don’t you think?)

To help indicate your target when you're copying or moving files, Tiger
highlights the location to show you where the items will end up. (This
works whether the target location is a folder or a drive icon.) If the

target location is a window, Tiger adds a highlight to the window border.

+” To copy one or multiple items on a different drive: Click and drag the
icon (or the selected items if you have more than one) from the original
window to a window you’ve opened on the target drive. You can also
drag one item (or a selected group of items) and simply drop the items

&gN\BER on top of the drive icon on your desktop.
&

The items are copied to the top level, or root, of the target drive.

If you try to move or copy something to a location that already has an item

with the same name, Figure 4-7 illustrates the answer: You get a dialog box that

prompts you to decide whether to replace the file or to stop the copy/move
procedure and leave the existing file alone. Good insurance, indeed.
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Figure 4-7:
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Moving things from place to place

Moving things from one location to another location on the same drive is the
easiest action you can take. Just drag the item (or selected items) to the new
location. The item disappears from the original spot and reappears in the
new spot.

Duplicating in a jiffy

If you need more than one copy of the same item in a folder, use Tiger’s
Duplicate command. I use Duplicate often when I want to edit a document but
ensure that the original document stays pristine, no matter what. I just create
a duplicate and edit that file instead.

To use Duplicate, you can either

v Click an item to select it and then choose Filez>Duplicate.

v Control-click the item and choose Duplicate from the right-click menu.

The duplicate item has the word copy appended to its name.
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Duplicating a folder also duplicates all the contents of that folder, so creating
a duplicate folder can take some time to create if the original folder was
stuffed full.

Keys and Keyboard Shortcuts
to Fame and Fortune

Your Mac’s keyboard might not be as glamorous as your trackpad, but any
Macintosh power user will tell you that using keyboard shortcuts is usually
the fastest method of performing certain tasks in the Finder, such as saving
or closing a file. | recommend committing these shortcuts to memory and
putting them to work as soon as you begin using your laptop so that they
become second nature to you as quickly as possible.

Special keys on the keyboard

Apple’s laptop keyboards have a number of special keys that you may not
recognize — especially if you've made the smart move and decided to migrate
from the chaos that is Windows to Mac OS X! Table 4-1 lists the keys that bear
strange hieroglyphics on the Apple keyboard as well as what they do.

Table 4-1 Too-Cool Key Symbols

Action Symbol Purpose

Media Eject 2 Ejects a CD or DVD from your opti-
cal drive

Audio Mute q Mutes (and restores) all sound

produced by your Mac

Brightness y Increases or decreases the
‘3} brightness of your LCD screen

Keyboard illumination Increases, decreases, or turns off

s the brightness of your keyboard
backlighting (PowerBooks and
MacBook Pro only)
Volume Up ) Increases the sound volume
Volume Down L)) Decreases the sound volume

(continued)
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Table 4-1 (continued)

Action Symbol Purpose

Control A Displays the right-click/
Control-click menu

Command 3 Primary modifier for menus and
keyboard shortcuts

Del x> Deletes the selected text

Option X Modifier for keyboard shortcuts

Using Finder and application
keyboard shortcuts

The Finder is chock-full of keyboard shortcuts that you can use to take care
of common tasks. Some of the handiest shortcuts are in Table 4-2.

P But wait, there’s more! Most of your applications also provide their own set
of keyboard shortcuts. While you're learning a new application, display the
application’s Help file and print a copy of the keyboard shortcuts as a handy
cheat sheet.

Table 4-2 Tiger Keyboard Shortcuts of Distinction

Key Combination Location Action

8+A Edit menu Selects all (works in the Finder too)

38+C Edit menu Copies the highlighted item(s) to
the clipboard

88+H Application menu Hides the application

8+M Window menu Minimizes the active window to
the dock (also works in the Finder)

8+0 File menu Opens an existing document, file,
or folder (also works in the Finder)

8+P File menu Prints the current document

#8+Q Application menu Exits the application

8+V Edit menu Pastes the contents of the clip-

board at the current cursor
position
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Key Combination Location Action

88+X Edit menu Cuts the highlighted item to the
clipboard

8+Z Edit menu Reverses the effect of the last
action you took

8847 Help menu Displays the Help system (works in
the Finder, too)

38+Tab Finder Switches between open
applications

88+0ption+M Finder Minimizes all Finder windows to
the dock

88+0ption+W Finder Closes all Finder windows

If you’'ve used a PC before, you're certainly familiar with three-key shortcuts —
the most infamous being Ctrl+Alt+Delete, the beloved shutdown shortcut
nicknamed the Windows Three Finger Salute. Three-key shortcuts work the
same way in Tiger (but you’ll be thrilled to know you won’t need to reboot
using that notorious Windows shortcut). If you're new to computing, just
hold down the first two keys simultaneously and press the third key.

Performing Tricks with Finder Windows

In this section of your introduction to Mac OS X, I describe basic windows
management in Tiger: how to move things around, how to close windows,
and how to make ’em disappear and reappear like magic.

Scrolling and resizing windows

Can you imagine what life would be like if you couldn’t see more than a single
window’s worth of stuff? Shopping would be curtailed quite a bit — and so
would the contents of the folders on your hard drives!

That’s why Tiger adds scroll bars that you can click and drag to move through
the contents of the window. You can either

v Click the scroll bar and drag it

v Click anywhere in the empty area above or below the bar to scroll pages
one at a time
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Figure 4-8 illustrates both vertical and horizontal scroll bars in a typical
Finder window.
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Often, pressing the Page Up and Page Down keys moves you through a docu-

ment one page at a time. Also, pressing the arrow keys moves your insertion
cursor one line or one character in the four compass directions.

You can also resize most Finder and application windows by enlarging or
reducing the window frame itself. Move your mouse pointer over the resize
handle in the lower-right corner of the window (which smartly bears a
number of slashed lines to help it stand out) and then drag the handle in any
direction until the window is the precise size you need.



Chapter 4: Working Magic with the Keyboard and Trackpad

Only one can be active at once

Yes, here’s a special Mark’s Maxim in the Mac though, that you can still use an inac-
0S X universe. Only one application window tive window’s Close, Minimize, and Zoom
can be active in Tiger at any time. You can buttons.

always tell which window is active: 4= Any input you make by typing or by moving

v The active window is on top of other your mouse pointer appears in the active
windows. window.

v The Close, Minimize, and Zoom buttons ¢ Mac 0S X dims inactive windows that you
of the active window are in color. Note, haven't minimized.

Minimizing and restoring window's

Resizing a window is indeed helpful, but maybe you simply want to banish
the doggone thing until you need it again. That’s a situation for the Minimize
button, which also appears in Figure 4-8. A minimized window disappears
from the desktop but isn’t closed: It simply reappears on the dock as a minia-
ture icon. Minimizing a window is easy: Move your mouse pointer over the
yellow Minimize button at the top-left corner of the window — a minus sign
appears in the button to tell you that you’re on target — and then click.

A\
Hold down the Shift key whilst you minimize, and prepare to be amazed when
the window shrinks in slow motion like Alice in Wonderland!

To restore the window to its full size again (and its original position on the
desktop), just click its window icon on the dock.

Moving and zooming windows

Perhaps you want to move a window to another location on the desktop so
you can see the contents of multiple windows at the same time. Click the
window’s title bar (that’s the top frame of the window, which usually includes
a document or application name) and drag the window anywhere you like.
Then release the trackpad button.

a\\J
Many applications can automatically arrange multiple windows for you.
Choose Window=>Arrange All (if that menu item appears).
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Toggling toolbars the Tiger way

Time to define a window control that's actually
inside the window for a change. A toolbaris a
strip of icons that appears under the window’s
title bar. These icons typically perform the most
common actions in an application; the effect is
the same as if you used a menu or pressed a
keyboard shortcut. Toolbars are popular these
days. You see ‘em in everything from the Finder
window to most application windows.

You can banish a window’s toolbar to make
extra room for icons, documents, or whatever it
happens to be holding. Just click the little
lozenge-shaped button at the right corner of the
window. (You guessed it — the Toolbar button
is also shown in Figure 4-8.) One note: By tog-
gling the Finder toolbar off, you also lose the
Finder window sidebar.

R,
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To see all that a window can show you, use the Zoom feature to expand any
Finder or application window to its maximum practical size. Note that a

zoomed window can fill the entire screen, or (if that extra space isn’t applica-
ble for the application) the window might expand only to a larger part of the
desktop. To zoom a window, move your mouse pointer over the green Zoom
button (refer to Figure 4-8 yet again) at the top-left corner of the window.

When the plus sign appears in the Zoom button, click to claim the additional
territory on your desktop. (You can click the Zoom button again to automati-
cally return the same window to its original dimensions.)

Closing windows

When you’re finished with an application or no longer need a window open,
move your mouse pointer over the red Close button at the top-left corner of
the window. When the X appears in the button, click it. (And yes, I can get
one more reference out of Figure 4-8, which I'm thinking of nominating as

Figure of the Year.)

If you have more than one window open in the same application and you
want to close ’em all in one swoop, hold down the Option key while you click
the Close button on any of the windows.

If you haven’t saved a document and you try to close that application’s window,

Tiger gets downright surly and prompts you for confirmation. “Hey, human, you
don’t really want to do this, do you?” If you answer in the affirmative — “Why,
yes, machine. Yes, indeed, | want to throw this away and not save it.” — the
application discards the document that you were working on. If you decide to
keep your document (thereby saving your posterior from harm), you can save
the document under the same filename or under a new name.




Chapter 5
Getting to the Heart of the Tiger

In This Chapter

Making the most of your Home folder

Arranging your desktop for greater efficiency

Adding timesavers to the dock

Using the trash (and rescuing precious stuff from it)

Using Exposé and the Dashboard to perform desktop magic

Printing documents

Wlen you’re no longer a novice to Tiger and the basics of Finder, turn
your attention to a number of more advanced topics 'n tricks that will
turn you into a Mac laptop power user — which, after all, is the goal of every
civilized consciousness on Planet Earth.

Consider this chapter a grab bag of Tiger knowledge. Sure, | jump around a
little, but these topics are indeed connected by a common thread: They’re all
sure-fire problem-solvers and speeder-uppers. (I can’t believe the latter is
really a word, but evidently it is. My editors told me so.)

Vour Home Folder Is Your Homestead

Each user account that you create in Tiger is a self-contained universe. For
example, each user has a number of unique characteristics and folders
devoted just to that person, and Tiger keeps track of everything that user
changes or creates. (I describe the innate loveliness of multiple users living in
peace and harmony on your laptop in Chapter 16.)

This unique universe includes a different system of folders for each user
account on your system. The top-level folder uses the short name that Tiger
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assigns when that user account is created. Naturally, the actual folder name
is different for each person, so Mac techno-types typically refer to this folder
as your Home folder.

Each account’s Home folder contains a set of subfolders, including

v Movies

v Music

¥ Pictures

v Library

v Public

v~ Sites (Web pages created by the user)

v Documents (created by the user)

Although you can store your stuff at the root (top level) of your hard drive,
that horde of files, folders, and aliases can get crowded and confusing very
quickly. Here’s a Mark’s Maxim to live by:

Your Home folder is where you hang out and where you store your stuff. Use
it to make your computing life much easier!

Create subfolders within your Documents folder to organize your files and
folders even further. For example, I create a subfolder in my Documents
folder for every book that [ write. That way, I can quickly and easily locate all
the documents and files associated with that book project.

In Chapter 16, I discuss security in your Home folder and what gets stored
where. For now, Figure 5-1 shows how convenient your Home folder is to
reach because it appears in the Finder window sidebar. One click of your
Home folder, and all your stuff is right in front of you.

In addition to using the Finder window sidebar, you can reach your Home
folder in other convenient ways:

v From the Go menu: Choose Go>Home to display your Home folder
immediately from the Finder window. You can press 38+Shift+H to
accomplish the same thing.

v From the Open and Save dialog boxes: Tiger’s standard File Open and
File Save dialog boxes also include the same Home folder (and sub-
folder) icons as the Finder window sidebar.
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v Within any new Finder window you open: If you like, you can set every
Finder window that you open to do so automatically within your Home
folder.

a. Choose Finderc>Preferences to display the dialog box you see in
Figure 5-2.

b. Click the arrow button on the right side of the New Finder Windows
Open pop-up menu.

A menu pops up (hence the name).
c. Click the Home entry in the menu.
d. Click the red Close button at the top-left corner of the dialog box.

You’re set to go. From now on, every Finder window you open dis-
plays your Home folder as the starting location!

\J , .

) Here’s another reason to use your Home folder to store your stuff: Tiger
expects your stuff to be there when you use Apple’s Backup application or
when you migrate your files from an older Mac to a new Mac.
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Personalizing Your Desktop

Most folks put all their documents, pictures, and videos on their Tiger desk-
top because the file icons are easy to locate! Your computing stuff is right in
front of you . . . or is it?

Call me a finicky, stubborn fussbudget — go ahead, I don’t mind — but I
prefer a clean Tiger desktop without all the iconic clutter. In fact, my desktop
usually has just three or four icons even though I use my MacBook Pro sev-
eral hours every day. It’s an organizational thing; [ work with literally hun-
dreds of applications, documents, and assorted knickknacks every day.
Sooner or later, you'll find that you’re using that many, too.

When you keep your stuff crammed on your desktop, you end up spending
more time scanning your screen for a particular file, alias, or type of icon
than simply looking in your Documents folder! Plus, you'll likely find yourself
looking at old icons that no longer mean anything to you or stuff that’s cov-
ered in cobwebs that you haven’t used in years. Stale icons . . . yuck.

I recommend that you arrange your desktop so you see only a couple of icons
for the files or documents that you use the most. Leave the rest of the desk-
top for that cool image of your favorite actor or actress.
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I can recommend a number of other favorite tweaks that you can make to
your desktop (besides keeping things clean):
” Keep desktop icons arranged as you like.
a. From the Finder menu, choose View->Show View Options.
b. Select the Keep Arranged By check box.

c. From the pop-up menu, choose the criteria that Tiger uses to automat-
ically arrange your desktop icons, including the item name, the last
modification date, or the size of the items.

I like things organized by name.
1 Choose a favorite background.

a. Hold down the Control key while you click any open spot on your
desktop. (Or, if you use a pointing thing with a right mouse button,
click that instead.)

b. From the pop-up menu that appears, choose Change Desktop
Background.

You see the Desktop & Screen Saver pane, as shown in Figure 5-3.
Browse through the various folders of background images that
Apple provides or use an image from your iPhoto library.
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v~ Display everything that’s connected.
a. Choose Finder~>Preferences.

b. Make sure that all three of the top check boxes (Hard Disks; CDs,
DVDs, and iPods; and Connected Servers) are selected.

If your computer is connected to an external network or you've
loaded an external hard drive or device, that shows up on your
desktop. You can double-click that desktop icon to view your exter-
nal stuff.

Customizing the Dock Just So

If the dock seems like a nifty contraption to you, you're right — it’s like one of
those big NASA control rooms. From the dock — that icon toolbar at the
bottom of Tiger’s desktop — you can launch an application, monitor what’s
running, and even use the pop-up menu commands to control the applica-
tions that you launch. (Hey, that NASA analogy is even better than I thought!)

When you launch an application — either by clicking an icon on the dock or
by double-clicking an icon in a Finder window or on the desktop — the icon
begins to bounce hilariously on the dock to indicate that the application is
loading. (So much for my Mission Control analogy.) After an application is
running, the application icon appears on the dock with a tiny triangle under-
neath. That way, you can easily see what’s running at any time just by glanc-
ing at the dock.

You can hide most applications by pressing 8+H. Although the application
itself is still running, it might not appear on the dock.

Some applications run in the background — that is, they don’t show up on
the dock. You generally don’t even know that these applications are working
for you. However, if you need to see in detail what’s going on, you can always
use the Activity Monitor utility to view everything that’s happening on your
MacBook. (For example, an Apple support technician might ask you to

run Activity Monitor to help troubleshoot a problem.) To run the Activity
Monitor:

1. Open a Finder window.
2. Click the Utilities folder in the sidebar or press 38+Shift+U.

3. Double-click the Activity Monitor icon.
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Adding dock icons

Ah, but the dock can offer more than just a set of default icons! You can add
your own MIS (or Most Important Stuff) to the dock, making it the most conve-
nient method of taking care of business without cluttering up your desktop.
You can add

v Applications: Add an application to your dock by dragging the applica-
tion icon from a Finder window into the area to the left of the separator
line (which appears between applications and folders or documents).
The existing dock icons move aside so that you can place the new neigh-
bor in a choice location.

Do not try to add an application anywhere to the right of the separator
line. You can’t put applications there — and Tiger might even think that
you want the application dumped in the trash!

v~ Files and folders: Would you like to add files and folders to the dock?
They belong in the area to the right of the separator line. Again, drag the
desired folders and volume icons to the dock and deposit them in the
desired spot.

v Web URLs: Sure, you can add your favorite Web site from Safari! Drag it
from the Safari address bar into the area to the right of the separator
line. When you click the URL icon, Safari opens the page automatically.

Removing dock icons

You can remove an icon from the dock at any time (as long as the application
isn’t running). In fact, | recommend that every Tiger user remove the default
icons that never get used to make more room available for your favorite
icons. The only two icons you can’t remove are the Finder and Trash icons.

To remove an icon from the dock, just click and drag it off the dock. You're
rewarded with a ridiculous puff of smoke straight out of a Daffy Duck cartoon!
(One of the Mac OS X developers was in a fun mood, I guess.)

When you delete an icon from the dock, all you delete is the dock icon: The
original application, folder, or volume is not deleted.

Using dock icon menus

From the Dock menu, you can open documents, open the location of the item
in a Finder window, set an application as a login item (which I discuss at
length in Chapter 16), control the features in some applications, and engage
in other assorted fun, depending on the item.
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To display the pop-up Dock menu for an icon:

1. Move your mouse over the icon.

2. Click and hold the mouse button for a second or two.
Note that you can also hold the Control key down and click the icon. Or
if you have a right mouse button, click it to display the menu.

In Chapter 6, I cover the dock settings you can change in System Preferences.
You can change the same settings from the Apple menu if you hover your
mouse over the dock item, which displays a submenu with the settings.

Taking Out the Trash
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Another sign of a Mac laptop power user is a well-maintained trash bin. It’s a
breeze to empty discarded items you no longer need, and you can even
rescue something that you suddenly discover you still need!

The Tiger trash bin resides on the dock, and it works just like the trash has

always worked in Mac OS X: Simply drag selected items to the trash to delete
them.

Note one very important exception: If you drag an external device or a remov-
able media drive icon on your desktop to the trash (such as an iPod, a DVD, or
an external hard drive), the Trash icon automagically turns into a giant Eject
icon, and the removable device or media is ejected or shut down — not erased.
Repeat, not erased. (That’s why the Trash icon changes to the Eject icon — to
remind you that you're not doing anything destructive.)

Here are other methods of chucking items you select to go to the wastebasket:

v Choose FilecoMove to Trash.

v Click the Action button on the Finder toolbar and choose Move to
Trash from the list that appears.

v Press 38+Delete.

v Hold down Control (or press the right mouse button) while clicking
the item; then choose Move to Trash from the menu that appears.

You can always tell when the trash contains at least one item because the
Trash icon is full of crumpled paper! However, you don’t have to unfold a wad
of paper to see what the trash holds: Just click the Trash icon on the dock to
display the contents of the trash in a new window. To rescue something from
the trash, drag the item(s) from the Trash window to the desktop or any
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other folder in a Finder window. (If you’re doing this for someone else who’s
not familiar with Tiger, remember to act like it was a lot of work, and you’ll
earn big-time DRP, or Data Rescue Points.)

When you’re sure that you want to permanently delete the contents of the
trash, use one of these methods to empty the trash:

1 Choose Finder~>Empty Trash.

v Choose Finder->Secure Empty Trash.

If security is an issue around your laptop and you want to make sure
that no one can recover the files you've sent to the trash, the Secure
Empty Trash command takes a little time but helps to ensure that no
third-party hard-drive repair or recovery program could resuscitate the

items you discard.

1 Press 38+Shift+Delete.

v Hold down Control while clicking the Trash icon on the dock and

then choose Empty Trash from the contextual menu.

If your mouse has extra buttons, you can right-click to display the con-

textual menu.

Previewing images and documents the Tiger way

Tiger offers a Swiss-Army-knife-type applica-
tion for viewing image files and documents in
Preview, Adobe’s PDF format. You can use
Preview to display digital photos in several pop-
ular image formats, including TIFF, GIF, PICT,
PNG, JPEG, and Windows Bitmap.

| know, if that were the total of Preview’s fea-
tures, it wouldn’t deserve coverage here. So,
what else can it do? Here's a partial list (just my
favorites, mind you):

1+ Use Preview to add a bookmark at the cur-
rent page in a PDF document by choosing
Bookmarks=>Add Bookmark.

v~ Fill outaform in a PDF document by choos-
ing Tools=>Text Tool.

Click a field; if a blue highlight appears, you
can type text into that field. After you com-
plete the form, you can fax or print it.

v~ Take a screen snapshot (saving the con-
tents of your screen as a digital photo) by
choosing Filec>Grab=>Timed Screen.

v~ Convert an image into another format or
into a PDF file by choosing Filez>Save As.

+” Resize or rotate an image using the com-
mands on the Tools menu.

Tiger automatically loads Preview when you
double-click animage in a format that it recog-
nizes or when you double-click a PDF file. It
also acts as the Print Preview window, as you
can read elsewhere in this chapter. However, if
you want to launch Preview manually, open a
Finder window, click the Applications folder in
the sidebar, and then double-click the Preview
icon.
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Saving Time and Trouble with
Dashboard and Exposé
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Mac power users tend to wax enthusiastic over the convenience features
built into Tiger. In fact, we show 'em off to our PC-saddled friends and family.
Two of the features that I've demonstrated the most to others are Tiger’s
brand-new Dashboard display and the amazing convenience of Exposé. In
this section, I show 'em off to you as well. (Then you can become the Tiger
evangelist on your block.)

Using Dashboard

The idea behind the Dashboard is deceptively simple yet about as revolu-
tionary as it gets for a mainstream personal computer operating system.
Dashboard is an alternate desktop that you can display at any time by using
the keyboard or your mouse; the Dashboard desktop holds widgets (small
applications that each provide a single function). Examples of default widgets
that come with Tiger include a calculator, a world clock, a weather display,
and a dictionary/thesaurus.

Oh, did [ mention that you’re not limited to the widgets that come with Tiger?
Simply click the plus button at the bottom of the Dashboard display and drag
new widgets to your Dashboard from the menu at the bottom of the screen.
To remove a widget while you're in this mode, click the X icon that appears
next to each widget. When you’ve finished adjusting your widgets — that
sounds a bit strange, but I mean no offense — click the plus button again to
return to your Dashboard display.

Widgets can also be rearranged any way you like by dragging them to a new
location.

Simple applications like these are no big whoop — after all, Tiger has always
had a calculator and a clock. What'’s revolutionary is how you access your
widgets. You can display and use them anywhere in Tiger, at any time, by
simply pressing the Dashboard key. To banish Dashboard and return to your
Tiger desktop, just press the Dashboard key again.

The default key is F12, but you can change the Dashboard key in the
Dashboard & Exposé pane in System Preferences (or even turn it into a
key sequence, such as Option+F12). You can also click the Dashboard icon
on the dock to summon and dismiss your Dashboard widgets.
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Switching between apps with Exposé

Exposé is a racy sounding feature, but (like Dashboard) it’s all about conve-
nience. If you typically run a large number of applications at the same time,
Exposé can be a real timesaver, allowing you to quickly switch between a forest
of different application windows (or display your desktop instantly without
those very same windows in the way). The feature works in three ways:

v~ Press the All Windows key (or key sequence) to display all your applica-
tion windows on a single screen, as shown in the truly cool Figure 5-4.

Click the window that you want to make active. By default, F9 is the All
Windows key; but depending on your model of Mac laptop, you may
have to press fn+F9 instead.

+~ Press the Application Windows key (or key sequence) to display all
the windows that have been opened by the active application.

This comes in handy with those mega-applications like Photoshop
Elements or FileMaker Pro, in which you often have three or four win-
dows open at one time. Again, you can click the window that you want
to make active. By default, F10 is the Application Windows key, but you
may have to press fn+F10 instead.

@ iTunes File Edit Contrals Visualizer Advanced Window Help = 4f) Mon7S5LPM £ )
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v Press the Desktop key (or key sequence) to move all your application
and Finder windows to the sides of your desktop so you can access
your desktop icons.

After you're finished with your desktop and want to restore your win-
dows to their original locations, press the Desktop key to put things
right again. The default Desktop key is F11.

You can activate both Exposé and Dashboard by using your mouse instead of
the keyboard:

1. Click the System Preferences icon on the dock.

2. Click the Dashboard & Exposé icon to display the settings.

3. Click the desired screen corner pop-up menu to choose what function
that screen corner will trigger.

4. Press 3+Q to save your changes and exit System Preferences.

When you move your mouse pointer to that corner, Dashboard or
Exposé automatically kicks in!

Printing in Mac 0S X
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Tiger makes document printing a breeze. Because virtually all Mac printers
use a Universal Serial Bus (USB) port, setting up printing couldn’t be easier.
Turn on your printer and connect the USB cable between the printer and
your laptop; Tiger does the rest.

Printer manufacturers supply you with installation software that might add
cool extra software or fonts to your system. Even if Tiger recognizes your
USB printer immediately, | recommend that you still launch the manufac-
turer’s Mac OS X installation disc. For example, my new Epson printer came
with new fonts and a CD/DVD label application, but [ wouldn’t have ’em if |
hadn’t installed the Epson software package.

After your printer is connected and installed, you can use the same procedure
to print from just about every Mac OS X application on the planet! To print
using the default page layout settings — standard 8%-x-11" paper, portrait
mode, no scaling — follow these steps:

1. Within the active application, choose File~>Print or press the 3#+P
shortcut.

Mac OS X displays the Print dialog box, as shown in Figure 5-5.
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2. If you want to print from a different printer connected to your laptop

or print over a network connection to a shared printer on another
computer:

a. Click the Printer pop-up menu.

In this pop-up menu, Tiger displays all the printers that you can
access.

b. Click the desired printer to select it.

3. If you want to check what the printed document will look like, click

Preview.

If you have to make changes to the document or you need to change the
default print settings, click Cancel to return to your document. (You
have to repeat Step 1 to display the Print dialog box again.)

4. For more than one copy, click in the Copies field and type the number

of copies you need.

Collation (separating copies) is also available, and it doesn’t cost a thing!
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5. To print a range of selected pages, select the From radio button and
then enter the starting and ending pages.

To print the entire document, leave the default Pages option set to All.

6. If the application offers its own print settings, such as collating and
grayscale printing, make any necessary changes to those settings.

To display these application-specific settings, click the Copies & Pages
pop-up menu in the Print dialog box and choose the desired settings
pane that you need to adjust. (You can blissfully ignore these settings
and skip this step if the defaults are fine.)

7. When you’re set to go, click the Print button.
You can also save an electronic version of a document in the popular Adobe
Acrobat PDF format from the Print dialog box — without spending money on
Adobe Acrobat. (Slick.)

1. Click the PDF button to display the destination list.

2. Click Save as PDF.

Tiger prompts you with a Save As dialog box, where you can type a
name for the PDF document and specify a location on your hard drive
where the file should be saved.

Heck, if you like, you can even fax a PDF or send it as an e-mail attachment!
Just choose these options from the destination list instead of Save as PDF.
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System Preferences Are
Your Friends

In This Chapter
Navigating System Preferences
Searching for specific controls
Customizing Tiger through System Preferences

R emember the old TV series Voyage to the Bottom of the Sea? You always
knew you were on the bridge of the submarine Seaview because it had an
entire wall made up of randomly blinking lights, crewmen darting about with
clipboards, and all sorts of exotic-looking controls on every available surface.
You could fix just about anything by looking into the camera with grim deter-
mination and barking out an order. After all, you were On The Bridge. Virtually
all the dialog and action inside the sub took place on that one (expensive) set:
It was the nerve center of the ship and a truly happenin’ place to be.

In the same vein, I devote this entire chapter to the System Preferences
window and all the settings within it. After all, if you want to change how
Tiger works or customize its features, this one window is the nerve center of
Mac OS X and a truly happenin’ place to be. Sorry, you won'’t find a built-in
wall of randomly blinking lights — but you will find exotic controls just about
everywhere.

An Explanation (in English, No Less)

The System Preferences window (as shown in Figure 6-1) is a self-contained
beast, and you can reach it in a number of ways:

v Clicking the System Preferences icon on the dock, which resembles a
light switch next to the Apple logo. (Don’t ask me, I just work here.)

»* Choosing ®=System Preferences.

»* Choosing ®=Dock=>Dock Preferences.
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v Clicking the Time and Date display in the Finder menu and then choos-
ing the Open Date and Time menu item.

v Control-clicking (or right-clicking) any uninhabited area of your desktop
and choosing Change Desktop Background.

v Clicking most of the Finder menu status icons (including Bluetooth,
AirPort, Display, Modem, and Clock) and then choosing the Open
Preferences menu item.

When the System Preferences window is open, you can click any of the group
icons to switch to that group’s pane, the entire window morphs to display the
settings for the selected pane. For example, Figure 6-2 illustrates the Sound
pane, which allows you to set a system alert sound, configure your laptop’s
built-in microphone, and choose from several different output options.

Many panes also include a number of tabbed buttons at the top — in the case
of the Sound pane, you have Sound Effects, Output, and Input. You can click
these tabs to switch to another fab within the same pane. Many panes in
System Preferences have multiple tabs. This design allows our friends at
Apple to group a large number of similar settings in the same pane (without
things getting too confusing).

Previous
Next Group icons
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To return to the top-level System Preferences tab from any pane, just click

the Show All button (top left), or press 38+L. You can also click the familiar
Previous and Next buttons to move backward through the panes you’'ve
already visited and then move forward again, in sequence. (Yep, these buttons
work just like the browser controls in Safari. Sometimes life is funny that way.)

You won'’t find an OK button that you have to click to apply a System
Preferences change — Apple’s developers do things the right way. Your
changes to the settings in a pane are automatically saved when you click
Show All or when you click the Close button on the System Preferences
window. You can also press 8+Q to exit the window and save all your
changes automatically . . . a favorite shortcut of mine.

If you see an Apply Now button in a pane, you can click it to immediately
apply any changes you’'ve made, without exiting the pane. This is perfect for
some settings that you might want to try first before you accept them, such
as many of the controls on the Network pane. However, if you're sure about
what you’ve changed and how those changes will affect your system, it’s not
necessary to click Apply Now. Just exit the System Preferences window or
click Show All as you normally would.

Locating That Certain Special Setting

Hey, wouldn't it be great if you could search through all the different panes in
System Preferences — with all those countless radio buttons, check boxes,
and slider controls — from one place? Even when you’re not quite sure
exactly what it is you're looking for?
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Figure 6-3 illustrates exactly that kind of activity taking place. Just click in the
System Preferences Search box (in the upper right, with the magnifying glass
icon) and type just about anything. For example, if you know part of the name
of a particular setting you need to change, type that. Tiger highlights the
System Preferences panes that might contain matching settings. And if you're
a Switcher from the Windows world, you can even type in what you might
have called the same setting in Windows XP!
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The System Preferences window dims, and the group icons that might con-
tain what you’re looking for stay highlighted. Slick.

You can also search for System Preferences controls using the Spotlight menu
and Spotlight window. Find more on this cool feature in Chapter 7.

If you need to reset the Search box to try again, click the X icon that appears
at the right side of the box to clear it.

Introducing Mark’s Favorite
Preference Panes

Time to get down to brass tacks. In this section, I discuss the most often used
panes in System Preferences and the magic you can perform in each one! |
won'’t discuss every pane because [ cover many of them in other chapters.
However, this chapter covers just about all the settings that you're likely to
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use on a regular basis. (Some System Preferences panes, such as the
Universal Access or Classic panes, you might never need to open.)

The Display pane

If you're a heavy-duty game player or you work with applications such as
video editing and 3-D modeling, you probably find yourself switching the
characteristics of your monitor on a regular basis. To switch those settings
more easily, visit the Display pane (see Figure 6-4), which includes two tabs:

v~ Display: Click a screen resolution from the Resolutions list on the left.
Tiger displays the number of colors (or color depth) allowed at that reso-
lution, and you can choose a color depth from the Colors pop-up menu.
(Typically, it’s a good idea to use the highest resolution and the highest
number of colors.) Because laptops running Tiger have a flat-panel LCD,
the refresh rate is disabled. However, if you're using a CRT display, I rec-
ommend choosing the highest refresh rate allowed. To change the
brightness level of your display, drag the Brightness slider.

When you select the Show Displays in Menu Bar check box, you can
switch resolutions and color levels right from the Finder menu!

v Color: Your Mac can use a color profile file that controls the colors on
your display. This setting comes in handy for graphic artists and illustra-
tors who need color output from their printer that closely matches the
colors displayed by the laptop. Click the Calibrate button to launch
Display Calibrator, which can create a custom ColorSync profile and cali-
brate the colors that you see on your monitor.
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The Desktop & Screen Saver pane

Hey, no offense to the aqua blue desktop background, but who doesn’t want
to choose his or her own background? And what about that nifty screensaver
you just downloaded from the Apple Web site? You can change both your
background and your screen saver using the Desktop & Screen Saver pane.

The settings on the Desktop tab (as shown in Figure 6-5) are

v Current desktop picture: To change your desktop background, click a

thumbnail. You can also drag a picture from a Finder window or the
desktop and drop it into the well (the fancy Apple word for the square
box with the sunken look). Tiger automatically updates your desktop so
you can see the results. To open another collection of images from
Apple, click the collection folder in the list on the left of the tab. (I rec-
ommend the stunning images in the Nature folder.) If you want to open a
different folder with your own images, click the Choose Folder entry in
the left column and navigate to that folder.

To add your own folder as a collection in the list, drag the folder to the
well from a Finder window.

v Arrangement: You can tile your background image (repeat it across the

desktop), center it, and stretch it to fill the screen. Because the images
from Apple are all sized correctly already, the Arrangement control
appears only when you’re using your own pictures.

v Change Picture: If you’d like a bit of automatic variety on your desktop,

select the Change the Picture check box. You can click the drop-down
list box to set the delay period. The images in the current collection or
folder are displayed in the sequence in which they appear in the thumb-
nail list.

1 Random Order: Select this check box to throw caution utterly to the

wind and display random screens from the current collection or folder!

The settings on the Screen Saver tab are

v Screen Savers: Click the screen saver that you want to display from

the Screen Savers list. Tiger displays an animated preview of the selected
saver on the right. You can also click the Test button to try out the
screen saver in full-screen mode. (Move your mouse a bit to end the test.)

If the selected screen saver has any settings you can change, the Options
button displays them.

1~ Start Screen Saver: Drag this slider to choose the period of inactivity

that triggers the screen saver. Choose Never to disable the screen saver.
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+ Use Random Screen Saver: Another chance to rebel against conformity!
Select this check box, and Tiger chooses a different screen saver each
time.

v Hot Corners: Click any of the four pop-up menus at the four corners of
the screen to select that corner as an activating hot corner. (Moving your
mouse pointer there immediately activates the screen saver.) You can
also specify a corner as a disabling hot corner — as long as the mouse
pointer stays in that corner, the screen saver is disabled. Note that you
can also set the Dashboard and Exposé activation corners from here.
(Read on for the entire lowdown.)
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The Dashboard & Exposé pane

The pane you see in Figure 6-6 illustrates the settings that control Tiger’s
Dashboard and Exposé features. The settings are

v Active Screen Corners: The screen corner pop-up menus operate just
like those in the Screen Savers tab, which I describe in the preceding
section. Click a corner’s list box to set it as

¢ An Exposé All Windows corner (displays all windows on your
desktop)

e An Exposé Application Windows corner (displays only the windows
from the active application)

93
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¢ An Exposé Desktop corner (moves all windows to the outside of
the screen to uncover your desktop)

e A Dashboard corner (displays your Dashboard widgets). Widgets
are small applications that each perform a single task; they appear
when you invoke the awesome power of Dashboard.

These pop-up menus can also set the activate and disable hot corners
for your screen saver.

v Keyboard and Mouse Shortcuts: Pretty straightforward stuff here. Click
each pop-up menu to set the key sequences (and mouse button settings)
for all three Exposé functions as well as for Dashboard.

If you hold down a modifier key — Shift, Control, Option, or 3 — while a
shortcut pop-up menu is open, Tiger adds that modifier key to the selec-
tions you can choose! (Perfect for those folks who already have the F11
key in use by another application. Make your desktop shortcut key the
Shift+F11 key sequence instead.) I should also note that your default
shortcuts may be different (or may require the function key) depending
on the laptop model you're using.

eeaon

4 |

Dashboard & Exposé
Show All | Q

Exposé allows you to temporarily see all your open windows at once, so you can easily
click on any window to bring it to the front. You can set a Dashboard shortcut to show
or hide the Dashboard.

Active Screen Corners

All Windows s

Keyboard and Mouse Shortcuts

All windows: | F9 4 - =
Application windows: | F10 W [- D
Desktop: | F11 B (- B3
Dashboard: | F12 ) “ H
For more shortcut choices, press the Shift, Control, Option, or Command keys. (:?\

The Appearance pane

The talented Appearance pane (shown in Figure 6-7) determines the look and
operation of the controls that appear in application windows and Finder win-
dows. It looks complex, but I cover each option here.
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enn Appearance
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@ Together
Click in the scroll bar to: @Jump to the next page
| )
Jump to here
Figure 6-7: ! Use smooth scrolling
Appear- ™ Minimize when double clicking a windaw title bar
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not be Mumber of Recent Items: 50 m Applications
everything, 20 [3) Documents
but they're 30 %] servers
easy to find =
in System Font smoothing style: = Medium - best for Flat Panel & l
Preferences. Turn off text smoothing for font sizes | 8 '8 and smaller. ‘_?l
|

The settings are

v Appearance: Click this pop-up menu to specify the color Tiger uses for
buttons, menus, and windows.

v+~ Highlight Color: Click this pop-up menu to choose the color that high-
lights selected text in fields, pop-up menus, and drop-down list boxes.

v Place Scroll Arrows: Select a radio button here to determine whether
the arrows that control the scroll bar in a window appear together at the
bottom of the scroll bar or separately at the top and bottom of the
scroll bar.

v Click in the Scroll Bar To: By default, Tiger scrolls to the next or previ-
ous page when you click in an empty portion of the scroll bar. Select the
Jump to Here radio button to scroll the document to the approximate
position in relation to where you clicked. (Smooth scrolling slows down
scrolling, which some people prefer.)

\P
) You can minimize a Finder or application window by simply double-

clicking the window'’s title bar. To enable this feature, select the
Minimize When Double Clicking a Window Title Bar check box.

1+ Number of Recent Items: By default, Tiger displays ten recent applica-

tions, documents, and servers in the Recent Items item in the Apple menu.

Need more? Just click the corresponding pop-up menu and specify up to
50 items.
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+ Font Smoothing Style: This feature performs a little visual magic that
makes the text on your monitor or flat-panel look more like the text on a
printed page. Most laptop owners should choose Standard (for a typical
CRT monitor used as a secondary screen) or Medium (for your laptop’s
flat-panel LCD display).

v Turn Off Text Smoothing for Font Sizes: Below a certain point size, text
smoothing doesn’t help fonts look any smoother on the screen. By
default, any font displayed at 8 points or smaller isn’t smoothed, which
is a good choice for a Mac laptop with a flat-panel LCD screen.

The Energy Saver pane

I'm an environmentalist — it’s surprising how many techno-types are colored
green — so | think the two tabs of the Energy Saver pane (shown in Figure
6-8) are pretty doggone important. When you use them correctly, you can not
only save electricity but even invoke the Power of Tiger to automatically start
and shut down your Mac whenever you like!

ann Energy Saver
[« »|[ Showan | Q

)
)

Your energy settings are optimized for high performance.
Current battery charge: 100%

Settings for: = Battery

-| ar

Optimization: = Custom

Sleep | Options

Put the computer to sleep when it is inactive for:

1 min 15 min 1hr 3 hrs  Never

|
Figure 6-8: Put the display to sleep when the computer is inactive for:
Reduce =] 1 [ i i ] E=r]
1 min 15 min Thr 3hrs  Never
your Mac
laptop’s
power
consump- 1 Put the hard disk(s) to sleep when possible \?‘1
tion from o
the Energy Hide Details ) (_ Schedule... )
0
Saver pane' i ‘g Click the lock to prevent further changes.
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The tabs are as follows:

v~ Sleep: To save electricity, drag the Put the Computer to Sleep When It Is

Inactive For slider to a delay period that triggers sleep mode when you're
away from the keyboard for a significant period of time. (I prefer 30 min-
utes.) If your Mac must always remain alert and you want to disable sleep
mode entirely, choose Never. You can set the delay period for blanking
your monitor separately from the sleep setting with the Put the Display
to Sleep When the Computer Is Inactive For slider. To conserve the maxi-
mum juice and cut down on wear, select the Put the Hard Disk(s) to Sleep
When Possible check box to power-down your hard drives when they’re
not needed. (This might cause a delay of a second or two while loading
or saving files because the drives must spin back up.)

You can set Tiger to start or shut down your Mac laptop at a scheduled
time. Click the Schedule button and then select the desired schedule
(the Start Up/Wake check box and the Shut Down/Sleep pop-up menu) to
enable them. Set the trigger time by clicking the up and down arrows
next to the time display for each schedule. Click OK to return to the
Energy Saver pane.

v Options: From this tab, you can specify events that can awaken your

Mac from sleep mode, such as a ring signal from your modem. If you
prefer to send your laptop to sleep by pressing the Power button, select
the Allow Power Button to Sleep the Computer check box. Tiger can also
restart your Mac automatically after a power failure.

If you're running an older laptop that uses a G4 processor, the Processor
Performance pop-up menu appears in the Options tab. You can use this
control to fine-tune the performance of your laptop’s processor to
reduce its power consumption and heat buildup. Choose Automatic to
allow Tiger to monitor and tweak your processor’s performance when-
ever possible. Choose Highest if you want the best possible performance
at all times — note that this setting may result in significant heat
buildup, especially on older G4-based Mac laptops. Choose the Reduced
option if you need to conserve battery power or reduce heat buildup.

The Dock pane

I'll come clean: [ think the dock is the best thing since sliced bread! (I wonder
what people referred to before sliced bread was invented?) You can use the
settings shown in Figure 6-9 to configure the dock’s behavior until it fits your
personality like a glove:

v Dock Size: Pretty self-explanatory. Just drag the slider to change the

scale of the dock.
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v Magnification: When you select this check box, each icon on your dock
swells up like a puffer fish when you move your mouse cursor over it.
(Just how much it inflates is determined by the Magnification slider.) |
like this feature because I resize my dock so it’s smaller, and [ have a
large number of dock icons.

v~ Position on Screen: Select a radio button to position the dock on the
left, bottom, or right edge of your Mac’s desktop.

v Minimize Using: Tiger includes two cool animations that you can
choose from when shrinking a window to the dock (and expanding it
back to the desktop). Click the Minimize Using pop-up menu to specify
the genie-in-a-bottle effect or a scale-up-or-down-incrementally effect.

\P
) If animation isn’t your bag or you want to speed up the graphics perfor-

mance of an older Mac laptop, you can turn off these minimizing effects
by clicking the Minimize Using checkbox to deselect it.

v Animate Opening Applications: Are you into aerobics? How about punk
rock and slam dancing? Active souls who like animation likely get a kick
out of the bouncing application icons on the dock. They indicate that
you’ve launched an application and it’s loading. You can turn off this
bouncing behavior by disabling this check box.

v Automatically Hide and Show the Dock: Select this check box, and the
dock disappears until you need it. (Depending on the size of your dock,
the desktop that you gain can be significant.) To display a hidden dock,
move your mouse pointer over the edge of the desktop you selected
with the Position on Screen radio button.

eer Dock
|« & || Showall | Q

Dotk Size: m—fi—

Small Large

# Magnification: =

— rx e
Figure 6-9: Position on screen: [ ] ®
Customize Left  Bottom  Right

yOur dock Minimize using: M

using these # Animate opening applications
controls. | Automatically hide and show the Dock (7)

The Sharing pane

So you'’re in a neighborly mood, and you want to share your toys with others
on your local wired or wireless network. Perhaps you’d like to start your own
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Figure 6-10:
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Web site or protect yourself against the Bad Guys on the Internet. All these
fun diversions are available from the Sharing pane in System Preferences, as
shown in Figure 6-10.

een Sharing
|« —|| Show All | Q

Computer Name: WhiteDragon

Other computers on your local subnet can access e
your computer at WhiteDragon.local { Edit... )

[ Services | Firewall | Internet '

Select a service to change its settings.

On | Service Personal File Sharing On
i Personal File Sharing " Stop

Windows Sharing
Personal Web Sharing Click Stop 1o prevent users of other

z computers from accessing Public folders on
Remote Login this computer.

FTP Access

Apple Remote Desktop
Remaote Apple Events
Printer Sharing

Xgrid

DD0ooo®mo

Other Macintosh users can access your computer at afp://192.168.1.103/ or browse for
“WhiteDragon® by choosing Network from the Go menu in the Finder.,

P
L
] H Click the lock to prevent further changes.

Here’s the lowdown on the three tabs the Sharing pane offers:

v~ Services: Each entry in the services list controls a specific type of shar-
ing, including Personal File Sharing (with other Macs), Windows Sharing
(with PCs running Windows), Personal Web Sharing, Remote Login, FTP
Access, Apple Remote Desktop, Remote Apple Events, Printer Sharing,
and Xgrid. (More on these services and what they do appears in Chapter
17.) To turn on any of these services, select the On check box for that
service. To turn off a service, choose it from the list and click the Stop
button that appears, or just disable the On check box for that service.

To change the default network name assigned to your laptop during
Tiger’s setup process, click in the Computer Name text box and type the
new name.

v Firewall: You can enable Tiger’s powerful built-in Internet firewall from
this tab — and I strongly urge you to do so! A firewall blocks communi-
cation to any sharing service not allowed in the list. To enable communi-
cations with a service, select the entry in the list and select the On
check box to enable it. (Note that Tiger takes care of this automatically
when you start a service on the Services tab.)
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Need to create an opening (or porf) in your firewall for an application?
Click the New button and specify a new port by entering a port number
and assigning it a name. The new port appears in the list, and you can
turn it on and off like any other port. You can also edit or delete the
selected port.

If you find that your Mac suddenly can’t connect to other computers (or
share services that you were able to share) after you turn on your fire-
wall, one (or more) of your ports is set incorrectly. (This often happens
if you turn off a port manually.) Review each service that you've turned
on, and then make sure the corresponding ports are opened on the
Firewall tab.

v+ Internet: To share an Internet connection from your Mac laptop to the

rest of the computers on your network, click the Share Your Connection
From pop-up menu and choose the proper port. For just about every
network, you should choose the Built-in Ethernet port (naturally, wire-
less folks can choose AirPort). Then click Start.

Security is always an issue when you share your Internet connection with
others. Chapter 17 includes information on common-sense security rules you
should follow while networking!
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Sifting through Your Stuff

In This Chapter
Understanding how Spotlight works

Searching for data, files, and folders using Spotlight
Using the results you get from a Spotlight search
Searching with the Find dialog box and the Search box

Searching for stuff on the Internet with Sherlock

Wlat would you say if I told you that you could search your entire
system for every single piece of data connected with a person — and

only in the time it takes to type that person’s name? And I'm not just talking
about files and folders that might include that person’s name. I mean every
e-mail message and every iCal calendar or event that references that person
and even that person’s Address Book card to boot? Heck, how about if that
search could dig up every occurrence of the person’s name inside your elec-
tronic PDF documents?

You’d probably say, “That makes for good future tech — I'll bet I can do that
in five or ten years. It’ll take Apple at least that long to do it . . . and just in
time for me to buy a new laptop! (Harrumph.)”

Don’t be so hasty: You can do it right now. The technology is a new Mac OS X
feature named Spotlight, built right into Tiger. In this chapter, I show you how
to use it like a Mac power guru. [ also show you how to take advantage of
Sherlock, the best Internet search tool ever.

A Not-So-Confusing Introduction
to Spotlight

Invoking the magic of Spotlight is a snap. As you can see in Figure 7-1, the
Spotlight search field always hangs out on the right side of the Finder menu
bar. You can either click once on the magnifying glass icon or just press F5.
Either way, Tiger displays the Spotlight search box.
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Spotlight works by indexing — in other words, searching for and keeping track
of keywords in your files. In fact, Tiger indexes the contents of your laptop’s
hard drive into a huge file, which it constantly maintains as you create and
modify files. Tiger can search this index file in a fraction of a second after you
enter your search criteria. The index file contains all sorts of data, including
quite a bit of information from various documents — hence Spotlight’s ability
to present matching data inside your files and application records.

When you first boot Tiger, it spends anywhere from a few minutes to an hour
or two creating the Spotlight index file. If you click the Spotlight icon whilst
indexing is taking place, you’ll see a progress bar indicating how much longer
you have to wait before you can use Spotlight. Creating this full index hap-
pens only once, so it’s no great burden to bear.

You can search for any string of text characters in Spotlight. You'll be surprised
at everything this plucky feature will search. For example, Spotlight searches
through your Address Book contacts, mail messages, iCal calendars, iChat tran-
scripts, and even System Preferences! Yep, you can even use it to find specific
settings in all those System Preferences panes, such as printer sharing or
Dashboard. Spotlight locates and displays matching files and folders — like that
other operating system — but it performs searches in the blink of an eye.
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Spotlight matches only those items that include all your search text:
Therefore, if you enter just the word horse, you're likely to get far more
matches than if you enter a word string, such as horse show ticket.

If you add metadata to your documents (such as the Comments field in a
Word document or the keywords embedded in a Photoshop image), Spotlight
can match that information as well. Other recognized file formats include
AppleWorks documents, Excel spreadsheets, Keynote presentations, Pages
documents, and third-party applications that offer a Spotlight plug-in.

Spotlight works so seamlessly — and so doggone fast — because it’s literally
built into the core of Tiger (unlike that other operating system that begins
with a W, which uses a separate program to search and can take a couple of
minutes to return just matching filenames). Spotlight’s integration into the
heart of Tiger allows those high-IQ Apple developers (and even smart folks
outside the company) to easily use it elsewhere within Tiger — more on this
later in the chapter.

Searching for all sorts of things
with Spotlight

To begin a Spotlight search, display the Spotlight box, click in it, and start
typing. As soon as your finger presses the first key, you'll see matching items
start to appear. Check out Figure 7-2, in which I typed only a single character.
(No need to press Return, by the way. This is all automatic from here on.) As
you continue to type, Spotlight’s results are updated in real-time to reflect the
new characters.

Spotlight displays what it considers the top 20 matching items within the
Spotlight menu itself. These most relevant hits are arranged into categories
such as Documents, Images, and Folders. You can change the order in which
categories appear (using the Spotlight pane in System Preferences, which I
cover a bit later in this chapter).

Using internal magic, Spotlight presents the Top Hit category (with what it con-
siders the single most relevant match) at the top of the search results, as also
shown in Figure 7-2. You'll find that the Top Hit is often just what you’re looking
for. To open or launch the Top Hit item from the keyboard, press $8+Return.

Didn’t find what you were after? Click the X icon that appears at the right side
of the Spotlight box to reset the box and start over.

If all you know about the item you're searching for is what type of file it is —
for example, you know it’s a QuickTime movie, but you know nothing about
the title — just use the file type, such as movies, all by itself as the keyword
in the Spotlight field. This trick works with image files and audio files, too.
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Here’s another trick that’s built into Spotlight: You can type a relative time
period — such as yesterday, last week, or last month — and Spotlight will
match every item that was created or received within that period. That’s 100
percent sassy/

Working with matching stuff

After you run a fruitful search, and Spotlight finds the proverbial needle in
your system’s haystack, what’s next?

Just click the item — that’s all it takes. Depending on the type of item, Tiger
does one of four things:
v Launches an application

v Opens a specific pane in System Preferences (if the match is the name of
a setting or contained in the text on a Preferences pane)

v Opens a document or data item, such as an Address Book card

v Displays a folder in a Finder window
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To see all sorts of useful info about each Spotlight menu item, click the Show
All item (above the Top Hit listing) to expand your Spotlight menu into the
Spotlight Results window, as shown in Figure 7-3. From the keyboard, you can
press the Results window shortcut key, which you can set from System
Preferences (more on this in a page or two).
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The category groups in the upper-right side of the Results window allow you
to group your results by different categories. You can also specify how items
are sorted within each group by clicking the option you want under the Sort
Within Group By heading. Spotlight displays images as thumbnails to make
them easier to differentiate.

To display the details about any item in the list (without selecting it, which
closes the Results window), click the Info icon (lowercase italic i in a circle)
at the right side of the item entry. After you locate the item you want, click it
to open, launch, or display it, just like you would in the Spotlight menu.

Use the filter settings in the column at the right to display or hide items by
the date they were created or last saved (the When section) or by their
source (such as your hard drive or Home folder).

Tweaking Spotlight in System Preferences

The System Preferences window boasts a new Spotlight icon, which you can
use to customize what search matches you’ll see and how they’ll be presented.
To adjust these settings, click the System Preferences icon on the dock (look
for the light switch) and then click the Spotlight icon (under Personal).
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Configuring the Search Results settings
From the Search Results tab of the Spotlight Preferences pane, you can

v Choose your categories: To disable a category (typically, because you
don’t use those types of files), select the check box next to the category
to clear it.

v Specify the order in which categories appear within Spotlight: Drag
the categories into the order that you want them to appear in the
Spotlight menu and Results window.

1 Select new Spotlight menu and Spotlight Results window keyboard
shortcuts: In fact, you can enable or disable either keyboard shortcut, as
you like. Click the pop-up menu to choose a key combination.

Marking stuff off-limits

Click the Privacy tab to add disks and folders that should never be listed as
results in a Spotlight search. The disks and folders that you add to this list
won’t appear even if they match your search string. This safeguard can come
in handy for organizations (such as hospitals) that are required by law to pro-
tect their patient or client data. You can also select a removable hard drive
here, which is often stored in a safe, after-hours.

To add a private location, click the Add button (which bears a plus sign) and
navigate to the desired location. Then click the location to select it and then
click Choose. (If you already have the location open in a Finder window, you
can drag folders or disks directly from the window and drop them into the list.)

Other Search Tools Are Available Too

For a few years now, the Finder window toolbar has featured a Search box and
Tiger has included a Find dialog box, but even the older Search features in
Tiger have been updated to take advantage of Spotlight technology. Now you
can use file types (such as image or movie) and relative time periods (such as
yesterday and last week) in the Finder window Search box and Find displays!

[ typically use the Finder window Search box if [ need to do a simple file or
folder name search — it works the same as using the Spotlight search field.
Just begin typing, and use the X button in the Search box to reset the field. To
choose a specific location for your search — such as your Home folder or a
hard drive volume — click the desired button along the top of the Search
results display. The Finder window automatically turns into a Results display.
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Tiger also includes the oldest Search method in the book: the Find display. (It
used to be a dialog box all by itself, but now the Find controls are displayed
in the Finder window, so it’s more of an extension to the Finder window.)
Choose Filer>Find or press 38+F to display the Find controls. From here, you
can click pop-up menus to choose a specific filename or portion of a file-
name. Other modifiers include the file type, content, label color, file size, and
the last date the file was opened. Again, click the location buttons at the top
of the window to choose where to search.

The Find display, however, is a little more sophisticated than the toolbar
Search box. You can click the plus (+) button next to a search criterion field
in the Find display to add another field, allowing for matches based on more
than one condition. Click the minus (-) button next to a search criterion field
to remove it.

After you find a match, both of these older search methods work the same:
Click the item once to display its location, or double-click it to launch or open
it. Files can also be moved or copied from the Results and Find displays with
the standard drag and Option+drag methods. You can return to the more
mundane Finder window display by clicking the Back button on the toolbar.

These older search methods can also do one thing that Spotlight doesn’t
offer: You can use them to create a new Smart Folder. Click the Save button in
either the Finder window Search Results or the Find display. You’'ll be
prompted to specify the name and location for the new Smart Folder and
whether it should appear in the Finder window sidebar. After you create the
folder, Tiger automatically updates the contents of the Smart Folder with
whatever items match the criteria you've saved. You'll never have to search
using the same text or criteria again! (Each icon in a Smart Folder is a link to
the file or folder, so nothing gets moved, and no extra space is wasted with
multiple copies of the same items.) You can work with the files and folders
inside a Smart Folder as if they were the actual items themselves.

Putting Sherlock on the Case

No chapter on searching in Mac OS X would be complete without that famous
Internet sleuth, Sherlock (as shown in Figure 7-4). Conan Doyle himself would
be proud indeed if he could see just how much information Tiger’s Sherlock
application can pluck from Web pages, Internet search engines, and all sorts
of content providers.

Each channel, or search type, in Sherlock has a different function. To see a
short description of what each can do, just click the Channels button. In this
section, | demonstrate how to use three of the most useful channels to track
down the information you need.
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Okay, [ know you’re going to roll your eyes, but I have to remind you that you
need an Internet connection to use Sherlock. Otherwise, Sherlock is about as
useful as a pair of swim fins in the Sahara.

Searching that darn Internet for data
and pictures

If you're using Safari, check out the Google search box conveniently located
in the Safari toolbar. (Still, Sherlock can perform the same duties if you
choose the Internet channel.) You’ll find Sherlock in your Applications folder
on your laptop’s boot drive. (Click the Applications icon in the sidebar that
appears in any Finder window to open your Applications folder.) After you
double-click the Sherlock icon to launch the application, follow these steps to
track down specific information from Web sites around the world, using a
number of Internet search engines:

1. Click the Internet channel button.

2. Type the phrase Elvis Parade into the Topic or Description box, and
then click the Search button (yep, it’s the button with the magnifying
glass).

To force a search for an exact phrase, surround it with quotes.

3. When you find the perfect match for your search, click that entry to
display the summary text.

I'll bet you didn’t know there were so many parades featuring Elvis
impersonators, did you?
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4. To display the entire Web page in all its glory, double-click the entry.

Sherlock launches Safari (or whatever you've installed as a default
browser).

Getting movie information in the
new millennivm

Ready to take in a good movie? Yep, you guessed it, Sherlock can help! To
search local theaters for information on a movie — and watch the trailer to
boot — follow these steps:

1. Click the Movies channel button.

2. Click the Movies button to search by movie name.

You can also search by theater name by clicking the Theaters button. To
filter the results you'll get, enter a different city/state combination or Zip
code in the Find Near box.

3. Click the Showtime pop-up menu and then select today’s date.

4. When you find a listing that looks good, click that entry to display the
summary text.

Sherlock automatically downloads a thumbnail of the movie poster (and,
if available, the QuickTime movie trailer). If you have a broadband or
network Internet connection, click the Play button in the QuickTime
viewer window to watch the trailer.

5. In the center column, click the theater you want to display a list of the
show times for the selected film.

Keep an eye on my stocks, Watson!

What better stock to monitor than Apple? I use the Stocks channel all the
time to keep up on the latest news and information on a number of stocks.

Follow these steps to monitor a stock:

1. Click the Stocks channel button.

2. In the Company Name or Ticker Symbol box, type Apple (or its ticker
symbol, AAPL).

(I would check Microsoft’s stock, but it hasn’t been doing so well
recently.)
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3. Press Return or click the Search button.

4. To display the text of a news item (or a link to the story on the Web),
click the desired headline.

Sherlock displays the text of the news item in the summary section, and
Safari launches automatically to display Web pages.

5. To switch to another stock you’ve recently been watching, click the
stock entry in the list at the top of the window.

Like any other public-access stock ticker, the quotes you see on the Stocks
channel are delayed 15 minutes. (Go figure.)
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“T can be reached at home on my cell phone, T can
be veached on the voad with my pager and PDA.
Soon T'11 be veachable on a plane with email. T'm
beginning to think identity theft wouldn’t be
such a bad idea €or a while.”




In this part . . .

ou want to do the Internet thing, don’t you? Sure you

do — and in this part, I describe and demonstrate
your Safari Web browser. You also find out about Apple’s
.Mac Internet subscription service, and how you can
store, back up, and synchronize your data online. Finally,
this part fills you in on connecting important stuff such as
printers and scanners, as well as how you can use your
cool-looking Apple remote and your laptop’s built-in iSight
Webcam.




Chapter 8
Taking Your Laptop on Safari

In This Chapter

Identifying the major controls in Safari

Jumping to a site and navigating the Web
Searching for information and recently visited sites
Recognizing secure connections

Specifying a home page

Putting bookmarks to work

Staying current with an RSS feed

! ooking for that massive Microsoft monster of a Web browser on your
MacBook Pro? You know, the one that practically everyone uses in the
Windows world. What'’s it called? [ forget the name.

You see, [ use a Mac laptop, and I proudly surf the Web using a lean, mean —
and very fast — browser application. That’s Safari, of course, and it just
keeps getting better with each new version of Mac OS X. Safari delivers the
Web the right way, without the wait.

If you need a guide to Safari, this is your chapter. Sure, you can start using it
immediately, but wouldn’t you rather read a few pages so you can surf like a
power user?

It’s Not Just Another Web Browser

Safari could almost be mistaken for a Finder window! Figure 8-1 illustrates the
Safari window, with the most important controls and whatnots marked. To
launch Safari, click the spiffy-looking compass icon on the dock.
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|
Figure 8-1:
The Web
doesn't get
any better
than this —
the default
Safari
window.
|
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Status

Page window

Let’s begin with introductions all around to the stuff in Figure 8-1:

v Previous and Next buttons: Click the Previous button (left-facing triangle)
to surf backwards — no small feat on water but no big deal here. Safari
simply returns you to the last page you visited, and each additional click
takes you back one page further. If you've moved one or more pages back-
ward, you can click the Next button (right-facing triangle) to move for-

ward through those same pages again.

v Reload button: Clicking this button (circular arrow) reloads, or refreshes,
the current page, updating the page with the latest information from the
Web server. This feature is useful for Web sites that change periodically,
such as www . cnn . com or your stockbroker’s Web site.
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v Add a Bookmark button: Click this button (a plus sign) to add the cur-
rent page to your collection of bookmarks, which are favorite sites that
you return to regularly. (More about bookmarks later in the section
“Organizing favorite spots with bookmarks.”)

1 Address box: You can enter a Web site’s address (URL) manually in this
box, or you can drag a Web address from another application here to
jump directly to that page.

v Google search box: One of the slicker features of Safari, this box (look
for the magnifying glass) allows you to search Google for keywords that
you type without having to visit www.google. com first.

v+ Show All Bookmarks button: Clicking this button, which looks like an
open book, displays (or hides) a special screen from which you can
organize your bookmark collections and select a specific bookmark. You
can also add or remove bookmarks from the bookmarks bar and
Bookmarks menu from this screen.

+* Bookmarks bar: This button strip (which appears below the Safari tool-
bar) allows you to jump directly to your most important bookmarks.

v~ Page window: No surprises here! This window displays the contents of
the current Web page, including all sorts of stuff such as links to other
pages, images, animated graphics, pop-up windows (if you want them),
and anything else that appears on a Web page.

v~ Status bar: Not particularly flashy, but I like the status bar nevertheless
because it updates you with information on what you’re doing, what’s
currently loading, or what will load if you click a link.

Handling Basic Safari Chores

Sure, you're likely saying, “Mark, I already know this stuff. I can operate a Web
browser blindfolded — while listening to The Best of Air Supply, even.” | know
that most browsers work in the same way, and Safari shares most of those
mechanics. However, I'm a thorough guy (just ask my editors). Therefore, just
in case you've never used a browser before, let me show you how to surf.

And no giggling from the Peanut Gallery.

Entering Web addresses

The most mundane method of crossing the Web and visiting a specific site is
manually typing the Web page address — more technically called a URL,
short for Uniform Resource Locator — directly into the address box. Click the
tiny image icon that appears at the beginning of the address box, start typing,
and then press Return after you enter the entire address. Boom, you're there.
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Tabs: Love ‘em or leave ‘em

Safari offers an alternate method of display-
ing multiple Web pages — Tabbed browsing
mode. With Safari open, just choose Safarie>
Preferences to display the Preferences dialog
box and then click the Tabs button. From here,
select the Enable Tabbed Browsing check box
to turn on tabs.

In Tabbed browsing mode, Safari doesn’t open
a new window or replace the current Web page
when you click a link. Instead, a tab represent-
ing the new page appears under the bookmarks
bar, and you can click it to switch pages.
However, you have to open a link or a bookmark
as a tab by holding down the 88 key while you
click. Otherwise, Safari acts as it usually does
and replaces the contents of the window with
the new page.

In fact, this area below the bookmarks bar
becomes a separate strip called the tab bar. To
remove a tabbed page from the tab bar, click the
X button next to the tab’s title. (If less than two
tabs are active, the tab bar automatically disap-
pears, unless you've enabled the Always Show
Tab Bar check box on the Tabs pane of the
Preferences dialog box.)

To be honest, I'm not a huge fan of tabs because
| tend to surf the Web in a linear fashion and
don't often keep multiple windows open.
(Evidently, Apple thinks that most people fall in
the same category because Tabbed browsing is
disabled by default.) However, if you do a lot of
comparison shopping or research, or you find
yourself with a dozen Safari windows open at
once, tabs might be just the ticket for you.

However, other methods of entering addresses are a bit easier than all that

hunt-and-peck action:

v Click a link: If the page that’s currently displayed includes an under-

lined link to another page, you can click the colored link text to jump to

P that page.

Links can also be attached to images. You know when you’re over a link
because the mouse cursor changes to a pointing hand.

v~ Use the Google search box: A Google results page contains links to Web
pages that match your search criteria. (More on Google later in the
upcoming section, “It’s a snap to search with Google.”)

+* Double-click an HTML file: If an application saves an HTML file on your
drive, you can display that page by double-clicking the file icon to make
Safari launch and load the page automatically. (HTML is the computer
“language” of Web pages. When you visit a Web site on the Internet,
you're actually receiving a series of commands that tell Safari what text
to display and how to display it. These commands can also be saved as
a file to your hard drive.)

v Click a bookmark: Bookmarks can appear on the Bookmarks menu or the
bookmarks bar, and a single click automatically sends you to that site.

v Click a Web address icon: A Web address icon looks like a spring-loaded
@ symbol. By default, the Tiger dock contains the perfect example. On
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|
Figure 8-2:
Add a Web
page to the
dock.

the right side of the dock, you see a Web address icon. Clicking that icon
takes you to the Mac OS X home page on the Apple Web site, as shown in
Figure 8-2. You can drag any Web address to the right side of the dock (to
the right of the vertical line) to create your own dock Web address icon.

v Drag-and-drop; cut-and-paste: You can cut or copy a Web address from a
document and paste it into the Safari address box. Often you can drag-
and-drop an address into the address box as well.

Putting the toolbar to work

You can specify which controls — buttons — should appear on the Safari
toolbar. For example, if you don’t use the Add a Bookmark button very often,
you can hide it to make room for another control that sees more action:

+ To add a toolbar control: Choose View=>Customize Address Bar.

A sheet appears in which you can drag controls to and from the toolbar.

v To return to the default set of Safari toolbar controls: Drag the preset
default group back to the toolbar.
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Click this Web address icon to launch Safari
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What about downloading?

The default Safari configuration can handle just
about any type of download file you throw at it,
including movies, MP3 audio, disk images, and
executable applications. Just click the down-
load link, and the Downloads window pops up
to keep you informed of the status of the trans-
fer. Things work the way they’re supposed to,
even the first time you run Safari after you
unpack your new laptop.

However, | am going to persistin reminding you
about the possibility of malicious files and the
damage they can do to your system. These
include viruses, Trojan horses (applications that
appear to be harmless but are designed to do
Very Bad Things), and Java applets. Here are
the rules: Never download or run any applica-
tion from a Web site that you don't trust, and
always run an antivirus application to scan any-

thing you download. Nuff said.

Although I discuss most of the Safari toolbar buttons earlier in this chapter,
two or three don’t appear on the default toolbar configuration. You can see
them in Figure 8-3. Here’s a rundown on the controls that you can add to the
toolbar:

v+ Home: Click this button (which looks like a house) to return immediately
to your home page. To find more on selecting a home page, see the
“Putting down roots with a new home page” section, later in this chapter.

v AutoFill: This button (look for the pencil) is great if you do a lot of
online shopping or regularly fill out forms online. Click AutoFill, and
Safari does its best to automatically complete online forms with the
information that you provide in the AutoFill section of the Safari
Preferences dialog box. (Choose Safari=>Preferences to display this
dialog box.) You can choose to AutoFill with data from your personal
Address Book card, and you can also specify whether AutoFill should
take care of names and passwords.

Vg‘“‘NG" AutoFill works its magic for anyone who's sitting at the keyboard. If your
S Mac is in a public location and you can’t guarantee that you’ll be the one
using it (or you're worried about security in general), fill out forms manu-
ally. We're talking about your personal information here — even your
login names and passwords, if you choose!

Don’t provide any personal information to any Web site unless the
connection is secure. Skip to the upcoming section, “Using secure
connections.”

v~ Text size: These two buttons (small and large capital As) allow you to
decrease or increase the point size of the text on your Web pages. This
feature is great for those who prefer larger text for better readability.
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v Bug: Strange name, but a click of the Bug button (um, look for the
spider-ant critter) helps Apple improve Safari! If you visit a Web page
that doesn’t display properly in Safari (hence the name Bug, which is
developer-speak for an error in an application), click this button to dis-
play a sheet in which you can describe the problem. When you then
click Submit, your Bug report is automatically sent to the hard-working
Apple developers responsible for Safari, who check out the page them-
selves to see whether they can correct what’s wrong for a future version
of Safari. In fact, the Bug feature is one of the reasons why Apple was
able to fine-tune Safari’s compatibility so quickly after the browser was
introduced.

v~ Print Page: Click this icon (printer, natch) to print the current page dis-
played in Safari.

Home

Autofill Text size
—

Bug
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Searching for Specific Web Sites

[ honestly can’t imagine how anyone could find anything on the Web without
today’s modern Web search engines. In my opinion, the best online Web
search on the Internet can be found at the familiar Google.com home page.
I've been using Google now for the last several years (long before it became
oh-so trendy and fashionable). There’s no better way to find that one Web
page that offers a complete listing of the hair stylists Elvis used in 1958.

However, searching isn’t always about where you're going — sometimes, it’s
more important to look where you’ve been. If you need to search through the
Web sites that you visited in the recent past and return to a specific page,
you need to comb Safari’s History list.

Finally, Safari allows you to find specific text within the current page. And
believe me, with some of the humongous, 23-screen behemoth pages that I've
recently visited, you really appreciate the ability to zero in on the phrase ripe
avocado in two or three seconds!

In this section, [ jaw about all three of these search resources. Read along,
and you’ll be well prepared to search the Web sites behind you, under you,
and in front of you.

It’s a snap to search with Google

Before Safari arrived on the scene, Mac owners had to bookmark Google.com,
or make Google their home page — or, in the worst case, actually type the
address manually. (Oh, the horror!) The designers and bigwigs at Apple knew
that they wanted to beat Microsoft at the browser game, so they added the
Google search box to the Safari toolbar . . . and knocked the pitch right out of
the ballpark.

To search for something, simply click your mouse cursor on the Google search
box on the Safari toolbar, type a word or short phrase, and press Return. Figure
84 illustrates the result of a search that I did using the phrase Stradivarius vio-
lins. If  had wanted to narrow the search to the most relevant pages, I could
have enclosed the search text in quotes — “Stradivarius violins” — to search
for precisely that text.

Looking back with the History list

Safari’s History list records any page visit. Click the History menu at any
time to
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+* Return to your home page: You can also press 8 +Shift+H at any time.

v Mark a page for SnapBack: The first page that you open in a window (or
the page that appears when you click a bookmark) is automatically set
as the SnapBack page.

¢ To return immediately to the SnapBack page, just click the orange
SnapBack button that appears at the right end of the Address box.

¢ To mark the active page as the SnapBack page, you can choose
Mark Page for SnapBack from the History menu. (For example,
if you were visiting the Apple site and you decide that you’'d
rather SnapBack to the Support page instead of the Apple
welcome page, you would display the Support page and choose
this command.)

v~ Visit pages ordered by date: You see a number of submenus, including
Earlier Today and then previous days. To view the History list for an ear-
lier date, move your mouse pointer over the desired date and then click
the desired page.

v Clear the list: If you want to clear the History list — for security reasons
or just to remove old entries — you can do so from the History menu.
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Searching the current page

You can always press 8+F (or choose Edit=>Find=>Find) to display the Find
dialog box. Type the word or phrase that you’re looking for in the Find box
and then click Next to display each occurrence in order, all the way to the
bottom of the page. To search upward to the top of the page, click Previous.

Safari highlights any match that it finds and jumps to that spot within the
page. Convenient indeed.

Safari Power User Tips and Tools

Safari is easy to use and handles simple Web surfing as well as any other
browser — click here, click there, and you’re navigating the Web. But what
about the features that a power user needs? They’re here as well!

In this section, [ mention the most popular features among the experienced
Mac surfing set.

Putting down roots with a new home page

You have a number of different ways to jump to your home page, but how
do you set your home page in the first place? Follow these steps to move in to
your new home page:
1. Visit the page that you want to use as your home page.
2. Choose Safariz>Preferences.
The Safari Preferences dialog box appears.
3. Click Set to Current Page.

4. Click the Close button (which carries an X) in the Preferences dialog
box to return to your (new) home page.

Organizing favorite spots with bookmarks

Bookmarks make it easy to return to your favorite hangouts in cyberspace.
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Sometimes a technology author has to use the same word over and over and
yet even over again. In this section, I claim the world record for using the
term bookmark — it’s a small triumph, but I take whatever comes my way.

To set a bookmark for the current page, just click the Add a Bookmark button
on the Safari toolbar, which looks like big plus sign. (There’s high intelligence
at work here, I'm telling you.)

Figure 8-5 illustrates the sheet that appears, in which you can

v Enter a name for the bookmark.

v Specify whether you want the bookmark to appear in the bookmarks bar,
the Bookmarks menu, or an existing Bookmarks folder.

To return to a bookmark, use one of these methods:

v Click a bookmark button on the bookmarks bar.
v Click the Bookmarks menu and select a bookmark.

v Press a Bookmark keyboard shortcut. Safari assigns a keyboard short-
cut to the keys that appear on the bookmarks bar. For example, press-
ing 88+1 is the same as clicking the first Bookmark button on the
bookmarks bar.

 Click the Show All Bookmarks button at the left side of the bookmarks
bar. A full-screen Bookmark library appears (see Figure 8-6), in which
you can drag-and-drop all your bookmarks to the bookmarks bar, the
Bookmarks menu, or to collection folders that you can create.

Collection folders are great for organizing; I have more than 200 book-
marks, and I'd need a separate computer to keep track of ’em if [ didn’t
use collections. Anyway, you can Control-click (or right-click) on any
bookmark in the Bookmarks screen to display the pop-up menu, and
then click Open to display the page. To close the Bookmarks screen,
just click the Show All Bookmarks button in the Safari toolbar a second
time.

Your Address Book appears as a collection folder in the Bookmarks library
screen. You can click this collection to immediately access all Web sites
stored as contact information in your Address Book; then you can create
bookmarks directly from those sites.

I now hereby close my record-setting bookmark section. Thank you.
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Using secure connections

I love shopping on the Web, but I'm always cautious — and you should be,
too. Safari indicates that your connection to the current Web page is secure
(or encrypted) by displaying a padlock icon in the upper-right corner of the
Safari window, as shown in Figure 8-7.

Here comes the only rule that you have to remember about secure connec-
tions in Safari. (In fact, it’s a Mark’s Maxim.)

Never — I mean never — enter any valuable personal or financial information
on a Web page unless you see the secure connection padlock symbol.

This type of information includes

v Obvious things such as your credit card number, address, and telephone
number

v Not-so-obvious things such as your Social Security number and a login/
password combination

Padlock
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If a site doesn’t provide a secure connection and asks you for personal infor-
mation, find another spot in cyberspace to do your business. Your identity
should remain yours.

Reading RSS feeds

Almost time to exit stage right, but before leaving this discussion of Safari, I
want to cover a feature that’s new with Tiger: Safari now has the ability to
receive RSS (short for RDF Site Summary) newsfeeds. A Web site that pro-
vides RSS content sends updated news or information in a short headline
format — almost like the old AP and UPI teletype machines that newspapers
once used. You can recognize RSS Web addresses by their feed: // prefixes.

Safari displays RSS headlines in a list format. They're easy to scan with a
glance, with no popup advertisements or unnecessary graphics, either.

A square blue RSS icon appears at the right side of the address box to let you
know that the Web server you're visiting has RSS feeds available. Click this
RSS icon to display the newsfeed provided by that Web server.

The RSS feature has its own pane in the Safari Preferences dialog box, in
which you can specify the time delay before Safari checks for updated arti-
cles. You can also assign a color to new articles, which is a great help for
those who like to ride the latest tech wave (like [ do). RSS feeds can be book-
marked just like a typical Web page, too, and Apple provides a number of RSS
sites as a default drop-down list on the bookmarks bar.



Chapter 9
Mac Is .Made for Mac Laptops

In This Chapter

Understanding online storage

Opening a new .Mac account
Using your iDisk
Backing up your hard drive using .Mac

R eaders often ask me to name my favorite reasons why they should
switch — that is, why should a Windows user who thinks all is well
move to the Apple universe? Of course, | always mention the superior hard-
ware and how much of a better job Tiger does as an operating system. But
here’s my favorite selling point: “Apple simply does things right the first time,
and everyone else plays catch-up.”

And then I pose this question: “What if you could reach a hard drive with 1GB
of your files over any Internet connection — anywhere in the world — and it
just showed up on your desktop automatically?” Usually, I get a thoughtful
silence after that one, and another person decides to learn more — about
Apple’s .Mac online hosting service, that is. In this chapter, I save you the
trouble of researching all the benefits of .Mac. Heck, that’s one of the reasons
why you bought this book, right?

Wheve Is My .Mac Stuff Stored?

The question that everyone asks is, “Where is my .Mac stuff stored?” Best
that I answer this one first. I'll begin with a definition. The online hard drive
offered to .Mac subscribers (read about subscribing in the following section)
is an iDisk, and it’s well integrated into Mac OS X. In fact, if you didn’t know
the background, you might think that iDisk was simply another internal hard
drive. Figure 9-1 illustrates my iDisk icon on my desktop. The Finder window
displays the contents; notice the folders visible there. (More on these folders
later in the chapter.)
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The files that [ add to my iDisk are stored on an Apple server, location
unknown. Literally. The physical storage (a massive file server that holds
uncounted gigabytes of data) could be in Cupertino, or it might be in
Timbuktu. There’s a whole bunch of storage sites, too. You and [ don’t need
to care about the where part because

v Your iDisk is always available. Oh, yes. 24/7, your files are waiting
for you.

v Your iDisk is secure. Apple goes to great lengths to guarantee the secu-
rity of your data, encrypting the transfer of files and folders whenever
you use your iDisk. You can also password-protect any data that you
want to offer to others, just in case.

v Your iDisk works even when you aren’t on the Internet. Yep, you read
that right: You can create new documents and modify files to your heart’s
content while you're on a flight or relaxing on the beach. iDisk automati-
cally updates whatever’s changed the next time you connect to the
Internet.

Is .Mac an ISP?

.Mac is many things, butitisn'tan ISP. You need hardware headaches that an ISP has to deal

to join an ISP first because you need an exist-
ing Internet connection to use the services and
features included in .Mac membership. This
makes a lot of sense, considering that most of
us already have Internet access. (Plus, Apple
doesn't have to worry with all the support and

with.) .Mac works with the ISP that you already
have, so you don't have to worry about AOL or
EarthLink conflicting with .Mac. (However, |
can’t guarantee that your system administrator
at work will allow .Mac traffic across his or her
pristine network..)
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Now that I've piqued your interest (and answered the most common ques-
tions about iDisk), return to the .Mac service for a moment so I can show you
how to set up your account.

Opening a .Mac Account

|
Figure 9-2:
The .Mac
panein
System
Preferences
keeps track
of your login
information.
|

If you haven’t already opened your .Mac account, you get a chance to sign up
when you turn on your Mac for the first time and also when you install (or
upgrade) Mac OS X. However, if you decided to pass on .Mac at that time, you
can always join in the fun by following these steps:

1. Click the System Preferences icon on the dock.

2. Click the .Mac icon.

3. Click the Sign Up button.

Safari launches and displays Apple’s .Mac Welcome page (www.mac . com,
.Mac tab).

4. Follow the onscreen instructions for choosing a member name and
password.

When you’ve finished, you're rewarded with your login information.

5. Close Safari.

6. Enter your name and password into the text boxes in the .Mac System
Preferences pane.

Figure 9-2 illustrates an example login that I created.

enn .Mac
|« » || Showal | Q

I_ Account | Sync  iDisk = Advanced

Already a member?

_Mac Member Name: 'edwardnigma

Password: sssessssssss

Sign Up Now

Get the suite of Internet essentials for your
Mac. Click Learn More for a 60-day trial,

( Learn More |
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Like the convenient operating system that it is, Tiger handles all your .Mac
login chores automatically from this point on.

If you're a dialup Internet user, you were dreading this moment. Here it is. I'm
truly sorry, but in my opinion, a high-speed broadband connection is a
requirement to take full advantage of a .Mac subscription. You can certainly
still use all the functionality of .Mac with any type of Internet connection, but
you’re going to spend from now until the next Democratic presidency waiting
for files to copy and things to happen.

If you decide to sign up for a full year’s .Mac membership, I salute you for
your discerning taste in online services. However, you can also opt for a 60-
day trial subscription at this point, to check out things at your leisure. Table
9-1 shows the major storage differences between a free trial subscription and
a full $100 yearly subscription to .Mac.

Table 9-1 What a Ben Franklin Buys with .Mac

Status iDisk/E-Mail Storage Data Transfer Limit Backup
Trial 50MB total 1GB/Month 100MB limit
Subscriber 1GB total 10GB/Month No limit

A Mac subscription also allows you to synchronize your e-mail, Address
Book contact information, and Safari bookmarks between multiple Macs.
What a boon when you’re on the road with your laptop!

As a trial member to .Mac, you’re limited to reading your .Mac e-mail through
the Web-based browser offered on the .Mac Web site, as shown in Figure 9-3.
That’s neat, certainly, and you can use Web mail from any computer with an
Internet connection. However, as a full subscriber, you can also send and
receive .Mac e-mail seamlessly from Tiger’s Mail application, which is the pre-
ferred method for checking your messages.

If you decide that you want the extra functionality of a .Mac subscription,
upgrading is easy. When you open the .Mac pane in System Preferences and
click the iDisk button, Tiger displays a countdown reminder telling you how
many days remain on your trial period. Just click Join Now to upgrade. You
can also visit the .Mac Web site at any time and click Join Now to access the
same Web-based subscription system.
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Besides the features that I discuss at length in this chapter that are of special
interest to road warriors, your .Mac subscription also provides support for

v Web site creation and hosting using iWeb and HomePage

v Photocasting (where you can automatically update your online photo
albums and share them with others)

v Blogging (the now-almost-banal art form that involves sharing an online
journal with the world at large)

Using Your iDisk on the Road

So how do you open your iDisk? Tiger gives you a number of different avenues:

v Choose Go=iDisk from the Finder menu and then choose My iDisk
from the submenu. Keyboard types can press 38+Shift+] instead. The

Finder Go menu also includes a shortcut to access another .Mac
member’s Public folder.

Chapter 9: .Mac Is .Made for Mac Laptops ’3 1
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v Click the iDisk icon in the Finder window sidebar.

v Click the iDisk button on your Finder toolbar. It’s easy to add an iDisk
button. Open a Finder window, and then choose View=>Customize
Toolbar. Drag the iDisk icon up to the toolbar and click Done.

After you open your iDisk, an iDisk volume icon also pops up on your desk-
top. You can open the little scamp later in your computing session by simply
double-clicking it. The desktop iDisk icon hangs around until you log out,
restart, or shut down your laptop.

It’s all in the folders

Your iDisk contains a number of different folders. Some are similar to the sub-
folders in your Home folder, but others are unique to the structure of your
iDisk. In this section, I provide the details on the iDisk folder family.

You can’t store files or create folders in the root (or top level) of an iDisk.

Storage folders

Everything that you copy to or create on your iDisk must be stored in one of
these six folders (refer to Figure 9-1 to see them):

v Documents: Store the documents that you create with your applications
in this folder, which only you can access.

1 Movies: This folder stores your QuickTime movies (including any that
you might use in your .Mac Web pages).

v Music: iTunes music and playlists go here.

v Pictures: JPEG and GIF digital images that you store in this folder can be
used with other .Mac services (such as your Web pages) or in iPhoto.

v Public: The files that you store in this folder are meant to be shared with
other people (as well as offered on your .Mac Web pages). You can also
allow others to copy and save files to your Public folder (more on this
later in this section).

v~ Sites: You can use HomePage to create Web pages in this folder, or you
can add Web pages that you’'ve created with your own applications.

These folders can be opened in a Finder window just like any typical folder
on your laptop’s internal hard drive, and you can open and save documents
to your iDisk folders using all your applications. In other words, these six
iDisk folders act just like normal, everyday folders. Pretty doggone neat!
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Funky specialized folders

Your iDisk contains three folders that you can’t use to store stuff (directly,
anyway):

v Backup: This is the storage vault for the backup files created with the
.Mac Backup application.

Because you have read access to the Backup folder, you can copy the
backup files from this folder to a CD, DVD, or removable drive on your
Mac. (I cover backing up later in this chapter.)

v~ Library: Like the Library folders that you find in the root of your hard
drive (and in your Home folder), this folder stores all sorts of configura-
tion settings for the .Mac features that you're using, such as your
Backup settings.

v~ Software: This read-only folder is a special case. Apple stuffs this folder
full of a wide variety of the latest in freeware and shareware as well as
commercial demo software. You can copy whatever you like from the
Software folder to your Mac’s desktop and then install your new toy
from that local copy. (Oh, and the contents of the Software folder don’t
count against your total storage space limit.) Enjoy!

Mirror, mirvor, on your drive . . .

You can use your iDisk even if you aren’t connected to the Internet. This
magic is accomplished through a mirror, or local copy of your iDisk, that’s
stored on your local hard drive. (“Hey, wasn’t [ supposed to be getting away
from storing things locally?”) If you choose to use a mirror — you can disable
this feature if you like — Tiger automatically synchronizes any files that
you've created or changed on your local iDisk copy the next time you con-
nect to the Internet. This is a great feature if you have Macs in different loca-
tions because you can update and synchronize your iDisk files from any of
your computers — automatically!

Without a mirror, you must have an active Internet connection to use iDisk.

To enable (or disable) the mirror feature, open System Preferences, click the
.Mac icon, and then click the iDisk tab to display the settings you see in Figure
9-4. Click the Start button, and — after a moment of preparation, complete with
its own dialog box — the text above the button reads iDisk Syncing On.

If you use a copy of your iDisk on your hard drive — and I recommend it —
choose to synchronize automatically. This ensures that your files get updated
even if you're somewhat forgetful, like [ am.
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A mirror makes things much faster when you browse your iDisk or when you
save and load documents from your iDisk. Tiger actually uses your local copy
from your hard drive and then updates your remote iDisk files in the back-
ground while you work. (Tiger is updating your iDisk whenever you see that
silly animated circular-yin-yang-thinglet rotating next to your iDisk icon in the
Finder window. You’'ll know it when you see it.)

Monitoring and configuring your iDisk

The iDisk tab in System Preferences groups all the configuration settings you
can make to your iDisk and your .Mac account. In this section, I review the
controls you'll find here.

At the top of the tab is the iDisk Storage area. Concerned about how much of
your 25MB (for trial users) or 250MB (for subscribers) remains? The Disk
Space bar graph displays how much of your iDisk space is free. The middle
section, which I discussed in the preceding section, allows you to create a
local copy of your iDisk on your hard drive. At the bottom of the tab are the
settings for your Public folder.

[ strongly recommend that you set a password to protect the contents of
your Public folder — click the Password Protect Your Public Folder check
box to enable it, and then click the Set Password button to enter a new pass-
word. Then anyone trying to open your Public folder must enter the pass-
word. If you haven’t supplied that person with the proper password, he can’t
open your Public folder. It’s that simple. (There’s nothing more embarrassing
than discovering that the bikini shots from your vacation are available for
every .Mac user to peruse.)
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Putting .Mac Mail to work

If you decide to take advantage of a .Mac sub-
scription, you can easily set up Tiger's Mail
application to send and receive messages from
your .Mac address. Launch the Mail application,
and then choose Mail=>Preferences. Click the
Accounts button in the toolbar, and then click
the Add button (which sports a plus sign) at the
bottom of the window. Click the Account Type
pop-up menu and then click .Mac. Type a
description, press tab to complete the other

fields, including your full name, .Mac name, and
password. When everything’s filled in, click the
Close button on the Preferences window, and
then click Save when prompted by Mail. That's
it! You created a new account for your .Mac
messages, and you can now retrieve them on
your laptop and through the Web mail system at
www .mac.com. In fact, Mail is probably
pulling down at least two messages from Apple
as you read this.

Web pages.

This extra level of security has one drawback. If you password-protect your
Public folder, it can’t be used to store anything that you offer on your .Mac

While you’re in the iDisk tab, you can configure your Public folder security
settings. You can decide whether others should be able to

v Only read the contents of your Public folder. By default, the Public folder

is set to read-only.

v Copy documents to your Public folder. To give others the ability to save
and copy, select the Read & Write radio button.

Back Up VYour Laptop with .Mac

My editors have heard me drone on and on long enough about how important
it is to back up your hard drive. They probably rub their eyes when they
encounter yet another instance of my preaching about the wages of backup
sloth and losing everything but hindsight.

Well, you're lucky, because [ was just about to launch into another round of
backup warnings. .Mac subscribers get a great utility application called

Backup 3 when they join the club. Backup is a great application that saves a
copy of your treasured data on just about any media on the planet, including

v Your iDisk (using the Backup folder I describe earlier in this chapter)
v An external USB or FireWire hard drive
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v Recordable CD or DVD media
v Network servers

v Your iPod

Before you get too enthusiastic about backing up to your iPod, heed this:
Your iPod’s tiny hard drive isn’t meant to handle the same serious thrashing
as a full-size external hard drive. Personally, 've never used my iPod as a
backup destination, and I don’t recommend that you do either (unless no
other recording media is handy and you absolutely must have a backup).

Installing Backup

Backup isn’t built into Tiger; you have to download it from the .Mac site at
www . mac . com. After the compressed image file has been downloaded and
mounted on your desktop, you see the Backup installation folder. Double-
click the Backup . pkg file to begin the installation. After installation is com-
plete, you can find Backup in your Applications folder.

Saving your stuff

Nothing is more important to a proud Mac laptop owner than a secure
backup. In this section, I demonstrate how you can produce both manual
backups (whenever you like) and automated backups (which are scheduled
at regular intervals). Do it!

Manual backups

After you've double-clicked the Backup application, you’re presented with
the main Backup window. Beginning a backup is as easy as selecting the
check boxes next to the items that you want to safeguard and then clicking
Continue. Figure 9-5 shows the default backup sets (or plans) provided by
Apple. If one or more of these plans fit the bill, you need only click Back Up;
by default, the data is saved to CD or DVD media.

“But wait. What if [ want to select folders or files for my backup that aren’t in
the default plans?” No problem, just create your own plan as follows:

1. From the main Backup window, Click the Add button under Backup
Items — which bears a plus sign.

2. Click the Custom plan, and then click Choose Plan.

3. In the box at the top, type a new plan name for this group of files.

4. Click the Add button.

Backup opens a file/folder selection sheet.
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5. Click the Files and Folders button.

6. Navigate to the file or folder that you want to back up and click it to
select it.

7. Click Include this folder, and then click Done.
&‘«“BER You return to the Custom Plan dialog box.
&
You're limited to backing up a total of 100MB with a trial membership.

8. Click the Add button (again, bearing a plus sign) under Destination
and Schedule.

9. Choose a destination and a folder to store the data using the
Destination and Folder pop-up menus.

10. Click OK to save your changes.
11. In the Custom Plan dialog box, click Backup Now.

The rest is cake as your irreplaceable stuff is saved to your destination.

o6

]

Untitled

Choose a Plan Template
You can modify any of the templates to suit your needs or select Custom.

- Home Folder
"}E\ Back up your home folder to your hard disk daily and to CD or DVD

i monthly.

Personal Data & Settings
Back up your Address Book contacts, Stickies notes, iCal calendars,
Safari settings, and Keychain settings to your iDisk daily.

- iLife
f "'_’ Back up the iLife data in your home folder to CD ar DVD weekly.

Purchased Music and Video
| & d- Back up the files in your home folder that you purchased from the
4 ‘Fj iTunes Music Store te CD or DVD monthly.
.-

Figure 9-5:
BaCkUp 3 Custom
I’epresents @ Select your own files, destinations, and schedules,
online
peace of
mind.
|

(_ Cancel ) Choose Plan

\P
) If you just want to create a new plan and don’t need to back up data immedi-

ately, click Close in the Custom Plan dialog box instead of Backup Now to
save your changes and return to the Backup window.

If you ever need to restore from your backup, click the desired plan from the
Backup window and then click Restore. Backup leads you through the restore
process with the same aplomb.
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Scheduled automatic backups

You can schedule unattended backups with Backup. To add or edit a sched-
ule for an existing plan, select it in the Backup window list and click the
Action button (which bears a tiny gear symbol). A drop-down menu appears.
Click Edit, and the Plan dialog box appears, allowing you to make changes to
the items, destination, or schedule for that plan.

To add a schedule for a new plan, use the schedule option that appears while
you're selecting a destination (Steps 8 through 10 in the preceding section).
Follow these steps to set things up for automatic backup goodness:

1. On the Destination and Schedule sheet, select the Automatically Back
Up at the Following Times check box.
2. Click the pop-up menus next to the options:

¢ Select the time period (Day, Week, Month, 3 Months, or 6 Months)
depending on how often your files are changed.

¢ Set the backup time of day (and day of the week or month, if
necessary).

3. Click OK.

4. If you don’t want to back up the data immediately, click the Close
button in the Custom Plan dialog box.

Your next scheduled backup time appears beside your custom plan in
the list.

The Backup 3 application itself doesn’t need to be running for the automated
“&\\I\BER backup to kick off.
&
Scheduled backups require that

v Your laptop remains awake. Make sure that you're logged in and that
Sleep mode is disabled on the Energy Saver pane in System Preferences.
v Your Mac has something to write on:

e [f you're saving to iDisk, your laptop must make an Internet
connection.

e [f you're saving to CD or DVD, blank media must be loaded.

e [f you're saving to an external drive or iPod, that device must be
connected and turned on.



Chapter 10

Spiffy Connections for
the Road Warrior

In This Chapter

Adding a printer or scanner to your system
Working with your iSight camera
Using Front Row and the Apple remote

Flis chapter is all about getting interesting things into — and out of —
your MacBook or MacBook Pro. Some are more common (almost mun-
dane these days) and pretty easy to take care of, such as scanners and print-
ers. Then I might surprise you with something new to you, such as the iSight
video camera, which is built into your laptop and the perfect companion to
Photo Booth and iChat AV.

I also show you how to use your Apple remote with the magnificent Front
Row menu application. Control your laptop wirelessly from across the room
(or use your keyboard if your remote is hiding somewhere between the
couch cushions).

Sure, you can connect your MacBook Pro to a printer and do some serious
work — but then again, you could snap your photo and send it to your friends
as an e-mail attachment or upload it to your blog. Decisions, decisions!

Connecting USB and Network Printers

All hail the USB port! It’s the primary connection point for all sorts of good-
ies. In this section, [ concentrate on adding a USB printer and a typical USB
scanner to your system.

If you're itching to connect a USB digital camera for use with iPhoto, let me
redirect you to Chapter 12, where I cover the iPhoto experience in depth.
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USB printers

Connecting a USB printer to your Mac is duck soup. Don’t you wish all things
in life were this easy? You might very well be able to skip most of the steps in
this section, depending on whether your printer came with an installation
disc. (Virtually all do, but you may have bought yours used from eBay or

elsewhere.

Your printer needs to be fully supported in Mac OS X:

TE(,‘/, %,

v~ If the software is designed for earlier versions of Mac OS X (such as 10.2
or 10.3), it probably works with Tiger.

v | always recommend visiting the manufacturer’s Web site to download
the latest printer driver and support software after you install your
printer. That way, you know that you’re up-to-date.

QIWNG/
Q.
S Save and close your files before installing your printer. You might have to

restart your laptop to complete the installation.

The physical connections for your printer are simple:

v Make sure that your printer’s USB cable is plugged into both your Mac
and the printer itself.

v The printer should be plugged into an AC wall socket and turned on
(after the USB connection has been made).

Don’t forget to add the paper!

The finishing printer installation steps depend on whether or not you have a
manufacturer’s installation CD for your printer.

Sure, | have the install disc
If your printer comes with the manufacturer’s installation disc, follow these
steps when everything is connected and powered on:

1. Insert the installation disc in your laptop’s optical drive.

The disc contents usually appear in a Finder window. If they don’t, double-
click the installation disc icon on the desktop to open the window.

2. Double-click the installation application to start the ball rolling.

3. Follow the onscreen instructions.
Files get copied to your hard drive.

4. You might have to restart your Mac.

You're ready to print!
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& Don’t forget to visit your printer manufacturer’s Web site to check whether
any driver updates are available for your particular model.

Whoops, 1 have diddly-squat — software-wise

Didn’t get an installation CD? Try installing the printer without software or
downloading the software from the manufacturer’s Web site.

If you didn’t get an installation CD with your printer, maybe you're lucky
enough that your printer’s driver was included in your installation of Mac OS X.
Here’s how to check for that pesky driver after you connect the printer and
switch it on:

A\ 1. Open a Finder window and navigate to the Utilities folder.
The Utilities folder is usually inside your Applications folder.

2. Double-click the Printer Setup Utility icon.

3. Check the Printer list in the Printer Setup Utility window to see
whether your printer has already been added automatically in Tiger.

Figure 10-1 shows an example. If your printer appears here, dance a cele-
bratory jig. You can close the Utility window and choose that printer
from the Print dialog box in your applications.

emne Printer List (=)

.o H X
Add t
Figure 10-1: In Menu “Name & Status Kind Host

DY0007 Xerox DP N2025

If Mac 0S X
recognizes
your printer,
you're ready
to go.
|

If you don’t have installation software and your Mac doesn’t automatically
match the printer with a driver, adding the printer manually is your last
installation option. Follow these steps:

1. Open a Finder window and navigate to the Utilities folder.

2. Double-click the Printer Setup Utility icon.

3. Click the Add icon on the Printer Setup Utility toolbar.

4. Click the Print Using pop-up menu.

The list of supported printer models appears.
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|
Figure 10-2:
Choosing
my
LabelWriter
from the
Add sheet’s
drop-down
list.
|

WING/

5. Click the closest match to your printer in the Print Using list.

Figure 10-2 shows an example of some of the printer models recognized
in Tiger. If you don’t find an exact match for your printer, you have a
couple of options:

¢ Look for just the brand name, such as EPSON.

e Try the generic USB setting. If you choose USB, Tiger defaults to
Auto Select for the printer model. You can manually change this if
the automatic selection wasn’t right.

_6 06 Printer Browser =1
R & .
= = &
Default Browser IP Printer Search
Printer Name & | Connection
A B
k.| " 3 L
™ ' -.' Il ) _ ! = I
Apple i
i | Brother E
Locatiof Canon
. EPSON
Print Usln1 ESP l
Fujifilm i |
Gestetner
@ A E
g | LANIER
1 Lexmark
NRG
Olympus
RICOH
SAVIN
Sony
Tektronix
Xerox
infotec

6. Click Add.

The other option is to check the manufacturer’s Web site for your printer’s
software. Look for special software drivers that the printer might need and
installation applications. If the manufacturer offers an installation application
for your printer, download the application and run it.

Install any drivers you find before you run an installation application.
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Networked printers

Need to access a shared or networked printer? Business travelers know all
about using “foreign” printers whenever possible! In case you’'ve never made
a printer connection to a well-connected (network) printer, here’s a rundown
on what your laptop can use:

v Ethernet wired networks. You can use a printer that’s shared on another
computer on your network or a printer with standalone network hardware.

v AirPort and AirPort Extreme Wireless networks — if your Mac laptop
has AirPort or AirPort Extreme hardware. You can also use printers on
wireless networks that don’t use Apple hardware, as long as those net-
works are Wi-Fi certified 802.11b or 802.11g.

v Wireless networks that don’t use Apple hardware, as long as those
networks are Wi-Fi certified 802.11b or 802.11g.

If you're printing over any network, you need these snippets of information
for the printer:

v The shared printer name (for this info, ask the network administrator or
the person using the computer to which the shared printer is connected)

v The Workgroup name (for shared printers connected to a PC running
Windows)

If the printer is connected to a Macintosh computer on your network, you don’t
have to configure anything on your Mac. When you want to use the printer, just
select it from the Printer drop-down list box in the Print dialog box.

If the printer is connected to a Windows PC, you have to set up the printer
before you use it. Follow these steps:
1. Run Printer Setup Utility.

“Hey, can’t I reach the functionality that Printer Setup Utility offers from
System Preferences?” Yep, indeed you can. Click Print & Fax, and then
click the Add Printer button (which carries a plus sign). Tiger launches
the Printer Setup Utility, and you're in business.

2. Click Add.

3. Click the More Printers button.
Choose Windows Printing from the first pop-up menu.

4. Choose the Workgroup name from the second pop-up menu.
The available network printers appear in the Printer list.

5. Click the desired printer name and then click Add.
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Connecting Scanners

\\3

|
Figure 10-3:
Preparing

to inhale
images with
Image
Capture.
|

USB and FireWire scanners practically install themselves. As long as the
model is listed as Mac OS X compatible and it supports the TWAIN device
standard (just about all scanners do), things really are plug-and-play.

If you have the scanner manufacturer’s installation disc, go ahead and use it.
However, most scanners don’t require specialized drivers, so even that
orphan model that you picked up from Uncle Milton last year should work (if
it’s recognized by Mac OS X). It doesn’t hurt to check the manufacturer’s Web
site to see whether any of the software has been updated since the disc was
produced.

If your older scanner isn’t supported by Mac OS X, a third-party application
may be able to help. Get thee hence to Hamrick Software at www . hamrick.com
and download a copy of the latest version of VueScan. This great scanning
application supports more than 500 scanner models, including a number that
don’t work with Tiger otherwise. At $50, it’s a world-class bargain to boot.

Ready to go? Make sure that your scanner is powered on and connected to
your Mac (and that you load a page or photograph to scan). If your scanner’s
installation disc provided you a proprietary scanning application, | recom-
mend that you use that application to test your scanner. In fact, it’s Mark’s
Maxim time!

If your printer or scanner includes bundled applications, use them!

Sure, Mac OS X has the Printer Setup Utility for printers and the Image Capture
application for scanners and digital cameras, but these are bare-bones tools
compared with the print manager and image acquisition software that comes
bundled with your hardware. [ turn to Tiger’s built-in hardware handling stuff
only when I don’t have anything better.

Hey, I'm not saying that anything’s wrong with Image Capture (shown in Figure
10-3), which is in your Applications folder. However, don’t expect Image Capture
to support any specialized features offered by your scanner (such as one-button
e-mail or Web publishing). You have to use the application especially designed
for your manufacturer and model to take advantage of any extras that it offers.

8aen 10USBCom positeDevice

f 1 Download To: | | I Pictures, Movies, and Music folders |
! 1

| —
 — Automatic Task: None ]

Occurs after downloading
tems to download: 2

( Options... Download Some... | | Download All
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Putting Your iSight Camera to Work

Figure 10-4:
The iSight
cameraisa
sightto
behold.

When I first got started in computers in the early '80s, the very idea of chat-
ting with someone in full-motion color video with sound was the stuff of
dreams — or you were watching the TV show Buck Rogers in the 25th Century.
(Remember that one, with Gil Gerard and Erin Gray?) Your camera and your
VCR were analog . . . if you could afford such luxuries.

Ah, what a difference two decades make. Now you can use the Dynamic Duo
of your laptop’s iSight camera (check it out in Figure 10-4) and Tiger’s iSight-
savvy software. With iChat AV, you can videoconference in style, and with
Photo Booth you can snap digital pictures just like the old automatic photo
booth at your local arcade. Heck, if you like, you can even capture live video
for use in iMovie HD!

Camera
indicator light

iSight
camera lens

Your iSight camera’s indicator light will glow green whenever you're taking a
snapshot or recording video (just to make sure you’re not caught “indis-
posed” in front of your friends and coworkers).

If you're using an older Mac laptop that doesn’t include a built-in iSight

camera, you can still buy the external model from Apple and continue merrily
on your way.

Using iSight with iChat AU

Although your MacBook comes ready for videoconferencing, you should
understand two caveats before embarking on the Voyage of Video Chat:
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v~ Speed is an issue. To take advantage of video in iChat AV, you need a
fast Internet connection — at least high-speed DSL or cable Internet, or
even a connection between computers on the same network.

v~ All participants need a video camera. Plenty of folks online have
bought an iSight camera and then suddenly realized that most of their
iChat AV buddies didn’t have video capability!

Even with an iSight camera installed, you can still join text-based and audio
chats. (Your Mac has a built-in microphone, so even if your online buddies
aren’t equipped with video hardware, you can enjoy an audio chat.) iChat AV
displays audio and video buttons next to each person on your buddy list to
help you keep track of who can communicate with you and how they can do it.

Starting a video chat is as simple as launching iChat AV from the dock (or
from your Application folder). Then in the buddy list, click any buddy entry
with a Camera button next to it to connect.

Using iSight with Photo Booth

With Photo Booth, you can always snap a quick picture of yourself for use on
your Web page or even for safekeeping in your iPhoto library. Although the
photos it can capture at 640 x 480 resolution are nowhere near as high a qual-
ity as those produced by today’s crop of digital cameras, everything’s built-
in, so there’s no need to drag your Canon or Nikon from town to town or
classroom to classroom.

To snap an image in Photo Booth, follow these steps:

1. Launch Photo Booth from the dock or from the Applications folder.
2. (Optional) Choose an effect you’d like to apply to your image.

Photo Booth can produce some of the simple effects you may be familiar
with from Photoshop, such as a black-and-white image or a fancy col-
ored pencil filter. Although you can always launch your favorite image
editor afterwards to use a filter or effect on a photo — for example, the
effects available in iPhoto — Photo Booth can apply these effects auto-
matically as soon as you take the picture.

3. Click the Camera button.

Photo Booth allows you to save your image directly to your iPhoto library, or
you can save it to your hard drive for later use.



Chapter 10: Spiffy Connections for the Road Warrior ’ 4 7

Using iSight with iMovie HD

“Wait a second, Mark, don’t I need an expensive digital camcorder to produce
video clips for use in iMovie HD?” Definitely not! In fact, your laptop’s iSight
camera can capture those clips for you — think of the party possibilities! (Or
the opportunity for practical jokes. But then again, you're not that kind of
person, now are you?)

To capture video directly from your iSight camera into iMovie HD, follow
these steps:

1. Launch iMovie HD from the dock or from the Applications folder.

2. Click the Import Video/Editing switch (the toggle switch under the
monitor window that sports camera and scissors icons) to switch to
Import Video mode.

3. Click the Camera icon (which is just to the left of the Import Video/
Editing switch) to display the pop-up menu, and click Built-in iSight.

4. When you’re ready to start recording video, click the Record with
iSight button.

iMovie HD automatically displays the incoming video in the monitor
window as it’s recorded. (As you might expect, the goofy behavior on
the part of the distinguished cast usually starts at about this moment.)

5. Click the Record with iSight button again to stop recording.
After you’'ve ended the recording, iMovie HD creates the video clip and
adds it to your Clips pane.

[ go into a lot more detail on iMovie HD in Chapter 13, but that’s the gist of
recording video clips with your MacBook or MacBook Pro.

Performing Magic with Front Row and
the Apple Remote

Your Mac laptop’s beautiful LCD screen would seem to be the perfect artist’s
canvas or the ideal display for your image editing, presentations, and impor-
tant documents. However, with Apple’s Front Row software, you can do much
more than paint, present, or edit images, and you don’t even have to touch
the keyboard (unless you decide to, that is).
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In fact, Front Row has four distinct functions:

v Watching DVD movies using DVD Player: If you've already loaded a
DVD into your optical drive, you can watch it. (Sorry, your Mac laptop
will not load the DVD for you. I guess some things have to remain manu-
ally driven for a few years yet.)

v~ Viewing photos and slide shows: Front Row calls upon iPhoto, so that
you can see your albums, film rolls, and slide shows.

v Displaying videos using QuickTime Player: You can choose any video
you’ve downloaded from the iTunes Music Store or saved to your
Movies folder.

v Coaxing your favorite music from your iTunes library: You'll find your
songs and playlists available from Front Row.

All this is accomplished with the simple infrared Apple remote you see in
Figure 10-5. Like everything from Apple, it’s simple, well-designed, and down-
right elegant.

—+—— IR window

Volume/menu up

Previous/rewind Next/fast forward

Volume/menu down

|~~—— Select/play/pause

Menu

|
Figure 10-5:
IsitaniPod
Shuffle? No,
it's the
Apple
Remote!
|

P You don’t even have to elevate your posterior from your easy chair to launch
Front Row! Just press the Menu button on the remote, and as long as your
Mac laptop is on, Front Row runs automatically. To put your laptop to sleep
after a night of fun, press and hold the Select/play/pause button. Sassy!

Table 10-1 includes the important functions of the Apple remote in Front Row.



Chapter 10: Spiffy Connections for the Road Warrior

Table 10-1 Front Row Functions Controlled by the Apple Remote

Action Purpose

Menu Press to launch Front Row or to return to the previ-
ous menu from within Front Row

Volume/menu down Press to navigate down through menu options or to
lower the volume while media is playing

Volume/menu up Press to navigate up through menu options or to
raise the volume while media is playing

Select/play/pause Press to select a menu item or play or pause media
from within iTunes, DVD Player, QuickTime, or iPhoto

Next/fast forward Press to skip to the next song or DVD chapter, or
hold down to fast forward through a song

Previous/rewind Press to skip to the previous song or DVD chapter, or
hold down to rewind a song

Of course, those Apple software designers knew that you might find yourself
on the road without your Apple remote, so they provided keyboard shortcuts
that you can also use to control Front Row. Table 10-2 explains the keyboard
shortcuts.

Table 10-2 Front Row Functions Controlled by the Keyboard

Action Keyboard Equivalent

Menu Command-Esc to enter the menu; Esc to exit it
Volume/menu down Down arrow

Volume/menu up Up arrow

Select/play/pause Spacebar or Return

Next/fast forward Right arrow

Previous/rewind Left arrow

Note that Front Row has no configuration or settings menu. Front Row is
what designers call a front-end application, which means that it launches the
Tiger applications necessary to display or play the media you select.
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Your Apple remote is not designed to work with any other applications at the
time of this writing — for example, you can’t use it as a presentation aide in
PowerPoint, or as a playback controller in GarageBand. However, it’s a sure
bet that Apple will continue to add functionality to the Apple remote in the
future, so check the Apple remote section of Tiger’s online help system to
keep tabs on what’s happening!
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In this part . . .

’{ere they are, the applications that everyone craves.
This part covers iTunes, iPhoto, iMovie HD, iDVD,

and GarageBand like your Grandma'’s best quilt. You dis-
cover how to share your images, music, and video clips

among the iLife '06 applications on your Mac laptop and
how to create everything from your own DVDs to a truly
awesome hardcover photo album!




Chapter 11
The Multimedia Joy of iTunes

In This Chapter

Shaking hands with the iTunes window

Listening to your music and watching video
Subscribing to podcasts

Organizing your music just so

Adding album information

Ripping music from CDs and other sources

Burning your own audio CDs

S)metimes, words just aren’t enough. iTunes is that kind of perfection.

To envision how iTunes changes your Mac, you have to paint the picture with
music — music that’s easy to play, easy to search, and easy to transfer from
place to place. Whether it be classical, alternative, jazz, rock, hip-hop, or folk,
[ can guarantee you that you won't find a better application than iTunes to fill
your life with your music.

Wait a second. Did I mention the podcasts you can listen to or download to
your iPod? Yep, iTunes allows you to subscribe to those cutting-edge broad-
casts that are sweeping the Internet, either from the iTunes Music Store or
from your cousin Harold’s Web site.

Oh, and don’t forget the moving pictures! Yep, you can now use iTunes to
download television shows and classic music videos from the iTunes Music
Store to your hard drive.

In this chapter, I lead you through all the features of my absolute favorite
member of the iLife suite, and it’s going to be pretty doggone obvious how
much [ appreciate this one piece of software.
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Boy, Check Out That iTunes Window!

Indeed, Figure 11-1 shows off the iTunes window like the jewel that it is. I
complete the roll call of switches and controls in Figure 11-2; there are just
too many neat WUDs (Wonderful User Devices) to list them all in one pass.

Rewind/previous track
Play/pause
Fast forward/next track Track list

Volume Track/status Search box

Wed 6:06 PM| &)

e
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Create a playlist

Source list

This isn’t the only face of the iTunes window. It morphs into something differ-
ent when you're browsing music from the Apple Music Store, and you can also
decide to watch animation while you listen. More on these different looks later.
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Before I dive into a discussion of how to use all this good stuff, let me intro-
duce you to the controls that you’ll use most often in the iTunes window:

v Source list: Imagine all your albums listed alphabetically — or, even
better, playlists of your favorite songs that you create to match your par-
ticular mood. You find both in the source list, along with a handful of
special categories called Library, Podcasts, Videos, Party Shuffle, Radio,
and Music Store. (As you can tell from Figure 11-1, I listen to a wide
range of musical genres.)

1 Rewind/previous track: Click and hold down this button to move back-
ward quickly through the song that’s currently playing. Clicking returns
you to the beginning of the track, and double-clicking this button takes
you to the previous track in the list.

v Play: Recognize it from your old cassette deck? Click Play, and iTunes
begins playing the selected music or podcast from the Track list or the
selected video from the video thumbnail display. (I tell you more about
selecting your favorite hits in the following section.) While your music
or video is playing, this bad boy turns into a Pause button, which you
can click to pause your music. To begin playing again where you paused,
click the button again.

v Forward/next track: Click and hold this button down to move forward
through a song at a fast clip. Click it normally to jump directly to the
next track in the list.

v Volume: Drag this unassuming control to raise or lower the volume
within iTunes. Go figure.

v Track list: Ah, you knew I'd get to this sooner or later. The track list dis-
plays all the songs, radio stations, and assorted whatnot that you can
play in iTunes. Double-clicking an item in the track list starts it playing
immediately. When you select Videos in the source list, the track list turns
into a scrolling collection of thumbnails, each of which corresponds to a
TV show or music video.

v Track/status display: A cool-looking LCD display in the middle of brushed
chrome . .. oh, yes. The display usually shows you the progress of the
current song and also rotates to inform you of the track name and artist.
iTunes also uses the display to show prompts and messages about things
such as burning discs and importing music.

Note those two tiny icons at both sides of the track display:

¢ Click the Play icon on the left side, and the track display trans-
forms into a graphic bar display like those on the finest stereo
systems. (Click the icon again to return to the normal display.)
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e Click the circular icon at the right side of the display, and iTunes
returns the selection highlight in the track list to the song that’s
currently playing.

1 Search box: This works much like the Search box in the Finder window
toolbar. You can type artist, album, and song names here. Then press
Return, and iTunes presents you with items that match in the track list.

v Create a playlist: Click this button to add a new empty playlist to your
source list, ready to be filled with whatever songs or items you crave.

That’s the quick tour. Simple, elegant, and powerful as a Ferrari. Time to get
started playing music and watching videos!

The Lazy iTunes Guide

In this section, I show you how to take care of business: playing your music (in
all its many forms), enjoying a podcast, creating playlists, organizing your col-
lection, and watching your music. (No, that last one wasn’t a typo. Just wait.)

Listening to song files, playlists,
Internet radio, and audio CDs

iTunes recognizes a number of audio file formats, and you can listen to any of
them:

v MP3: Unless you've been hiding under a rock for the last few years,
you'll recognize this popular format. MP3 files produce excellent quality
at a small size, but a discerning ear can hear the effects of the compres-
sion used to shrink an MP3 file. (Oh, and these files aren’t copy-protected.)

v AAC: Apple’s AAC format offers better compression than MP3, so your
songs are smaller and sound better. However, AAC files might be copy-
protected, so they can’t be shared among more than a handful of Macs.
When you buy and download music from the Apple Music Store (which
I crow about later in this chapter), the songs that you get are in AAC
format.

v~ AIFF: AIFF was the original high-quality format for audio files on the
Mac, but they’re uncompressed and just too big, so most folks have left
them behind in favor of MP3 and AAC.

v WAV: Microsoft’s original Windows audio format is similar to AIFF. WAV
format songs can reach the highest quality possible, but they’re so honk-
ing huge that practically no one uses WAV format any longer.

v~ Apple Lossless: Audiophiles love this new format from Apple because
the compression doesn’t affect the sound quality (as it does with MP3
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and AAC files), yet Apple Lossless files are much smaller than AIFF and
WAV files and sound as good. Is this the perfect audio format? Stay
tuned, friends: Only time will tell. Oh, and yes, copy protection is
included at no extra charge.

Okay, enough techno-info. Back to the music! iTunes makes it easy to listen to

a song:

v From a Finder window: Double-click the song icon (as shown in Figure
11-2) or drag the song file from the window to the iTunes icon on the
dock. iTunes launches automatically, if necessary, and the song appears
in the track list while it plays. You can also drag a song file from a Finder
window directly to the iTunes track list.

v From the iTunes track list: Double-click the track entry.
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Yes, Virginia, you can broadcast your music

If you've been following the Apple scene for the
last year or so, you might already know about
another of Apple's wireless success stories: the
AirPort Express base station. Okay, I'm guilty —
the AirPort Express is actually covered in
Chapter 17. However, | want to mention it here
as well because you can use one of these neat
devices to stream music to any room (and any
standard stereo system) in your house, and that
counts as wireless device-style magic to me.

Naturally, you need an existing AirPort Extreme
wireless network (connected to your Mac)
that's already operating to send your music
across the airwaves. In essence, you're using
the AirPort Express as a music receiver instead
of a base station. All your iTunes playlists are
sent over the wireless connection to the AirPort
Express unit, which in turn sends it across a

standard audio out cable to the Line In jack or
optical digital connector on your stereo.

Here's how simple it is: You plug the AirPort
Express into the AC wall socket next to your
stereo or boom box (in fact, even a set of AC or
battery-powered speakers will work) and con-
nect an audio out cable from the base station to
the sound system. Wait until the status light
turns green to indicate that the unit is online.
Then run the AirPort Express Assistant on your
laptop, which leads you through the setup
process with onscreen prompts.

iTunes recognizes your remote audio hookup
automatically. All you have to do is click the
remote unit in the pop-up menu at the bottom-
right corner of the iTunes window, and you're
suddenly Wolfman Jack!

That’s all there is to it! A tiny “playing” speaker appears next to the song in

the track list. If you pause iTunes, the speaker goes silent, but it remains next

to the track to indicate what you’re going to hear if you click Play again.
Although the highlight cursor may be on another song or playlist, that tiny
speaker icon always sticks next to whatever’s playing.

Speaking of the Play button, you really don’t have to click it. Instead, you can
press the spacebar to play or pause a song in iTunes. In fact, pressing the

right-arrow key works the same as clicking the iTunes Next track button, and
pressing the left-arrow key works just like clicking the Previous track button.

While you're listening to a song, notice the cursor as it moves along the progress
bar in the Status display. Feel free to click and drag that cursor to the left and
right, which works the same as using the Rewind and Fast forward controls,
respectively. (In fact, I use this method exclusively because it lets me cover a lot
of musical ground when I'm listening to a 24-minute track from Frank Zappa.)

If you get tired of hearing an album in the same order that you memorized
years ago, make use of the Shuffle button. Click a playlist and then click the
Shuffle button (labeled in Figure 11-2). The button turns blue, and iTunes
mixes the order of your music automatically. To exit shuffle mode, click the
Shuffle button again. (If you click the Library entry at the top of the source list
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and click Shuffle, you get a wild mix taken from every song you’ve collected.)
Note that Shuffle doesn’t change the order of the songs in the track list.

You can specify whether iTunes should shuffle by songs or albums. Choose
iTunes=>Preferences, click the Advanced toolbar button, and then click either
Shuffle Song or Album.

Listening to a playlist

[ show you how to create a playlist later in the chapter, but for now, you can
consider it a unit, like a traditional vinyl album or audio CD. A playlist can be a
collection of songs that you choose yourself and organize by genre (such as
Boudreaux'’s Favorite Zydeco Hits), or it can include the songs that appear in an
actual album (such as Fleetwood Mac’s Rumours). In other words, the contents
of a playlist are up to you. It’s a container, like a folder in the Finder window.

Listening to a playlist is simplicity itself: Just click the desired playlist in the
source list and then click Play or press the spacebar. iTunes immediately
shows you the contents of the playlist in the track list and starts to play the
first track.

While you're listening to a playlist, feel free to browse other music in your
collection; iTunes keeps track of what song is due next, even if you're looking
at a different playlist. To jump to a specific track in a different playlist that
you’re browsing, just double-click it. iTunes immediately switches to that
track and continues to play the rest of the new playlist that you just selected.

Out of the box, iTunes stops playing after it reaches the end of the last song
in a playlist. Don’t like that? Then you’ll be ecstatic to learn that a single click
of the Repeat song/playlist button (labeled in Figure 11-2) repeats all the
songs in the playlist. (The button turns blue when Repeat is on.) If you click
the same button again, a tiny 1 icon appears, and only the current song
repeats. A third and final press of the Repeat button turns the feature off, and
you're back to Start. (Click the Library icon at the top of your Source list,
click Repeat, and the tunes keep on coming until you choose to stop them.
For my collection, that’ll take almost four solid days!)

Tuning in to streaming Internet radio

A neat Internet technology that you might not have heard of is called stream-
ing radio, which plays music. iTunes can receive and play streaming radio in
real time. The music sounds just as if the broadcast were traveling across the
airwaves instead of that expensive cable modem. (Well, except for the fade-
outs and static, but you won’t miss those.)

To display the variety of Internet radio stations provided by Apple, click the
Radio icon in the source list. Figure 11-3 illustrates the wide selection, catego-
rized by genre. I guess the folks in Cupertino enjoy their music, too!

159
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the Internet
means more

¥ k| Music Suore
‘s Shopping Cart

& Tracks M've Gora Hear

& AC/DC - Back in Black

& Aliman Brothess - At Fillmare East

F Arctic Monkeys — Whatever Pecgle Say | Am, Thar's What I'm Not
& Arlo Cuthrie - The Best of Arlo Cuthrie
& B-52s - B-523

o B-525 - Bauncing OFf the Saellites

4 Beach Boys - Surfs Up

& Bestof Sun Record Company

- Baume Midler - Live ar Last

& Bill Cosby - Wonderfulness

& Billie Holiday - Best of Billie

£ Billy Joel - An Innocent Man

£ Billy Joel - The Stranger

& Bing Crasby - Tne Radia Years, Vol. L
& Black Crowes - The Southern Harmony and Musical Companicn
& Blues Brothers - Briefease Full of Blues
& Bob Seqer - Beautiful Loser

F Bobby Darin - My Favarites

£ Bosten - Bostan

& Boston - Greatest Hits

& BR347 - My Favorites

F Cajun - Alligator Stamp

& Cars - Candy-0

Figure 11-3:
Suddenly

than e-mail
and the
Web.

@ iTunes File Edit Contrals Visualizer Advanced Window Help S 9 & ¢ W 4 Thu73eam D
8ana Tunes
P f 9 o
O | & | @
W[ Stream Bit Rate | Comment
T3 Library ¥ 5D5/605 Pap
¥ Podeasts ¥ 70s/80s Pop (54 streams)
[ videos I AlLModern Rock
& Party Shuffie # amaient (29 sreams]

» Americana
b Blues

I Classic Rack {26 streams)
I Classical (15 streams)

» Country

B Eclectic

# Elecrranica

B Hard Rock § Meral

B International

< #MusikLounge an RauteM

T #Musik.Lounge on RauteM..
Absalutely Smaoth Jazz an..

= Absalutely Smooth Jazz on
aTTeNTioN sPaN raDi0 L

T ATTeNTIoN sPaN ralio 1

T aTTeMTioN sPak rali0 2
DLIm Modern Jazz

T DI.fm Modern Jazz

= Dimensions in Jazz
Erherbeat Radio

= Frerhear Radio

128 kips
48 kbps
128 kbps
24 kips
24 kbps
56 kbps
56 kbps
96 kbps
56 kinps
56 kbps
64 kbps
24 kbps

#Musik-Loange - 247 hours open - Music

A mie of instrumental jazz, funk and rock
Solos, Duets, Trics and X-tets from the ye..

The likes of Coftrane, Orantte Coleman, En
Mostly jazz from the 505 & Gos

The Urban Alternative

The Urban Alteraative

= MacWoary Radio 32 kbps | Al Sl Gaiflard -~ The Flat Foat Floogse w.

#Musik-Lounge - 24/7 hours apen - Music..
the weeld's Smoothest jazz 24 hours a day..
the werld's Smocthest 222 24 hours a day..
A mix of instrumental jazz, funk and rock ...

The likes of Coltrane, Ornette Coleman, Eri..

FAlRadic.net 1 64 kbps Woarkday favarite - smooth jazz, easy liste...
Forever Cool 54 kbps  Featuring the laid-back sourd of Coof and...|
T KHE Live 56 kbps | Klazz-the best jazz and blues, live frem 5.,
KMHD 4B kbps  Jazz, Blues, and American Roots Music
TKPLU 32 kbps  WORLD CLASS JAZZ 24-HOURS A DAY
T KSER 56 kbps | From Classic to Cantemporary/Funk ta Fus..
. KSBR 24 kbps  From Classic to Conternporary/Funk to Fus..

EEITENP--N

162 streams

& Chicagn - Groarast Hits Hadio Reposada 48 kbps Jazz and electronica fram Cuernavaca, MY
:
& Chiefrains - Boil the Breakflast Early disiad 105 L Ll " laimal iy
€ s
ey

Recognize those right-facing triangle icons from the Finder window’s list
mode? Yep, just click a triangle to expand or collapse that category to see the
entries it contains. To start playing, double-click a station entry.

Hey, do you remember the "70s?

Do you remember Farrah Fawcett, disco balls,
and the AMC Javelin? Do you yearn for the
incomparable music that dates from 1970 to
19797 Then, my friend, do | have an Internet
radio station for you! It's called MLC Radio
Online (I bet you saw that coming, didn’t you?),
and it features the absolute best from the
Decade That Shall Never Come Again. Rock,
folk, disco, soul, and even the beginnings of
New Wave and Alternative. (And yes, it does

include Kung Fu Fighting by Carl Douglas. After
all, the song was hot.)

MLC Radio Online requires a high-speed con-
nection (DSL, cable modem, or satellite)
because all those hits are 128 Kbhps, CD quality!
Itisnt in Apple’s default list — are you listen-
ing, Mr. Jobs? — but the station address is
on my Web site, MLC Books Online, at www .
mlcbooks.com. See you there, Starsky &
Hutchfans!
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P A station’s bit rate means a lot, especially if you're using a dialup modem con-
nection. The higher the bit rate, the better the sound. A bit rate of 128 Kbps
gives you CD-quality sound, but it takes a high-speed Internet connection
(such as a DSL or cable modem connection) to move all that data fast enough
to provide uninterrupted music. (You’ll know this is the problem if iTunes
keeps pausing during play so that it can catch up to the station’s data.)
Therefore, if you're using a dialup connection, I recommend that you stick
with stations offering music at around FM quality, which is 56 Kbps or less.

P You can also tune in to an Internet radio station by entering that station’s
Web address directly into iTunes. Press 8+U (or, for the keyboard-wary,
choose Advanced=>Open Stream) to display a text box in which you can type
or paste the station’s Web address. Click OK, and sit back.

Listening to a podcast

Unless you've been doing the hermit gig for the last couple of years, you've
likely heard of podcasts, which are much like radio shows (typically talk radio,
usually opinionated, practically never boring). Instead of being broadcast by a
traditional radio station, however, podcasts are distributed by companies and
individuals as MP3 files. You can listen to them on your laptop using iTunes or
download the podcast to your iPod for later listening on the move.

The iTunes Music Store includes a separate section for podcasts. (In fact, you
don’t even have to visit the iTunes Music Store to view the Podcast directory:
Just click the Podcast Directory link at the bottom of the window.) When you
find a podcast you like, you can subscribe to it by clicking the Subscribe button.
iTunes automatically downloads the latest edition of a subscribed podcast each
time you’re connected to the Internet. To unsubscribe from a podcast, click it in
the podcast list in iTunes and then click the Unsubscribe button.

< You can also subscribe to a podcast offered on a specific Web site. Choose

Advanced=>Subscribe to Podcast, and then enter the URL (or Web address)

provided by the podcaster.

You listen to a podcast in iTunes in the same way you listen to an individual
track: Click the Podcast entry in the source list and then double-click the
desired podcast in the list.

Giving your audio CDs the treatment

To play a music CD, load the disc into your laptop. By default, iTunes launches
automatically whenever you load a music CD. Click the CD icon in the source
list to select it, and then click the Play button and start enjoying yourself.

\&&N\BER The Rewind and Forward buttons also function as Previous track and Next
S track when you’re listening to a CD. Click the Previous track button once,
and iTunes returns to the beginning of the track that’s currently playing. (If
you’ve used home or car CD systems, you’'ll immediately recognize this
behavior.) To make the move to the previous track, double-click the button.
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Doing the iPod dance

If you're the proud owner of an iPod, | salute
you. My old 15GB model is still chugging away
and still has a little room left for a few more
songs. Each time you plug your iPod into its
cradle, iTunes automatically updates your iPod'’s
hard drive with any changes, additions, or dele-
tions you've made to your library. It's all pretty
automatic.

| wish | had more space to go into more detail
on advanced settings for the iPod in iTunes, but

this is a book dedicated to your Mac laptop, and
my editors tell me that | must concentrate on
that glamorous piece of Apple hardware. If
you'd like a comprehensive guide to everything
that you can do with iTunes and iPod, iPod &
iTunes For Dummies, 2nd Edition (by Tony Bove
and Cheryl Rhodes; Wiley) devotes a full 384
pages to the dynamic duo. Gee, | only got 16
pages to cover all of iTunes. Sometimes life is
so unfair.

A\\S

To specify what action iTunes should take after it’s launched by loading a CD,
choose iTunes>Preferences and then click the General toolbar button. Click
the On CD Insert pop-up menu and choose your weapon.

To eject the disc, you can simply click the Eject button (labeled in Figure 11-2).
iTunes immediately sends the disc packing.

If you’d rather not have iTunes launch all by itself when you load an audio
CD, open System Preferences and click the CDs & DVDs icon. Then click the
When You Insert a Music CD drop-down list box and choose the action that
you prefer, or choose Ignore if nothing should happen.

Watching video

Watching video in iTunes is similar to listening to your music. To view your
video collection, click the Videos entry in the source list; iTunes displays
your videos as thumbnails, as shown in Figure 11-4. From here, you can

v Double-click a video thumbnail.

v Drag any QuickTime-compatible video clip from the Finder window to
the iTunes window. (These typically include video files ending in .mov
or .mp4.)

The player window you see in Figure 11-4 sports a slider bar that you can
drag to move through the video. You can also pause the video by clicking the
Pause button.
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Organizing, sorting, and searching

What good is having the world’s largest music collection if you can’t find any-
thing? In this section, I help you get organized by showing you how to create
playlists, sort stuff, and rearrange tracks as you see fit.

Creating playlists and moving your music

The Library category in the source list is the Big Kahuna. Click Library, and
you see every song in your collection, all in one huge list. The playlist is the
other side of the coin because it allows you to compartmentalize your music
any way you please.

You can create a playlist in several ways:

v Click the Create New Playlist button (which bears a plus sign) at the
bottom of the iTunes window.
v Choose Filew>New Playlist.

1” Press 38+N.
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No matter which method you choose, a new entry named untitled
playlist appears in the source list. The entry is actually a text entry box,
ready for you to type a more descriptive name. Do so, and press Return. Bam!
You've created an empty playlist.

Change your mind about a playlist name? No problem! You can rename a
playlist just like you rename a file in the Finder window: Click the file to select
it, pause for a second, and then click again. The edit box reappears, and you
can type the name that you really want.

As you can tell from the figures in this chapter, I prefer to name most of my
playlists with artist or band name first, then a dash, and then the album
name. (This helps keep things organized alphabetically in the source list.
When you have almost 1500 songs in your Library, the alphabet becomes a
truly handy tool.) Most of my playlists are albums, so this makes sense. If you,
on the other hand, prefer to build your playlists song by song, My Favorite
Swedish Rock Ballads might work better as a name. It’s all up to you!

After you create your new playlist, you can drag songs from your Library and
drop them on top of the playlist entry in the source list. Alternatively, you
can click the playlist name in the source list and then drag the songs into the
track list. To choose multiple files at once, hold down 8 while you click.

To delete a track from a playlist, click it to highlight the song and then press
the Delete key. Note, however, that the song isn’t deleted from your collection
unless you click the Library entry in the source list and delete the song there
as well. Deleting a playlist works the same way: Click the playlist to select it,
and then press Delete.

You can also select songs in the track list and create a playlist that contains
those tracks. Click the desired tracks to select 'em and then choose File>New
Playlist from Selection. You still get the playlist name edit box, but the
playlist already contains the files that you chose.

After the songs that you want are in your new playlist — however they got
there — they don’t have to remain in the order in which you first see them.
For example, to move a song from the Track 2 position to the Track 3 posi-
tion, click the song and drag it to the desired spot. (iTunes creates a ghost
entry to help you keep track of where that track is going. Sorry, bad pun.)

This same drag-and-drop functionality works throughout most of iTunes.
Drag tracks here and there to organize your music into the playlists that you
create. It’s just plain fun.

Searching for every artist named Elvis

(Don’t laugh, I've done it.) You can use the Search box in the iTunes toolbar
to locate a string of text. For example, follow these steps to find whether Elvis
is in the building:
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1. Click the Library entry in the source list to select it.

In most cases, you want to click the Library entry so that your search
encompasses your entire music collection. However, if you have a really
huge playlist to search, you can select the individual playlist instead.

2. Click the magnifying glass icon.

This displays a short pop-up menu from which you can choose to search
through just one data field — the Artist, Album, Composer, or Song
Name. The default is All, which doesn’t limit the search to any one field;
any match of any of the four criteria counts.

3. Click in the Search box and type the text that you want to match.

iTunes immediately goes to work and displays the matches (within the
criteria that you select) in the track list.

4. Click the X icon on the right side of the Search box.

iTunes erases the search text, and the rest of your collection reappears.
Now you can try another search, if you like.

By the way, the search for Elvis returned just two songs: Elvis Has Just Left the
Building (Frank Zappa) and Hound Dog (the King himself). Note to self: Get
more Elvis.

Sorting your music every which way

Check out those buttons atop each column in the track list. They work just
like the buttons at the top of each column in a Finder window when you’re
using list mode. Click Song Name, for example, and your selected playlist or
your entire Library is sorted by song name.

The ability to sort by artist, album, and genre can provide interesting pick-
ings for new playlists. Never before has it been so easy to compose your own
greatest-hits collection from your favorite band or from a specific musical
style.

Oh, and if the artist name, album name, or genre doesn’t appear for songs in
your track list, don’t worry — that just means you need to add the informa-
tion, and that’s the next topic.

Adding or editing song information

Many of the MP3 and AAC files that you add to your collection already have
tags — that’s the techno-nerd name for the information that’s embedded in a
song file, which iTunes displays in the track list, like the year the song was
released and the album name.
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But what if a track (or an entire playlist) has no tags, or the tags are wrong?
You can add or edit them yourself. Follow these steps:

1. Click the desired songs to select them.

To select every song in the playlist, click the first track and then press
B+A.

2. Press 38+1.

Mac fanatics everywhere can immediately identify what appears as the
Get Info keyboard shortcut. The Info dialog box for the selected tracks
appears, as shown in Figure 11-5. (If you’re adding information for just
one song, click the Info button to get to the same spot. Personally, I usu-
ally find myself adding song information for every song in a playlist, so |
usually see the Multiple Song version.)

3. Click in each field that you want to add or edit, and then enter the
new tag information.

Remember, the same information that you add is embedded in every
song that you select, so it needs to apply equally. For example, if you
select songs from AC/DC, Louis Armstrong, and Hank Williams Sr., you
probably wouldn’t want to apply the Genre tag Rock to all of them!
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4. After you're finished, click OK.

iTunes displays a progress bar as it embeds the tag data in the songs.

P If you're wondering about that square marked Artwork, you can indeed drag an
image of the album cover to the square to embed it. (This trick works exception-
ally well with thumbnails dragged from the Amazon Web site.) To display album
art while a song is playing, press 88+G to toggle the Artwork pane on and off.

Visualization — music for your eyes

Speaking of artwork, iTunes can display a kaleidoscopic animated light show
right out of Woodstock for your visual pleasure. Click the Visualization button
(Figure 11-2 yet again) to enter the light show or press 3+T. Figure 11-6 gives
you an idea of the beautiful patterns that you might see.

To switch your laptop into mind-blowing full-screen mode, press 38+F. You
even get an MTV-style song information block in the lower-left corner!

To exit visualization mode and get back to work — like [ should right now —
press 38+T again or click your mouse button.
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Figure 11-6:
Hey, dig that
crazy light
show!
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In this final section, I cover three important tasks: Two involve getting songs
into iTunes (by importing them and buying them), and the last instructs you
on how to get music out of iTunes (by burning your own audio CDs). I trust
you’ll be paying attention.

Importing songs from CD and hard drives

It’s easy to import — or, as the process is more popularly called, rip — music
from music CDs that you own. First, however, it’s a good idea to set up your
encoder (the software that actually converts a track from digital to MP3
format), so go ahead and launch iTunes by clicking the iTunes icon on the
dock. Then follow these steps:

1. Choose iTunes~Preferences to display the Preferences dialog box.

2. Click the Importing button on the toolbar.

3. Click the Import Using pop-up menu and then choose one of the
following:

e MP3 Encoder: Gives the best compatibility with other computers
and devices. If you choose MP3 encoder, click the Setting drop-
down list box and choose Higher Quality (192 Kbps).

In my experience, this bit rate gives you the best combination of
good audio quality and smaller file sizes.

e Apple Lossless Encoder: Gives the best sound, although the file
sizes will be larger than MP3 format.

4. Click OK.
That takes care of your encoder settings — a process that you need to per-
form only once. Now you're ready to do the deed. With iTunes running, follow
these steps to add the songs to your Library:

1. Load a music CD into your Mac.

If you have an active Internet connection, iTunes attempts to identify the
tracks and name them for you.

2. Click the check boxes of any tracks that you want to import.
3. Click the Import button at the right side of the iTunes window.

Figure 11-7 illustrates iTunes importing my favorites from a Ray Charles
music CD.
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To import songs from files you've downloaded or copied to your hard drive,
follow these steps:

1. Open a Finder window and navigate to the location where the songs
are stored.

2. If you want, create a new playlist to hold the songs, as I describe ear-
lier in the chapter.

You can also import the songs straight into your Library and organize
them later.

3. In the Finder window, select all the songs that you want to import.

4. Drag the song files into the iTunes window and drop them either on
top of the desired playlist or into the track list itself.

iTunes takes a second to verify the files and assign their tag information, and
then your new tracks appear in your playlist or the Library.

Buying Billie Holiday from
the Apple Music Store

As long as you have an active Internet connection — and I fervently hope
that it’s a high-speed DSL or cable modem connection — the Apple Music
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Figure 11-8:
Browse the
shelves of
the iTunes
Music

Store.
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Store is ready to serve your needs, with well over a million tracks for you to
choose from! Most single tracks are only $0.99 each, and most full albums are
$9.99 at the time of this writing.

The first time that you access the Music Store, you provide your credit card
and e-mail account information over a secure connection. From that point
onward, the Music Store remembers them and logs you in automatically. You
buy the tracks, albums, and videos you want, with no silly strings attached.
(Most podcasts offered on the Music Store are free.)

To browse or buy, click the Music Store entry in the source list. After a
moment or two, you see the entrance to the Store (as shown in Figure 11-8).
To browse, simply

v Click an album cover from the entrance page.

v Click a link to one of the day’s top songs or albums.

v Click the Choose Genre pop-up menu and select your passion.

v Click the Power Search link to perform an advanced search for just that
one artist or album.
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If you're interested in buying a track or album (but don’t have the desire or
time to browse), click the Show/hide ministore button to display a separate
Music Store pane for the currently highlighted track. Your playlist remains in
view while you peruse the information, and you can even buy from the
Ministore pane. To dismiss the Ministore pane, click the button again.

As you drill deeper into your favorite media, notice the back and forward
arrows and the Home icon right under the iTunes track display. These con-
trols work just like a Web browser, moving you to previous and next pages, or
returning you to the top-level entrance page (respectively). Nice.

Oh, and those little arrows next to the album and artist names in the iTunes
track list? If you already clicked one to experiment, you know that they auto-
matically take you to the Music Store so that you can purchase more music
by the same (or similar) artists.

If you decide to buy a track or an album, just click the corresponding Add Song
or Add Album button. The tracks that you marked are saved in the Shopping
Cart subentry (under the Music Store entry in your iTunes Source list). After
you’ve finished shopping, click the Shopping Cart entry and click the Buy
Now button. iTunes immediately begins downloading your new music, and
the tracks are saved to the Purchased Music playlist (again, immediately
below the Music Store entry in the source list).

Now you can move the music you bought to anywhere in your collection, build-
ing a new playlist or distributing them amongst your existing playlists. Enjoy!

Burning like a true techno

Are you ready to record your own music and MP3 CDs? Sure you are! You can
play the music CDs that you burn in just about any audio CD player or com-
puter these days, but MP3 discs are a little more specialized. Because they
are actually data discs that contain your music in MP3 format, you can store
a lot more music on a single disc. (Luckily, more and more audio CD players,
boom boxes, and computers can recognize and play an MP3 disc.) Still, here’s
the Mark’s Maxim to live by:

If you want the broadest compatibility, burn a standard audio CD.

To specify which type of disc you want to create, launch iTunes and follow
these steps:

1. Choose iTunes=Preferences to display the Preferences dialog box.

2. Click the Burning button on the toolbar.
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3.

4.

Click either Audio CD or MP3 CD.

Don’t burn a data CD unless you’ll only read the disc on a computer. If
you’re burning a disc for your car or home audio CD player, choosing
data CD is a good definition of a bad idea.

Click OK.

After you configure the type of disc that you want to burn, follow these steps
to burn the contents of a playlist to an audio or MP3 CD:

1.
2.

In the iTunes Source list, select the playlist that you want to burn.
Click the Burn Disc icon at the upper right of the iTunes window.

The icon changes into a truly neat burning symbol, and you're prompted
to load a blank CD-R.

Never use a CD-RW to record an audio CD unless you're sure that your
audio player supports rewriteable media — again, for the best compati-
bility, use a CD-R.

. Load the blank disc.

iTunes displays the total songs and time for the recording.

. Click the Burn Disc icon again, and await your new music or MP3 CD

with a smile on your face!



Chapter 12

Turning 1Photo into Your
Portable Darkroom

In This Chapter
Introducing the elements of the iPhoto window
Importing images from a camera or your hard drive
Arranging your photos the right way
Basic editing in iPhoto
Printing your own coffee-table book
Photocasting your pictures to friends and family

Sending images through e-mail

a
Photo, my favorite image cataloging-editing-sharing tool, is probably right
at the top of the popularity ratings when it comes to the iLife 2006 suite
because virtually every Mac owner is likely to have a digital camera or a
scanner. Digital video (DV) camcorders have certainly grown more plentiful
over the past three or four years, and the iPod is the hottest piece of music
hardware on the planet at the time of this writing, but the digital camera has
reached what those funny (strange) marketing people refer to as saturation.

With this in mind, I'm willing to bet that iPhoto is either the first or the
second iLife application that you fall in love with (running neck-and-neck with
iTunes). In this chapter, I show you how you can organize, print, share, and
display your digital photographs with true Apple panache!

Shaking Hands with the iPhoto Window

In Figure 12-1, you can see most of the major controls offered in iPhoto.
(Other controls automagically appear when you enter different modes — I
cover them in upcoming sections of this chapter.)
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Although these controls and sections of the window are covered in more detail

in the following sections, here’s a quick rundown of what you’re looking at:

v Source list: This list of image locations determines which photos iPhoto

displays.

® You can choose to display either your entire image library or just
the last “roll” of digital images that you downloaded from your

camera.

® You can create new albums of your own that appear in the source
list; albums make it much easier to organize your photos.
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v Viewer: This pane displays the images from the currently selected
photo source.

You can drag or click to select photos in the viewer for further tricks,
such as assigning keywords and image editing.

1 Create New Album button: Click this button to add a new blank album,
book, or slideshow to your source list.

 Get Info button: Click this button to display information on the cur-
rently selected photos.

v Find Photos by Date button: Click this button to view photos added in a
specific month or date. While you’re viewing the calendar, click the tiny
Date toggle button at the top left of the calendar display to switch
between month and date displays. (A month or date that appears in bold
contains at least one image.)

v Find Photos by Keyword button: Click this button to view photos that
you've marked with one or more keywords. (More on this later in the
chapter.)

v Enter Full Screen button: Click this button to switch to a full-screen
display of your photos. In full-screen mode, the images in the selected
album appear in a film strip across the top of the screen, and you can
click one to view that image using your laptop’s entire screen real estate.
You can also use the same controls that I discuss later in this chapter for
editing and adjusting images — just move the mouse cursor to the top
edge of the full-screen display to show the menu, or to the bottom edge
to show the toolbar.

v Toolbar buttons: This group of buttons selects an operation you want to
perform on the images you’ve selected in the viewer.

v Thumbnail Resize slider: Drag this slider to the left to reduce the size of
the thumbnails in the viewer. This allows you to see more thumbnails at
once, which is a great boon for quick visual searches. Drag the slider to
the right to expand the size of the thumbnails, which makes it easier to
differentiate details between similar photos in the viewer.

Working with Images on Your Laptop

Even a superbly designed image display and editing application like iPhoto
would look overwhelming if everything were jammed into one window. Thus,
Apple’s developers provide different operation modes (such as editing and
book creation) that you can use in the one iPhoto window. Each mode allows
you to perform different tasks, and you can switch modes at just about any
time by clicking the corresponding toolbar button.
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In this section, [ discuss three of these modes — import, organize, and edit —
and what you can do when you’re in them. Then I conclude the chapter with
sections on publishing and sharing your images.

Import mode: Coaxing photos
from your camera

In import mode, you're ready to download images directly from your digital
camera — as long as your specific camera model is supported in iPhoto. You
can find out which cameras are supported by visiting the Apple iPhoto sup-
port page at www . apple.com/macosx/upgrade/cameras.html.

\\s

Follow these steps to import images:

1. Connect your digital camera to your laptop.

Plug one end of a USB cable into your camera and the other end into
your Mac’s USB port, and prepare your camera to download images.

2. Launch iPhoto.

Launch iPhoto by clicking its icon in the dock (or in your Applications

folder).

The first time that you launch iPhoto, you have the option of setting its
auto-launch feature — I recommend this feature, which starts iPhoto
automatically whenever you connect a camera to your laptop.

3. Type a roll name for the imported photos.

Importing images from your hard drive

If you have a folder of images that you've
already collected on your hard drive, a CD, a
DVD, an external drive, or a USB Flash drive,
adding them to your library is easy. Just drag
the folder from a Finder window and drop it into
the source list in the iPhoto window. iPhoto
automatically creates a new album using the
folder name, and you can sit back while the
images are imported into that new album.
iPhoto recognizes images in several formats:
JPEG, GIF, RAW, PNG, PICT, and TIFF.

If you have individual images, you can drag
them as well. Select the images in a Finder
window and drag them into the desired album
inthe source list. To add them to the album cur-
rently displayed in the viewer, drag the selected
photos and drop them in the viewer instead.

If you'd rather import images by using a stan-
dard Mac Open dialog box, choose File=>Import
to Library. Simplicity strikes again!
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4. Type a description for the roll.

If you don’t expect to download these images again to another computer
or another device, you can select the Delete Items from Camera after
Importing check box to enable it. iPhoto automatically deletes all the
images after they’ve been downloaded from the camera. This saves you
a step and helps eliminate the guilt that can crop up when you nix your
pix. (Sorry, I couldn’t resist.)

5. Click the Import button to import your photographs from the camera.

The images are added to your Photo Library, where you can organize
them into individual albums, as well as in a separate “virtual” film roll in
the source list.

“What’s that about a roll, Mark? I thought I was finally getting away from
that!” Well, you are — at least a physical roll of film — but after you download
the contents of your digital camera, those contents count as a virtual roll of
film in iPhoto. You can always display those images by clicking Last Roll or
by choosing a specific roll (both are in the source list). Think about that . . .
it’s pretty tough to arrange old-fashioned film prints by the roll in which they
originally appeared, but iPhoto makes it easy for you to see just which
photos were part of the same download group!

Organize mode: Organizing
and sorting your images

In the days of film prints, you could always stuff another shoebox with your
latest photos or buy another sticky album to expand your library. Your digital
camera, though, stores images as files instead, and many folks don’t print
their digital photographs. Instead, you can keep your entire collection of digi-
tal photographs and scanned images well ordered and easily retrieved by
using iPhoto’s organize mode. Then you can display them as a slideshow,
print them to your system printer, use them as desktop backgrounds, or burn
them to an archive disc.

A new kind of photo album

The key to organizing images in iPhoto is the album. Each album can repre-
sent any division you like, be it a year, a vacation, your daughter, or your
daughter’s ex-boyfriends. Follow these steps:

1. Create a new album.

You can either choose File=>"New Album or click the plus (+) button at
the bottom of the source list. The New Album sheet appears, as shown
in Figure 12-2.
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Figure 12-2:
Add a new
albumiin
iPhoto.
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2. Type the name for your new photo album.
3. Click OK.

iPhoto also offers a special type of album called a Smart Album, which you
can create from the File menu. A Smart Album contains only photos that
match certain criteria that you choose, using the keywords and rating that
you assign your images. Other criteria include recent film rolls, text in the
photo filenames, dates the images were added to iPhoto, and any comments
you might have added. Now here’s the really nifty angle: iPhoto automatically
builds and maintains Smart Albums for you, adding new photos that match
the criteria (and deleting those that you remove from your Photo Library)!
Smart Albums carry a gear icon in the source list.

You can display information about the currently selected item in the informa-
tion panel under the source list — just click the Show Information button at
the bottom of the iPhoto window, which sports the familiar “i-in-a-circle”
logo. You can also type a short note or description in the comment box. For
more in-depth information, select the desired item and then press 38 +I.
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You can rename an image by selecting it in the viewer — you’ll notice that the
Title and Date fields below the source list turn into text edit boxes, so you
can simply click in either box to type a new name or alter the photo’s date-
stamp. The same method works when you select a photo album in the source
list — you can change the album name from the Album text box.

You can drag images from the viewer into any album you choose. For exam-
ple, you can move an image to another album by dragging it from the viewer
to the desired album in the source list.

To remove a photo that has fallen out of favor, follow these steps:

1. In the source list, select the desired album.
2. In the viewer, select the photo (click it) that you want to remove.

3. Press Delete.

When you remove a photo from an album, you don’t remove the photo from
your collection (which is represented by the Library entry in the source list).
That’s because an album is just a group of links to the images in your collec-
tion. To completely remove the offending photo, click the Library entry to
display your entire collection of images and delete the picture there, too.

To remove an entire album from the source list, just click it in the source list
to select it — in the viewer, you can see the images that it contains — and
then press Delete.

Change your mind? Daughter’s ex is back in the picture, so to speak? iPhoto
comes complete with a handy-dandy Undo feature. Just press 88+Z, and it’s like
your last action never happened. (A great trick for those moments when you
realize you just deleted from your Library your only image of your first car.)

Organizing with keywords

“Okay, Mark, iPhoto albums are a great idea, but do you really expect me to look
through 20 albums just to locate pictures with specific functions?” Never fear,
good Mac owner. You can also assign descriptive keywords to images to help
you organize your collection and locate certain pictures fast. iPhoto comes with
a number of standard keywords, and you can create your own as well.

To illustrate, suppose you’d like to identify your images according to special
events in your family. Birthday photos should have their own keyword, and
anniversaries deserve another. By assigning keywords, you can search for
Elsie’s sixth birthday or your silver wedding anniversary, and all related photos
with those keywords appear like magic! (Well, almost like magic. You need to
choose Viewr>Keywords, which toggles the Keyword display on and off in the
viewer.)
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iPhoto includes a number of keywords that are already available:

v Favorite

v Family

v Kids

1 Vacation

v Birthday

v Grayscale

v Widescreen

v Checkmark
What'’s the Checkmark all about, you ask? It’s a special case — adding this
keyword displays a tiny check mark icon in the bottom-right corner of the

image. The checkmark keyword comes in handy for temporarily identifying
specific images because you can search for just your check-marked photos.

To assign keywords to images (or remove keywords that have already been

assigned), select one or more photos in the viewer. Choose Photos=>Get Info
and then click the Keywords tab to display the Keywords pane, as shown in

Figure 12-3.
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You're gonna need your own keywords

I'll bet you take photos of other things besides
justkids and vacations — and that's why iPhoto
allows you to create your own keywords.
Display the iPhoto Preferences dialog box by
pressing 38+, (comma), click the Keywords
button on the toolbar, and then click Add (the
button with the plus sign). iPhoto adds a new
unnamed keyword to the list as an edit box,
ready for you to type its name.

You can rename an existing keyword from this
same dialog box, too. Click a keyword to select
it and then click Rename. Remember, however,
that renaming a keyword affects all the images
that were tagged with that keyword. That might
be confusing when, for example, photos origi-
nally tagged as Family suddenly appear with the
keyword Foodstuffs. To remove an existing key-
word from the list, click the keyword to select it

and then click Delete.
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Click the check box next to the keywords that you want to attach to the
selected images to mark them. Or, click the marked check boxes next to the
keywords that you want to remove from the selected images to disable them.

Digging through your library with keywords

Behold the power of keywords! To sift through your entire collection of
images by using keywords, click the Find Photos by Keyword button at the
bottom of the iPhoto window. iPhoto displays the Keywords panel, and you
can click one or more keyword buttons to display just the photos that carry
those keywords.

The images that remain in the viewer after a search must have all the keywords
that you specified. If an image is identified, for example, by only three of four
keywords you chose, it won’t be a match and it won’t appear in the viewer.

Playing favorites by assigning ratings

Be your own critic! iPhoto allows you to assign any photo a rating of any-
where from zero to five stars. I use this system to help me keep track of the
images that [ feel are the best in my library. Select one (or more) images and
then assign a rating using one of the following methods:

v Choose Photos=>My Rating, and then choose the desired rating from the
pop-up submenu.

v Use the 38+0 through 3+5 shortcuts.

Sorting your images just so

The View menu provides an easy way to arrange your images in the viewer by
a number of different criteria. Choose View=>Arrange Photos, and then click
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Figure 12-4:
iPhoto is
now in edit
mode —
watch out,
image
problems!
|

the desired sort criteria from the pop-up submenu. You can arrange the dis-
play by film roll, date, title, or rating. If you select an album in the source list,
you can also choose to arrange photos manually, which means that you can
drag-and-drop thumbnails in the viewer to place them in the precise order
you want them.

Naturally, iPhoto allows you to print selected images, but you can also pub-
lish photos on your .Mac Web site. Click the HomePage button in the toolbar,
and iPhoto automatically uploads the selected images and leads you through
the process of creating a new Web page using the HomePage online wizard.

Edit mode: Removing and fixing
stuff the right way

Not every digital image is perfect — just look at my collection if you need
proof. For those shots that need a pixel massage, iPhoto includes a number
of editing tools that you can use to correct common problems.

The first step in any editing job is to select the image you want to fix in the
viewer. Then click the Edit button on the iPhoto toolbar to switch to the Edit
panel controls, as shown in Figure 12-4. Now you're ready to fix problems,
using the tools that I discuss in the rest of this section.
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Figure 12-5:
Select the
stuff that
you want to
keep in your
photo.
|

Rotating tipped-over shots

If an image is in the wrong orientation and needs to be turned to display cor-
rectly, click the Rotate button to turn it once in a counterclockwise direction.
Hold down the Option key while you click the Rotate button to rotate in a
clockwise direction.

Crop 'til you drop

Does that photo have an intruder hovering around the edges of the subject?
You can remove some of the border by cropping an image, just as folks once
did with film prints and a pair of scissors. (We’'ve come a long way.) With
iPhoto, you can remove unwanted portions of an image — it’s a great way to
get Uncle Milton’s stray head (complete with toupee) out of an otherwise per-
fect holiday snapshot.

Follow these steps to crop an image:

1. Select the portion of the image that you want to keep.

In the viewer, click and drag on the part that you want. When you drag, a
semi-opaque rectangle appears to help you keep track of what you're
claiming. (Check it out in Figure 12-5.) Remember, whatever’s outside
this rectangle will disappear after the crop is completed.
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2. If you want, choose a preset size.

If you’d like to force your cropped selection to a specific size — such as
4 x 3 for an iDVD project — select that size from the Constrain drop-
down list box (to the left of the Crop button).

3. Click the Crop button in the Edit panel.

Oh, and don’t forget that you can use iPhoto’s Undo feature if you mess
up and need to try again — just press $8+Z.

iPhoto features multiple Undo levels, so you can press 8+Z several times to
travel back through your last several changes.

Enhancing images to add pizzazz

If a photo looks washed-out, click the Enhance button to increase (or decrease)
the color saturation and improve the contrast. Enhance is automatic, so you
don’t have to set anything, but keep in mind that Enhance isn’t available if
any part of the image is selected. (If the selection rectangle appears in the
viewer, click anywhere outside the selected area to banish the rectangle
before you click Enhance.)

To compare the enhanced version with the original photo, press Control to
display the original image. When you release the Control key, the enhanced
image returns. (This way, if you aren’t satisfied, you can press 8+Z and undo
the enhancement immediately.)

Removing rampant red-eye

Unfortunately, today’s digital cameras can still produce the same “zombies
with red eyeballs” as traditional film cameras. Red-eye is caused by a camera’s
flash reflecting off the retinas of a subject’s eyes, and it can occur with both
humans and pets.

iPhoto can remove that red-eye and turn frightening zombies back into your
family and friends! Click the Red-Eye button, and then select a demonized
eyeball by clicking in the center of it. To complete the process, click the X in
the button that appears in the image.

Retouching like the stars

iPhoto’s Retouch feature is perfect for removing minor flecks or lines in an
image (especially those you've scanned from prints). Click Retouch, and
you'll notice that the mouse cursor turns into a crosshair — just drag the
cursor across the imperfection. Like the Enhance feature, you can compare
the retouched and the original versions of the image by holding down and
releasing the Control key.

Switching to black-and-white or sepia

Ever wonder whether a particular photo in your library would look better as
a black-and-white (or grayscale) print? Or perhaps an old-fashioned sepia
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tone in shades of copper and brown? Just click the Effects button to convert
an image from color to shades of gray or brown, respectively.

Adjusting brightness and contrast manually

Click Adjust to perform manual adjustments on brightness and contrast (the
light levels in your image). To adjust the brightness and contrast, make sure
that nothing’s selected in the image, and then drag the Brightness/Contrast
sliders until the image looks the way that you want.

While you’re editing, you can use the Next and Previous buttons to move to
the next image in the current album (or back to the previous image).

Publishing Your Own Photo Book

\\3

Book mode unleashes what I think is probably the coolest feature of iPhoto:
the chance to design and print a high-quality bound photo book! After you
complete an album — all the images have been edited just the way you want,
and the album contains all the photos you want to include in your book —
iPhoto can send your images as data over the Internet to a company that will
print and bind your finished book for you. (No, they don’t publish For Dummies
titles, but then again, I don’t get high-resolution color plates in most of my
books, either.)

At the time of this writing, you can order many different sizes and bindings,
including an 8.5-by-11-inch softcover book with 20 single-sided pages for
about $20 and a hardbound 8.5-by-11-inch keepsake album with 10 double-
sided pages for about $30 (shipping included for both). Extra pages can be
added at $0.70 and $1.00 a pop, respectively.

iPhoto 6 can also produce and automatically order calendars and greeting
cards, using a process similar to the one I describe in this section for produc-
ing a book. Who needs that stationery store in the mall anymore?

If you're going to create a photo book, make sure to use only the best quality
images with the highest resolution. The higher the resolution, the better the
photos will look in the finished book. I always try to use images of more than
1000 pixels in both the vertical and horizontal dimensions.

To create a photo book, follow these steps:

1. Click the desired album in the source list to select it.
2. Click the Book toolbar button.
3. Select the size of the book and a theme.

Your choices determine the number of pages and layout scheme, as well
as the background graphics for each page.
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Figure 12-6:
Preparing
to publish

my own
coffee-table
masterpiece.

4. Click Choose Theme.

iPhoto displays a dialog box asking whether you want to lay out your
photos manually or allow iPhoto to do everything automatically. Automatic
mode is fine, but I'm a thorough guy, so we’ll lay out this book manually.

5. Click Manually to display the controls you see in Figure 12-6.

In Book mode, the viewer changes in subtle ways. It displays the current
page at the bottom of the display and adds a scrolling row of thumbnail
images above it. This row of images represents the remaining images
from the selected album that you can add to your book. You can drag
any image thumbnail into one of the photo placeholders to add it to

the page. You can also click the Page button at the left of the thumbnail
strip — it looks like a page with a turned-down corner — to display
thumbnails of each page in your book. (To return to the album image
strip, click the Photos button under the Page button.)
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| really need a slideshow

You can use iPhoto to create slideshows! Click
the album you want to display and then click the
Slideshow button in the toolbar; you’ll notice
thatiPhoto adds a Slideshow item in the source
list. The same scrolling thumbnail strip appears
at the top of the viewer — this time displaying
the images in the album. Click and drag the
thumbnails so that they appear in the desired
order.

To choose a background music for your
slideshow, click the Music button on the
Slideshow toolbar to display the tracks from
your iTunes library. Drag the individual songs
you want to the song list at the bottom of the
sheet — you can drag them to rearrange their
order in the list as well. Click OK to accept your
song list.

To configure your slideshow, click the Settings
button on the Slideshow toolbar. In the sheet
that appears, you can specify the amount of
time that each slide remains on the screen, as
well as an optional title and rating displays. |
can recommend the Automatic Ken Burns

effect— yep, the same one in iMovie — which
lends an animated movement to each image.
Widescreen laptop owners will appreciate the
Slideshow Format pop-up menu, which allows
you to choose a 16:9 widescreen display for
your slideshow.

Click the Adjust button to modify the settings for
a specific slide (useful for keeping a slide
onscreen for a longer period of time or for set-
ting a different transition than the default tran-
sition you choose from the Slideshow toolbar).

To display a preview of a single slide and its
transitions, click the desired slide and then click
Preview; this is a handy way of determining
whether your delay and transition settings are
really what you want for a particular slide.
When you're ready to play your slideshow, click
the Play button, and iPhoto switches to full-
screen mode. You can share your completed
slideshow by clicking Share in the iPhoto menu,
where you can send the slideshow to iDVD (for
later burning onto a DVD), export it as a
QuickTime movie, or send it through e-mail.

6. Rearrange the page order to suit you by dragging the thumbnail of
any page from one location to another in the strip.

7. On the Book toolbar below the page view, you can adjust a variety of
settings for the final book, including the book’s theme, page numbers,

and comments.

At this point, you can also add captions and short descriptions to the
pages of your photo album. Click any one of the text boxes in the page
display and begin typing to add text to that page.

8. When you’re ready to publish your book, click the Buy Book button.

9. In a series of dialog boxes that appear, iPhoto guides you through the
final steps to order a bound book.

Note that you’ll be asked for credit card information
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I wouldn’t attempt to order a book using a dialup modem connection. The
images are likely far too large to be sent successfully. If possible, use a broad-
band or network connection to the Internet while you're ordering. If your only
connection to the Internet is through a dialup modem, I recommend saving
your book in PDF format and having it printed at a copy shop or printing ser-
vice instead. (Choose File>Print, and then click the Save as PDF button.)

Photocasting for the People!

\\s

Figure 12-7:
Treat others
to your
soccer
photos,
automati-
cally!
|

iPhoto 6 introduces a new feature called phofocasting that does for images
what podcasting does for audio: You can share your photos with friends,
family, business clients, and anyone else with an Internet connection! (Your
adoring public doesn’t even require a Mac; they can use That Other Kind of
Computer.) However, you must be a .Mac subscriber to photocast albums to
others — if you haven’t heard the news on Apple’s .Mac service yet, see
Chapter 9 for the details.

Here’s how photocasting works: You designate an album to share by selecting
it in the source list and then clicking the Photocast button on the iPhoto tool-
bar. iPhoto displays the Publish a Photocast sheet, as shown in Figure 12-7.

If the Photocast button doesn’t appear on your toolbar, it’s because there’s
not enough room on the toolbar at your current screen resolution! Click the
double-right arrow button (>>) to display the remaining toolbar buttons.
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Specify the size of the images you want to offer (full size is highest quality,
natch, but also takes the longest time to upload and download). By default,
any changes you make to the contents of this album are automatically updated
on your .Mac account and, in turn, are updated automatically to everyone who
receives your images. You can turn this feature off, however, if you have a large
number of images and you update often (which can result in your sister’s com-
puter downloading a lot of data).

< Prefer a little security for those images? In that case, you can require that

your photocast audience enter a login name and password before they can

receive your photos.

Click Publish, and you’ll see that iPhoto indicates, with a cool twirling
progress icon to the right of the album in the source list, that your images are
being uploaded. When the process is complete, iPhoto indicates, with a spe-
cial networky-looking icon to the right of the album, that the album is being
photocasted. You're on the air!

Now for the other side of the coin: By clicking Announce Album on the iPhoto
toolbar, iPhoto automatically prepares an e-mail message in Apple Mail that
announces your new photocast! Just add the recipient names and click Send.
This spiffy message includes complete photocast subscription instructions for

v Folks using iPhoto 6 on a Mac: As you can imagine, this is the easiest
receive option to configure. After these folks are subscribed, they get an
automatically updated album of the same name that appears in their
source list, and they can use those images in their own iPhoto projects!

v Folks using Windows or an older version of iPhoto: These subscribers
can use any Web browser with RSS support (like the Safari browser that
comes with Tiger) or any RSS reader. (In effect, your photocast becomes
an RSS feed for those without iPhoto 6.)

Mailing Photos to Aunt Mildred

iPhoto can help you send your images through e-mail by automating the
process. The application can prepare your image and embed it automatically
in a new message.

To send an image through e-mail, select it and then click the Email button in
the toolbar. The dialog box shown in Figure 12-8 appears, allowing you to
choose the size of the images and whether you want to include their titles
and comments as well.
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Keep in mind that most ISP (Internet service provider) e-mail servers won’t
accept an e-mail message that’s more than 1MB or 2MB, so watch that Size
display. If you're trying to send a number of images and the size goes over
2MB, you might have to click the Size drop-down list and choose a smaller
size (reducing the image resolution) to get them all embedded in a single
message.

When you’re satisfied with the total file size and you’re ready to create your
message, click the Compose button. iPhoto automatically launches Apple
Mail (or whatever e-mail application you specify) and creates a new message
containing the images, ready for you to click Send!



Chapter 13

Making Film History
with iMovie HD

In This Chapter
Taking stock of the iMovie HD window
Importing and adding media content
Using transitions in your movie
Working with visual effects
Putting text titles to work
Using Magic iMovie to create movies automatically

Sharing your movie with others

Remember those home movies that kids used to make in high school?
They were entertaining and fun to create, and your friends were
impressed. In fact, some kids are so downright inspired that you’re not sur-
prised when you discover at your high school reunion that they became
graphic artists or are involved in video or TV production.

iMovie HD 6, part of the iLife 06 suite, makes moviemaking as easy as filming
those homemade movies. Apple has simplified all the technical stuff, such as
importing video and adding audio, so you can concentrate on your creative
ideas. In fact, you won't find techie terms like codecs or keyframes in this chap-
ter. I guarantee that you’ll understand what’s going on at all times. (How often
do you get a promise like that with video editing software?)

With iMovie HD, your digital video (DV) camcorder, and the other parts of the
iLife suite, you can soon produce and share professional-looking movies, with
some of the same creative effects and transitions used by those Hollywood

types.

If you turn out to be a world-famous Hollywood-type director in a decade or
so, don’t forget the little people along the way!
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Shaking Hands with the
iMovie HD Window
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Figure 13-1:
You'll see
this when

you launch
iMovie HD

for the first

time.
|

If you've ever tried a professional-level video editing application, you proba-
bly felt like you were suddenly dropped in the cockpit of a jumbo jet. In
iMovie HD, though, all the controls you need are easy to use and logically
placed.

Video editing takes up quite a bit of desktop space. In fact, you can’t run
iMovie HD at resolutions less than 1024 x 768, nor would you want to.

To launch iMovie HD, click the iMovie HD icon on the dock. (It looks like a
director’s clapboard.) You can also click the Application folder in any Finder
window sidebar and then double-click the iMovie HD icon.

When you first launch iMovie HD, the application displays a top-level dialog
box, as shown in Figure 13-1. From here, you can create a new iMovie HD
project, open an existing project, or let iMovie HD do things automatically
through Magic iMovie. (I cover Magic iMovie later in the section, “Doing
iMovie Things iMagically.”)

To follow the examples I show you here, follow these strenuous steps:

1. Click the Create a New Project button.

2. When iMovie HD prompts you to type a name for your project, do so.
3. Click Create.

You’re on your way! Check out Figure 13-2: This is the whole enchilada,
in one window.

iMovie HD

| 22
| * Create a New Project
=

| \f;ﬁr | Open an Existing Project

| & | Make a Magic iMovie

(7) Caue )
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The controls and displays that you’ll use most often follow:

v Monitor: Think of this just like your TV or computer monitor. Your video
clips, still images, and finished movie play here.

v Tools palette: This row of buttons allows you to switch between your
media clips (video clips, photos, and audio) and the various tools that
you use to make your film. For example, Figure 13-2 illustrates the Clips
pane, which appears when you click the Clips button (go figure).

Hint: All the video clips that you use to create your movie are stored in
the Clips pane. | show you what each of the panes in the Tools palette
looks like as you tackle different tasks in this chapter.

v Clips/timeline viewer: iMovie HD switches between two views — the
clips viewer and the timeline viewer — and I cover ’em both later in this
chapter. The buttons that you use to toggle between the two views are
labeled in Figure 13-2, which is displaying the clips viewer.
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v Playhead: The vertical line that you see in the viewer is the playhead,
which indicates the current editing point while you’re creating your
movie. When you're playing your movie, the playhead moves to follow
your progress through the movie.

v Scrubber bar: This bar makes it easy to crop, trim, or split a selected
clip. The entire length of a clip that you select is covered by the scrub-
ber bar, so you can drag the playback handle at the top of the bar to
quickly move through the clip.

v~ Playback controls: If these look familiar, it’s no accident: These controls
are used to play your movie (in window and full-screen mode) and to
return the playhead to the beginning of the movie. A different set of con-
trols appears when you import digital video from your DV camcorder.

v Import/editing switch: Click this switch to toggle between importing DV
clips from your DV camcorder and editing your movie.

Those are the major highlights of the iMovie HD window. A director’s chair
and megaphone are optional, of course, but they do add to the mood.

A Bird’s-Eye View of Moviemaking

[ don’t want to box in your creative skills here — after all, you can attack the
moviemaking process from a number of angles. (Pun unfortunately intended.)
However, I've found that my movies turn out the best when I follow a linear
process, so before I dive into specifics, allow me to provide you with an
overview of moviemaking with iMovie HD.

Here’s my take on the process, reduced to seven steps:
1. Import your video clips either directly from your DV camcorder or

from your hard drive.

2. Drag your new selection of clips from the Clips pane to the viewer and
arrange them in the desired order.

3. Import or record audio clips (from iTunes, GarageBand, or external
sources such as audio CDs or audio files you’ve recorded yourself)
and add them to your movie.

4. Import your photos (directly from iPhoto or from your hard drive)
and place them where needed in your movie.

5. Add professional niceties such as audio, transitions, effects, and text
to the project.
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6. Preview your film and edit it further if necessary.

7. Share your finished film with others through the Web, e-mail, or a
DVD that you create and burn with iDVD 6. (Read all about iDVD 6 in
Chapter 14.)

That’s the first step-by-step procedure in this chapter. I doubt that you’ll even
need to refer back to it, however, because you’ll soon see just how easy it is
to use iMovie HD.

Importing the Building Blocks

Sure, you need video clips to create a movie of your own, but don’t panic if
you have but a short supply. You can certainly turn to the other iLife applica-
tions for additional raw material. (See, I told you that integration thing would
come in handy.)

Along with video clips you import from your DV camcorder, iSight camera,
and hard drive, you can also call on iPhoto for still images (think credits) and
iTunes for background audio and effects. In this section, [ show you how.

Pulling in video clips

Your Mac laptop is already equipped with the two extras that come in handy
for video editing: namely, a large hard drive and a FireWire port. Because vir-
tually all DV camcorders today use a FireWire connection to transfer clips,
you’re all set. (And even if your snazzy new DV camcorder uses a USB 2.0
connection, you're still in the zone!) Here’s the drill if your clips are on your
DV camcorder:

1. Plug the proper cable into your laptop.
\\3 2. Set the DV camcorder to VIR (or VCR) mode.
Some camcorders call this Play mode.

3. Slide the import/editing switch (labeled in Figure 13-2) to the left.

The playback controls under the monitor change subtly, now mirroring
the controls on your DV camcorder. This allows you to control the unit
from iMovie HD. Keen! You also get an Import button as a bonus.

4. Locate the section of video that you want to import by using the play-
back controls.
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5. Click Stop and then rewind to a spot a few seconds before the good
stuff.

6. Click the Play button again (this may not be necessary on all cameras).
7. Click the Import button at the bottom of the monitor.
iMovie HD begins transferring the footage to your laptop.

8. When the desired footage is over, click the Import button again to
stop the transfer.

iMovie HD automatically adds the imported clip to your Clips pane.

9. Click Stop to end the playback and admire your handiwork.
\J
P If your clips are already on your hard drive, rest assured that iMovie HD can

import them, including those in high-definition video (HDV) format. iMovie HD
also recognizes a number of other video formats, as shown in Table 13-1.

Table 13-1 Video Formats Supported by iMovie HD

File Type Description

DV Standard digital video

iSight Live video from your laptop’s iSight camera

HDV High-definition (popularly called widescreen) digital video

MPEG-4 A popular format for streaming Internet and wireless digi-
tal video

To import a video file, follow this bouncing ball:

1. Click the Clips button on the Tools palette to display the Clips pane.
2. Choose Filec>Import.
3. Double-click the clip to add it to the Clips pane.

Alternatively, you can also drag a video clip from a Finder window and
drop it in the Clips pane.

Making use of still images

Still images come in handy as impressive-looking titles or as ending credits
to your movie. (Make sure you list a gaffer and a best boy to be truly profes-
sional.) However, you can use still images also to introduce scenes or to
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Figure 13-3:
Pulling still
images from
iPhoto is
child’s play.
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separate clips according to your whim. For example, I use stills when delin-
eating the days of a vacation within a movie or different Christmas celebra-
tions over time.

Here are two methods of adding stills to your movie:

v Adding images from iPhoto: Click the Media button in the Tools palette
and then click the Photos button, and you’ll experience the thrill that is
your iPhoto library, right from iMovie HD (as shown in Figure 13-3). You
can elect to display your entire iPhoto library or more selective picks
like specific albums or film rolls. When you find the image you want to
add, just drag it to the right spot in the viewer.

v+ Importing images from your hard drive: Choose File=Import to add
images in any format supported by iPhoto: TIFF, JPEG, GIF, PICT, PNG,
and PSD. These images show up in the Clips pane, and you can drag
them to the viewer just as if they were video clips. If you're a member of
the International Drag-and-Drop society, you can drag images directly
from a Finder window and drop them into the viewer as well.

@ iMovieHD File Edit View Markers Share Advanced Window Help S 9 & o+ ™ o4 Thullozam @

8.ne '+ My Great Example (DV-NTSC)

Audio || Photos

v g iPhata
T Library
F Last Rol

B Last 12 Months
W Mark’s Favorite Shats

| .
Wl FLAME Photos

Fracture 4 (Man . Fracture § (lam . Fracture b (e

Q 87 items

Show Photo Settings )

= - @ (wall p (9} B — ] Clips  Thomes | Madia | Editing | Chaptars |
f

Drag photos here to build your project,

R | =

467 CHavallable [ 08 |

w04 - O Clip: 11 Tas

197



198

Figure 13-4:
Calling on
my iTunes

library to
add Dinah

Washington

to my
iMovie.
|
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Importing and adding audio
from all sorts of places

You can pull in everything from Wagner to Weezer as both background music
and sound effects for your movie. In this section, [ focus on how to get those
notes into iMovie HD and then how to add them to your movie by dragging
them to the timeline viewer.

You can add audio from a number of sources:

v Adding songs from iTunes: Click the Audio button at the top of the Media
pane to display the contents of your iTunes library. In the scrolling list
box, click the desired playlist, such as the Dinah Washington playlist I
selected in Figure 13-4. (If you've exported any original music you’'ve com-
posed in GarageBand to your iTunes Library, you can use those songs in
your own movie!) You can add a track at the current location of the play-
head in the timeline viewer by clicking the song to select it and then click-
ing the Place at Playhead button.
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v Adding sound effects: Yep, if you need the sound of a horse galloping
for your Rocky Mountain vacation clips, click either Standard Sound
Effects or Skywalker Sound Effects in the scrolling list box. iMovie HD
includes a number of top-shelf audio effects from Skywalker Studios that
you can use in the second audio track on the timeline viewer. This way,
you can add sound effects even when you’ve already added a back-
ground song. Again, to add a sound effect at the current location of the
playhead in the timeline viewer, click the effect to select it and then click
Place at Playhead.

If you have several gigabytes of music in your iTunes library, it might be
more of a challenge to locate “Me and Bobby McGee” by Janis Joplin,
especially if she’s included in a compilation. Let your Mac do the digging
for you! Click in the Search box below the track list and begin typing a
song name. iMovie HD narrows down the song titles displayed to those
that match the characters you type. To reset the search box and display
all your songs in the library or selected playlist, click the X icon that
appears to the right of the box.

+ Ripping songs from an audio CD: Load an audio CD and then choose
Audio CD from the scrolling list box. iMovie HD displays the tracks from
the CD, and you can add them at the current playhead position the same
way as iTunes songs.

1 Recording directly from a microphone: Yep, if you're thinking voice-
over narration, you’ve hit the nail on the head. Check out the “Narration
the easy way” sidebar for the scoop.

v+ Importing audio from your hard drive: Choose File>Import to import
digital audio in any format recognized by QuickTime. The big players are
MP3, AAC, Apple Lossless, WAV, and AIFF. The audio you import is
inserted in the viewer at the current playhead location. Of course, you're
also welcome to drag audio files from a Finder window and drop them
into the viewer.

iMovie HD displays all the audio for your movie in two tracks in the timeline
viewer, so you won't see your audio in the clips viewer.

With the arrival of iMovie HD 6, you can fine-tune the audio that you add to
your project. With the desired audio track selected, click the Editing button
in the Tools palette, and then click the Audio FX button. You'll see an array
of audio controls that allow you to reduce the ambient noise in an audio
track, apply the reverb effect you’'d expect in a cathedral or an arena, and
even apply precise changes with a graphic equalizer! To hear what the
audio sounds like with the effect applied, click Preview — if you like what
you hear, click Apply.
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Narration the easy way

Ready to create that award-winning nature 5. Click the Play button in the monitor play-

documentary? You can add voice-over narration back controls.

:[Jo VRO L DRSS TRl . 6. Click the Record button in the Audio pane.
acques Cousteau proud. In fact, you can

record your voice as you watch your movie You can monitor the volume level of your

playing, allowing perfect synchronization with voice with the Microphone meter.

o . :
the action! To add narration, follow these steps: 7. Watch the video while you narrate, so that

1. If you're not already using the timeline you can coordinate your narration track
viewer, click the clips viewer/timeline with the action.

UIDUEIEUE 8. Click Stop in the Audio pane.
2. Drag the playhead in the timeline viewer to

the point where the narration should begin. [FETE (D) ECEIS Yo REBien ELeiD m e

timeline viewer. If you need to try again,
3. Click the Media button on the Tools palette. press Delete to remove the audio clip and

4. Click the Audio button. repeat the steps.

Building the Cinematic Basics

Time to dive in and add the building blocks to create your movie. Along with
video clips, audio tracks, and still images, you can add Hollywood-quality
transitions, optical effects, and animated text titles. In this section, I demon-
strate how to elevate your collection of video clips into a real-life furshlug-
giner movie.

Adding clips to your movie

You can add clips to your movie using the clip viewer or the timeline viewer.
The Dynamic Duo work like this:

v Clip viewer: This displays your clips and still images. Each clip that you
add occupies the same space. This is a great view for rearranging the
clips and still images in your movie.

v Timeline viewer: This displays clips with relative sizes. The length of
each clip in the timeline viewer is relative to the duration of the scene.
(In plain English, a 60-second clip that you add to the timeline viewer
appears half the length of a 120-second clip.)
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To add a clip to your movie

1. Click the Clips button on the Tools palette to display the Clips pane.

2. Drag the desired clip from the Clips pane to the spot where it belongs
in either viewer.

Do this several times, and you have a movie, just like the editors of old used
to do with actual film clips. This is a good point to mention a moviemaking
Mark’s Maxim:

Preview your work — and do it often.

Use the View Fullscreen playback button under the monitor to watch your
project while you add content. If you've ever watched directors at work on
today’s movie sets, they're constantly watching a monitor to see what things
will look like for the audience. You have the same option in iMovie HD!

Removing clips from your movie
Don’t like a clip? Bah. To banish a clip from your movie:

1. Click the clip in the viewer to select it.
2. Press Delete.

The clip disappears, and iMovie HD automatically rearranges the
remaining clips and still images in your movie.

If you remove the wrong clip, don’t panic. Instead, use iMovie HD’s Undo fea-
ture (press 38+7Z) to restore it.

Deleting clips for good

iMovie HD has its own separate trash system (different from Mac OS X trash).
It’s located at the bottom of the application window. If you decide that you
don’t need a clip or still image and you want to delete it from your iMovie HD
project completely, drag the media item from either the Clips pane or from
either viewer and drop it on top of the Trash icon. (Note that deleting a clip
or still image from iMovie HD does not delete it from your hard drive.)

To delete the contents of the iMovie HD trash, choose File>Empty Trash. To
display the contents of the iMovie HD trash, click the Trash icon; to retrieve
an item that you suddenly decide you still need, drag the item back into the
viewer.
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Reordering clips in your movie

If Day One of your vacation appears after Day Two, you can easily reorder
your clips and stills by dragging them to the proper space in the clip viewer.
When you release the mouse, iMovie HD automatically moves the rest of your
movie aside with a minimum of fuss and bother.

\\J

Editing clips in iMovie HD
If a clip has extra seconds of footage at the beginning or end, you don’t want
that superfluous stuff in your masterpiece. Our favorite video editor gives
you the following functions:

v Crop: Deletes everything from the clip except a selected region

v Split: Breaks a single clip into multiple clips

v Trim: Deletes a selected region from the clip
Before you can edit, however, you have to select a section of a clip:

1. Click a clip in the Clips pane to display it in the monitor.

2. Drag the playback head on the scrubber bar (that blue bar below the
monitor) to the beginning of the section that you want to select.

3. Shift-click anywhere on the scrubber bar to the right of the starting
point.
The selected region turns yellow when you select it. You're ready to edit
that selected part of the clip.

\\J
Note the handles that appear at the beginning or ending of the selection. You
can make fine changes to the selected section by dragging them.

v To crop: Choose Edit~>Crop. Everything but the selected region is
removed.

v To split: Choose Edit=>Split Video Clip at Playhead. The clip is divided
into two clips.

v To trim: Choose Edite>Clear. The selected section disappears.
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Adding transitions

Many iMovie HD owners approach transitions as visual bookends: They merely
act as placeholders that appear between video clips. Nothing could be further
from the truth because judicious use of transitions can make or break a scene.
For example, which would you prefer after a wedding ceremony — an abrupt,
jarring cut to the reception or a gradual fadeout to the reception?

Today’s audiences are sensitive to transitions between scenes. Try not to
overuse the same transition. Also weigh the visual impact of a transition
carefully.

iMovie HD includes a surprising array of transitions, including old favorites
(such as Fade In and Dissolve) and some nifty stuff you may not be familiar
with (such as Billow and Disintegrate). To display your transition collection,
click the Editing button on the Tools palette and then click the Transitions
button in the upper right of the screen, as shown in Figure 13-5.

@ iMovieHD File Edit View Markers Share Advanced Window Help S % o~ W4 Thullosam @
f|ana +| My Great Example (DV-NTSC)

Titles | @nstonsl Video FX | Ausdic X

] Bl

[ Circle: Ciosing
[ Cirtle Opening
B Cross Dissalve
B isinzegeare
[Elfade 1

7 fade Out

Bl Cverlap

B rush

B Ragiat
Hrippie

[ scale Down
[l wars 0wt

B wash 1
Ewash Out

" -
¥ Speed: e——y 1000

- @ < i 3 - —————} 4§ | Clips | Themes | Mocia |CEditing] Chapiers |
Y R R R T S T SR I e TR |
L ] = v
=i | a3 .
| cl
]
ime——— o el 0:08:04 totat duration Ansciavatanle (/2048 | o

Scrubber bar



204 Ppartv: Living the iLife

To see what a particular transition looks like, click it in the list to display the
transition in the monitor. (If things move too fast, slow down the preview
with the speed slider, which appears at the bottom of the Transition list.)

Adding a transition couldn’t be easier: Drag the transition from the list in

the Transitions pane and drop it between clips or between a clip and a still
image. In iMovie HD 6, transitions are usually applied in real time — however,
if you're working with an older laptop, the transition may take a few seconds
to render. (If rendering time is required, iMovie HD displays a red progress
bar in the viewer to indicate how much longer rendering will take.)

Oh, we got effects!

iMovie HD offers a number of fun visual effects that you can add to your
clips and stills. These aren’t the full-blown visual effects of the latest
science-fiction blockbuster, but then again, your movie already stars
Uncle Humphrey, and most people would consider him a special effect.

For example, to immediately change a clip (or your entire movie) into an old
classic, you can choose the Aged Film or Sepia effect to add that antique
look.

To view the effects, click the Editing button on the Tools palette, and then click
the Video FX button at the top of the screen. Click an effect from the list in the
pane (see Figure 13-6) to display the options you can customize for that partic-
ular effect. The settings you can change vary for each effect, but most include
the Effect In and Effect Out sliders, which allow you to gradually add an effect
over a certain amount of time from the beginning of the clip and then phase it
out before the clip ends. When you make a change to the settings, you see the
result in the monitor window.

To add an effect to a clip or still image in the timeline viewer:

1. Click the clip or image to select it.
The selection turns blue.
2. Click the desired effect.
3. Make any necessary adjustments to the settings for the effect.
4. When everything looks perfect, click Apply.

Like transitions, effects take a few seconds to render. The faster your laptop,
the shorter the time. Such is the life of a techno-wizard.
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What's a masterpiece without titles?

The last stop on our iMovie HD Hollywood Features Tour is the Titles pane.
You'll find it by clicking the Editing button, as shown in Figure 13-7. You can
add a title with a still image, but iMovie HD also includes everything you need
to add basic animated text to your movie.

Most of the controls you can adjust are the same for each animation style.
You can change the speed of the animation, the font, the size of the text, and
the color of the text. You can even add an optional black background, but
doing so actually inserts a new clip into your movie to show the text, which
may affect the timing of your sound effects or narration.

To add a title

1. Select an animation style from the list.

2. Type one or two lines of text in the text boxes at the bottom of the
Titles pane.
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|
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3. Make any changes to the settings specific to the animation style.

i ——————— o ciipeos (4]
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iMovie HD displays a preview of the effect in the monitor with the set-
tings that you choose.

4. Drag the animation style from the list to the timeline.

The title appears in the timeline viewer as a clip.

Doing iMovie Things iMagically

iMovie HD makes things just about as easy as can be with Magic iMovie,
which you can use to create your movie automatically from the settings you
choose from just one dialog box. (I know, it sounds like a corny name, but the
feature is truly cool.) If you're in a hurry or you want to produce something
immediately after an event (and you can do without the creative extras that I
discuss earlier in this chapter), a Magic iMovie is the perfect option.

In fact, the close integration of iMovie HD and iDVD 6 can automate the
process of downloading video from your DV camcorder and producing a
finished DVD. As you can read in Chapter 14, iDVD has a similar feature
called OneStep DVD that can create a DVD video from your Magic iMovie!
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Follow these steps to let iMovie HD take care of moviemaking automatically:

1. Connect your DV camcorder to your laptop using a FireWire cable.
2. Turn the camcorder on.
3. Set it to VCR (or VIR) mode.
4. Launch iMovie HD, then:
e [fyou see the opening top-level dialog box, click Make a Magic iMovie.

e [f you had a project open and that project appears instead, choose
Filec>Make a Magic iMovie.

5. Type a project name and choose a location.
6. Choose a video format.

Typically, you’ll want to use DV, DV widescreen, or the proper HDV reso-
lution format. (Of course, there’s always the iSight format, if your laptop
has a built-in iSight camera.)

7. Click Create.
iMovie HD displays the Magic iMovie dialog box.
8. In the Movie Title box, type a name for your movie.

9. If your tape needs to be rewound before the capture starts, select the
Rewind the Tape before Capturing the Movie check box.

10. If you want transitions between scenes, select the Use Transitions check
box, and then choose the transition you want from the pop-up menu.

11. If you want a soundtrack, select the Play a Music Soundtrack check
box, and then click the Choose Music button to browse your iTunes
music library or to select an audio CD that you’ve loaded.

12. Select the Send to iDVD check box.

This ships your finished movie directly to iDVD, which launches
automatically.

13. Click Create.

Sharing Your Finished Classic
with Others

Your movie is complete, you've saved it to your hard drive, and now you're
wondering where to go from here. Click Share on the application menu bar,
and you’ll see that iMovie HD can unleash your movie upon your unsuspect-
ing family and friends (and even the entire world) in a number of ways:
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v E-mail: Send your movie to others as an e-mail attachment. iMovie HD
even launches Apple’s Mail application automatically!

v iWeb: Share your movie with the world at large by using it with iWeb and
posting it on your .Mac Web site. (I provide more .Mac details to chew
on in Chapter 9.)

v Videocamera: Transfer your finished movie back to your DV camcorder.

v iPod: Truly the option to choose if you'd like to watch your movie on an
iPod with video support.

v GarageBand: Export your movie to GarageBand, where it can be added
to a podcast for that truly professional look.

v iDVD: iMovie HD can export your movie into an iDVD project, where you
can use it to create a DVD video.

v QuickTime: Any computer with an installed copy of QuickTime can dis-
play your movies, and you can use QuickTime movies in Keynote pre-
sentations as well.

v Bluetooth: If you have Bluetooth hardware installed on your laptop, you
can transfer your movie to a Bluetooth device.

When you choose a sharing option, iMovie HD displays the video quality

for the option. If you decide to send your movie through e-mail, for example,
it’s reduced as far as possible in file size, and the audio is reduced to mono
instead of stereo. The Videocamera and Bluetooth options give you onscreen
instructions for readying the target device to receive your movie.

If you’re worried about permanently reducing the quality of your project

by sharing it through e-mail or your .Mac Web site, fear not! When you choose
a sharing option to export your movie, your original project remains on your
hard drive, unchanged, so you can share a better quality version at any time
in the future!

After you adjust any settings specific to the desired sharing option, click
Share to start the ball rolling.
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Creating DVDs on the
Road with iDVD

In This Chapter

Traversing the iDVD window

Starting an iDVD project

Tweaking and adjusting your DVD Menu

Previewing your (nearly) finished DVD

Doing things automatically with OneStep DVD and Magic iDVD
Burning your finished masterpiece

How does the adage go? Oh, yes, it’s like this:

Any DVD movie must be a pain to create. You'll need a ton of money for
software, too. And you’ll need hours of training that will cause your brain
to explode.

Funny thing is, DVD authoring — the process of designing and creating a DVD
movie — really was like that for many years. Only video professionals could
afford the software and tackle the training needed to master the intricacies
of DVD Menu design.

Take one guess as to the company that changed all that. Apple’s introduction
of iDVD was a revolution in DVD authoring. Suddenly you, your kids, and Aunt
Harriet could all design and burn DVDs with movies and picture slideshows.
Dear reader, this iDVD thing is huge.

Plus, you’ll quickly find out that iDVD 6 is tightly connected to all the other
slices of your digital hub — in plain English, you can pull content from
iTunes, iPhoto, and iMovie HD as easily as a politician makes promises.
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In this chapter, I show you how your Mac laptop can take on Hollywood as
well as how you can produce a DVD movie with content that’s as good as any
you’d rent at the video store!

Introducing Vou and Your
Laptop to iDVD

Figure 14-1 shows the whole “kit and kaboodle.” (Okay, Mark, drop it.) The
iDVD 6 window was designed by the same smart people who brought you
the iMovie HD window. You have to supply your own digital video clips,
background audio, and digital photographs, of course.

Menu display

DVD  File Edit Project View Advagced Window
—

Figure 14-1:
iDVD6is a
jewel of an
application
—easyto

use and
powerful to

boot.
|

Media pane

Preview
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Take a moment to appreciate iDVD — no secondary windows to fiddle with or
silly palettes strung out everywhere. (Can you tell that I've had my fill of old-
style DVD authoring applications?) Allow me to list the highlights of the iDVD
window:

»* Menu display: This section takes up the largest part of the iDVD window,
with good reason. You create your project here. In this case, Menu refers
to your DVD Menu, not the menu at the top of your laptop’s display.

1 Media pane: You add video, still images, and audio to your project from
here, as well as tweak and fine-tune things. The Media pane actually
comprises four separate panes. To choose a new pane, click one of these
buttons at the bottom of the screen:

e Themes: You apply themes (such as Travel Cards, Wedding White,
and Baby Mobile) to your DVD Menu to give it a certain look and
feel.

e Menu: From here, you can change the look of the menus displayed
by your project by editing text and drop zones.

® Buttons: These options apply to the item currently selected, such
as drop shadows on your text titles or the appearance of your
menu buttons.

e Media: From here, you can add media items, such as video clips
and photos, to your menu.

v Add button: From this drop-down list (which sports a dapper plus sign),
you can choose one of three types of buttons to add to a project. The
choices are

¢ Add Submenu: Choose this item to add a new submenu button to
your DVD Menu. The person using your DVD Menu can click a
button to display a new submenu that can include additional
movies or slideshows. (If that sounds like ancient Greek, hang on.
All becomes clearer later in the chapter in the section, “Adding
movies.”

&,\‘I\BER In iDVD 6, a Menu can hold only 12 buttons, so submenus let you
S pack more content on your DVD. (Older versions of the application
only allowed 6 buttons, so don’t feel too cheated.) Anyway, each
submenu you create can hold another 12 buttons.

e Add Movie: Yep, this is the most popular button in the whole shoot-
ing match. Click this menu item to add a new movie clip to your
menu.

e Add Slideshow: If you want to add a slideshow to your DVD — say,
using photos from your hard drive or pictures from your iPhoto
library — click this menu item.
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v Motion: Click this button to watch the animation cycle used with the
current iDVD theme. Note that the animation playhead (the movie’s time-
line marker) moves below the Menu display to indicate where you are in
the animation cycle. Like other playheads in the iLife suite, you can
click-and-drag the diamond-shaped playhead button to move anywhere
in the animation cycle. The animation repeats (just as it will on your fin-
ished DVD) until you click the Motion button again.

v DVD Map: Click the Map button to display the organizational chart for
your DVD Menu. Each button and submenu that you add to your top-
level DVD Menu is displayed here, and you can jump directly to a partic-
ular item by double-clicking it. Use this road map to help design the
layout of your DVD Menu system or to get to a particular item quickly.
To return to the Menu display, click the Map button again.

v Preview: To see how your DVD Menu project looks when burned to a
DVD, click Preview. You get a truly nifty onscreen remote control that
you can use to navigate your DVD Menu, just as if you were watching
your DVD on a standard DVD player. To exit Preview mode, click the
Stop button on the remote control. Read more about this control in the
upcoming section, “Previewing Your Masterpiece.”

v Burn: Oh, yeah, you know what this one is for — recording your com-
pleted DVD movie to a blank disc.

That’s the lot! Time to get down to the step-by-step business of making movies.

Starting a New DUD Project

\\3

When you launch iDVD 6 for the first time (or if you close all iDVD windows),
you get the sporty menu shown in Figure 14-2. Let’s take a moment to dis-
cover more about these four choices.

Creating a new project

If you choose Create a New Project, iDVD prompts you to type a name for
your new DVD project and to set a location where the project files should be
saved. By default, the very reasonable choice is your Documents folder. You
also get to choose whether your project will display in a Standard (full
screen) aspect ratio of 4:3, or a Widescreen aspect ratio of 16:9. If you've
been watching DVD movies for some time, you recognize these two terms.

You'll probably crave Widescreen format if you have a widescreen TV — go
figure — but both formats will display on both types of televisions.

Click Create, and the iDVD window appears in all its glory.
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Figure 14-2:
Will that

be create

or edit,
manual or
automatic?
|

iDVD 6

——
333

| US|

Create a New Project

| \Ej | Open an Existing Project

_» |
‘ m | OneStep DVD

Magic iDVD

([ quit |

(7)

Opening an existing project

If you've used iDVD and had a DVD project open the last time you quit the
application, iDVD automatically loads the DVD project you were working on.
However, you can open any DVD you've created by clicking Open an Existing
Project. (To choose a different existing project from the iDVD window, press
8+0, or choose File>Open Recent.)

Automating the whole darn process

If you are a fan of click-it-and-forget-it (or are in a hurry), you can throw cau-
tion to the wind and allow iDVD to create your latest epic for you! iDVD offers
two automated methods of creating a DVD movie disc. One method has been
around since the last version of the application, and the other is brand new
with iDVD 6.

Using OneStep DVD

With OneStep, iDVD does most of the work automatically, using the media
clips and photos that you specify. To allow iDVD to help you create a movie,
click the OneStep DVD button on the top-level menu (refer to Figure 14-2). If
you’ve already opened a project, choose File=>OneStep DVD from the applica-
tion’s menu bar (to import clips directly from your camera) or OneStep DVD
from Movie (to select a clip to import from your hard drive).

I tell you more about the OneStep DVD feature later in the “A Word about
Automation” section.
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Using Magic iDVD

Magic iDVD is the newcomer on the block, and it falls neatly between total
automation (with OneStep DVD) and total manual control. Click the Magic
iDVD button on the top-level menu (as shown in Figure 14-2). If you've
already opened a project, you can choose Filec>Magic iDVD from the menu
bar to choose a theme, drop specific movies and photos into filmstrips, and
choose an audio track.

Unlike OneStep DVD, you get to preview the finished product. If it’s to your
liking, you can choose to either burn the disc directly or create a full-blown
iDVD project with the results. Sweet.

You'll find out more about the new Magic iDVD feature later in the “A Word
about Automation” section.

Creating a DVD from Scratch

Doing things the old-fashioned, creative, and manual way (following the
examples in this section) involves four basic steps:
1. Design the DVD Menu.
Choose a theme and any necessary buttons or links.
2. Add media.
iTunes.
3. Tweak.
Adjust and fine-tune your DVD Menu settings.
4. Finish things up.

Preview and burn your DVD, or save it to your hard drive.

Choosing just the right theme

The first step to take when manually designing a new DVD Menu system is to
add a theme. In the iDVD world, a theme is a preset package that helps deter-
mine the appearance and visual appeal of your DVD Menu, including a back-
ground image, menu animation, an audio track, and a group of settings for
text fonts and button styles.

iDVD helps those of us who are graphically challenged by including a wide
range of professionally designed themes for all sorts of occasions, ranging
from old standbys such as weddings, birthdays, and vacations to more
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Figure 14-3:
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new theme
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Themes
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generic themes with the accent on action, friendship, and technology. To
view the included themes, click the Themes button in the lower-right corner
of the iDVD window (see Figure 14-3).

To choose a theme for your project — or to see what a theme looks like on
your menu — click any thumbnail and watch iDVD update the Menu display.

If you decide while creating your DVD Menu that you need a different theme,
you can change themes at any time. iDVD won’t lose a single button or video
clip that you add to your DVD Menu. You'll be amazed at how the look and
sound of your DVD Menu completely changes with just the click of a theme
thumbnail.

Adding movies

Drop zones and themes are cool, but most folks want to add video to their
DVD. To accomplish this, iDVD uses buttons as links to your video clips. In
fact, some iDVD Movie buttons display a preview of the video they will dis-
play! To play the video on a DVD player, you select the Movie button with
the remote control, just like you do for a commercial DVD.
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Taking advantage of drop zones

Most of Apple’s animated themes include spe-
cial bordered areas marked as drop zones.
These locations have nothing to do with skydiv-
ing; rather, a drop zone is a placeholder in the
Menu that can hold a single video clip or photo-
graph. When you drag a video clip or an image
to a drop zone, that clip or picture is added to
the animation in Apple’s theme! Think about that
for a moment; | know | did. You can actually per-
sonalize a Hollywood-quality animated DVD
menu with your own photos and video!

Most of the themes included with iDVD 6
include at least one drop zone, and some are
practically jam-packed with drop zones. For
example, the amazing Baby Mobile theme has
a whopping six drop zones! If you think a menu
looks just fine without anything in a drop zone,
however, you don't have to put anything there.
The words Drop Zone disappear when you pre-
view or burn your DVD.

To add a video clip or image to a drop zone,
simply drag the clip or photo from a Finder
window and drop it on the drop zone. You can
also drag clips or photos from other sources,
including the Movie and iPhoto panes in iDVD,
the iMovie HD window, or the iPhoto window.
(Remember, Apple is anything but strict on
these matters.) Remember, drop zones don't act
as links or buttons to other content — the stuff
you add to a menu'’s drop zones appear only as
part of the theme’s animation cycle.

If you're adding something to a dynamic drop
zone (which disappears and reappears during
the menu animation cycle), click the Motion
button to activate the animation, and then click
it again to stop the animation cycle. Now click-
and-drag the scrubber bar until the desired drop
zone is in view. To delete the contents of a drop
zone, Control-click (or right-click) the drop zone
and choose Clear.

a\\J

To add a Movie button, drag a QuickTime movie file from the Finder and drop

it onto your DVD Menu display. (Note that only MPEG-4 QuickTime movies
are supported — older MPEG-1 and MPEG-2 movie clips may be rejected.)
Alternatively, launch iMovie HD and drag a clip from the iMovie HD clip

palette into the iDVD window, or click the Add button and choose Add Movie

from the drop-down menu.

iDVD and iMovie HD are soul mates, so you can also display the iDVD Media
pane and then click Movies from the pop-up menu. Now you can drag clips

from your Movies folder.

No matter the source of the clip, when you drop it onto your DVD menu,
iDVD adds a Movie button, as you can see in Figure 14-4. Note that some but-
tons appear as text links rather than actual buttons. The appearance of a
Movie button in your DVD menu is determined by the theme you choose.

A Movie button doesn’t have to stay where iDVD places it! To move a Movie
button to another location, click-and-drag it to the desired spot. By default,

iDVD aligns buttons to an invisible grid. If you don’t want such order imposed

on your creativity, turn off this grid function by clicking the button to select
it, clicking the Buttons button (at the bottom of the Media pane), and select-
ing the Free Positioning radio button.
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You can have up to 12 buttons on your iDVD Menu. To add more content than
12 buttons allow, add a submenu by clicking the Add button and choosing
Add Submenu from the drop-down menu. Now you can click the submenu
button to jump to that screen and drag up to another 12 movie files into it.

Q‘&N\BEH Keep in mind your target audience while you create your DVD. Standard TV
& sets have a different aspect ratio (height to width) and resolution (number of
pixels on the screen) than a digital video clip, and a standard TV isn’t as pre-
cise in focusing that image on the tube. If you selected the Standard aspect
ratio when you created the project, you can make sure that your DVD content
looks great on a standard TV screen by following these steps:

1. Click View on the old-fashioned iDVD menu (the one at the top of the
screen).

2. Choose the Show TV Safe Area command.

You can also press the convenient $8+T shortcut. iDVD adds a smaller
rectangle within the iDVD window to mark the screen dimensions of a
standard TV.

If you take care that your menu buttons and (most of) your background
image fit within this smaller rectangle, you're assured that folks with a stan-
dard television can enjoy your work. To turn off the TV Safe Area rectangle,
press $8+T again.
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|
Figure 14-5:
Who needs
a projector
anymore?
iDVD can
create a
great
slideshow.
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If your entire family is blessed with a fleet of HD TVs (or you chose the
Widescreen aspect ratio for this project), leave the Show TV Safe Area option
off. Today’s widescreen displays can handle just about any orientation.

Great, now my audience
demands a slideshow

Many Mac owners don’t realize that iDVD can use not only video clips but
also digital photos as content. In fact, you can add a group of images to your
DVD Menu by using Slideshow buttons, which allow the viewer to play back a
series of digital photographs. iDVD handles everything for you, so there’s no
tricky timing to figure out or weird scripts to write. Just click the Add button
at the bottom of the iDVD window and choose Add Slideshow. iDVD places a
Slideshow button on your DVD Menu.

After the Slideshow button is on tap, you need to add the content — in this
case, by choosing the images that iDVD adds to your DVD Menu. Follow these
steps to select your slideshow images:

1. Double-click the Slideshow Menu button — the one you just added to
the menu — to open the Slideshow display (see Figure 14-5).
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2. Click the Media button (bottom right of the screen).

3. Click the Photos button (top right of the screen) to display your iPhoto
library and photo albums.

4. Drag your favorite image thumbnails from the Photos list and drop
them into the My Slideshow window.

You can also drag images straight from a Finder window or the iPhoto
window itself. (Those Apple folks are sooooo predictable.)

5. Drag the photos in the My Slideshow window around to set their
order of appearance in your slideshow.

6. To add audio to these pictures, drag your favorite audio file from the
Finder and drop it in the Audio well in the My Slideshow window.

The Audio well is the box bearing the speaker icon, next to the volume
control below the My Slideshow window.

Alternatively, click the Audio button to select an audio track from your
iTunes library, iTunes playlists, or GarageBand creations.

7. Click the Return button to return to your DVD Menu.

You can choose which image you want to appear on the Slideshow button.
Click the Slideshow button that you added and see the slider that appears
above the Slideshow button. Drag this slider to scroll through the images
you added. When you find the image that you want to use for the Slideshow
button in the DVD Menu, click the Slideshow button again to save your
changes.

Now for the music . . .

Most of the Apple-supplied themes already have their own background music
for your menu, so you might not even need to add music to your DVD Menu.
However, if you want to change the existing background music (or if your
menu currently doesn’t have any music), adding your own audio to the cur-
rent menu is child’s play!

1. Click the Media button.

2. Click the Audio button to reveal the musical Shangri-La shown in
Figure 14-6.

3. Drag an audio file from the iTunes playlist or GarageBand folder dis-
play and drop it on the menu background.

iDVD 6 accepts every sound format that you can use for importing (or
encoding) in iTunes: AIFF, MP3, AAC, Apple Lossless, and WAV audio
files.



22() Partiv: Living the iLife

|
Figure 14-6:
You'lldo a
lot of fine-
tuning from
the Settings
pane.
|

\\J

@ IDVD File Edit Project View Advanced Window Help 5 9 & < ™ ) Thulo7PM @

E phatcs | Mavies

|4 Bobby Darin - My Favorites
4| Boston - Boston

[#] Boston - Greatest Hits m
#1 BR349 - My Favorites

#| Cajun - Alligator Stomp

|| Cars - Candy-0

# Chicago - Grearest Hits

& Chieftains - Boil the Breakfast Early

| Chieftains - Chieftains 3

Chieftains - Chieftains 4

#| Chieftains - Chieftains 5

_#| Count Basie & Joe Willlams - Count

{41 Counring Crows - Films About Ghosts
& Dad's Best for June 2005

\#| David Bowie - Changesbowle

e

B

a

Narme: Artist Tirne

] Every Day | Hawe the Bues  Count Basi 529
] The Comeback CountBasi.. 5:28
i} In the Evening {When the. Count Basi 338
] Roll “Em Pere CountBasi.. 312
] Teach Me Tanight Count Basi... 3:04
i} My Raby Lpsets Me Count Basi 258

] Please Send Me Someon...  CountBasi., 333
) Bv'ry Day [ Fall in Love) Count Basi_.. 3:48

1 As | Love You Count Basi . 107
1 Siop! Don'tt CountBasi.. 236
] Tao Clase far Camfort CountBasi_..  2:53
™ o T Apoly )

ey ﬁ% | Themes  Menu | Bumons MQ

Alternately, you can click the song you'd like to use and then click Apply.

4. Click the Motion button (labeled in Figure 14-1) to watch your DVD
Menu animation cycle set to the new background audio.

5. Click the Motion button again to stop the animation and return to seri-
ous work.

Giving Your DVUD the Personal Touch

You can easily make changes to the default settings provided with the theme
you chose. iDVD offers all sorts of controls that allow you to change the
appearance and behavior of buttons, text, and the presentation of your con-
tent. In this section, [ show you how to cast out iDVD’s (perfectly good)
defaults and then tweak things to perfection.
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Using Uncle Morty for your
DUD Menu background

Hey, Uncle Morty might not be a supermodel, but he has birthdays and
anniversaries, and iDVD is more than happy to accommodate you in docu-
menting those milestones! Follow these steps to change the background
of your DVD Menu:

1. Click the Menu button.

2. Get an image using one of the following methods:

¢ Drag an image from the Finder and drop it into the Background
well in the Menu section.

¢ Drag the image directly into the Menu display.

¢ To use an image from your iPhoto library, click the Media button
and choose Photos, and then drag the desired image into the Menu
display.

iDVD updates the DVD menu to reflect your new background choice.

Adding your own titles

The one tweak you’ll probably have to perform in every iDVD project is
changing titles. Unfortunately, the default labels provided by iDVD are pretty
lame, and they appear in two important places:

v Menu title: Your large main title usually appears at the top of the DVD
Menu.
* Button captions: Each Movie and Slideshow button that you add to your

menu has its own title.

To change the text in your Menu title or the titles below your buttons, follow
these steps:

1. Select the text by clicking it.

2. Click it again to edit it.

A rectangle with a cursor appears to indicate that you can now edit the
text.

3. Type the new text and press Return to save the change.
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Changing buttons like a
highly paid professional

Customizing Movie buttons? You can do it with aplomb! Follow these steps:

1. Click Buttons.
2. Click any Movie button from the DVD Menu to select it.

A slider appears above the button, which you can drag to set the thumb-
nail picture for that button in your DVD Menu. (Naturally, this is only for
3 animated buttons, not text buttons.)

Enable the Movie check box to animate the button.

3. To create a Movie button with a still image, drag a picture from a
Finder window or the Media pane and drop it on top of the button.

4. Adjust the properties for the button as desired with the controls in the
Button section of the Media panel.

Table 14-1 describes the button properties.

Table 14-1 Button Settings You Can Customize

Movie Button Property What It Does

Style thumbnail Changes the frame shape of the Movie button.

Snap to Grid Forces placement of a Movie button on an imaginary grid.
Free Positioning Unlike Snap to Grid, allows Movie buttons to be placed in

a freeform arrangement.

Transition Determines the transition that occurs when the button is
clicked (before the action occurs).

Size Adjusts the size of the button and the caption text. Move
the slider to the right to increase the button and caption
size.

Give my creation motion!

Earlier in this chapter, you found out how to use a different image for your
background, but what about using an animated background? You can use any
QuickTime movie from your iMovie HD library to animate your DVD Menu
background! Didn’t I tell you that this iDVD thing was huge?
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\\3 Keep in mind that your background movie should be a short clip; 20-30 sec-
onds is optimal. A clip with a fade-in at the beginning and a fade-out at the
end is the best choice because iDVD loops your background clip continu-
ously, and your animated background flows seamlessly behind your menu.

é_‘,“‘ I'm not talking drop zones here. (See the sidebar, “Taking advantage of drop
zones.”) By using a movie clip as a background, you’re replacing the entire
animation sequence rather than just a single area of the background.

Follow these steps to add a new animated background:

1. Click your old friend, the Menu button.
2. Drag a movie from the Finder and drop it into the Background well.

You can click the Movies button in the Media pane to instantly display
your iMovie collection.

3. Click the Motion button in the iDVD window to try out your new
background.

4. Click the Motion button again to stop the animation cycle.

Previewing Your Masterpiece

Figure 14-7 captures the elusive Preview remote control — truly an awesome
sight. When you click Preview, the Media pane disappears, and your DVD
Menu appears exactly as it will on the finished DVD.

Ah, but appearances aren’t everything: You can also use your DVD Menu!
Click the buttons on the remote control to simulate the remote on your DVD
player, or think outside the box and click a menu button directly with your
mouse pointer. iDVD presents the video clip, runs the slideshow, or jumps to
a submenu, just as it will with the completed disc.

This is a great time to test-drive a project before you burn it to disc. To make
sure you don’t waste a blank DVD, make certain that everything you expect
to happen actually happens. Nothing worse than discovering that Aunt
Edna’s slideshow from her Hong Kong trip actually displays your family’s
summer trip to the zoo (whoops). If you made a mistake or something needs
tweaking, click the Preview button again, and you’re back to the iDVD
window proper, where you can edit or fine-tune your project.
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Figure 14-7:
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mode — an
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indeed.
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iDVD 6 allows you to save your project as a standard Mac OS X disc image
rather than as a simple project file (or a physical DVD) — a good idea for
those laptops without a SuperDrive on board, because you can use Apple’s
Disk Utility to open and mount the disc image as if it were a burned disc. If
you move the disc image to another Mac with a SuperDrive, you can use Disk
Utility to burn it on that machine. To save an iDVD project as a disc image,
choose File>Save as Disc Image (or press 8+Shift+R). For the complete word
on disc images, visit Chapter 21 — hey, you didn’t think I'd leave you out in
the cold, did you?

A Word about Automation

At the beginning of the chapter, | mention the easy way to produce an iDVD
disc or project, using either OneStep DVD (for complete automation) or
Magic iDVD (for partial automation). In this section, I provide you with the
details.
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One-click paradise with OneStep DVD

If you're in a hurry to create a DVD from clips on your DV camcorder and you
don’t mind losing your creative input, OneStep DVD is just the ticket. In short,
iDVD 6 allows you to plug in your DV camcorder, answer a question or two,
and then sit back while the application does all the work. iDVD 6 imports the
DV clips, creates a basic menu design, and burns the disc automatically!

Using OneStep DVD will appeal to any laptop owner with a SuperDrive. Right
after a wedding or a birthday, for example, why not produce a DVD that

you can give as a gift? Photographers who cover those same special events
might consider selling a DVD made with OneStep DVD. If you happen to cap-
ture something incredibly unique — such as a UFO landing or an honest
politician — you can use OneStep DVD to create an instant backup of the
clips on your DV camcorder. You can even keep your friends and family up-
to-date with the progress of your vacation by sending them a daily DVD of
your exploits! (You gotta admit, even Grandma would consider that eminently

sassy!)
Follow these steps to start the OneStep DVD process:

1. Click the OneStep DVD button on the iDVD 6 top-level menu (refer to
Figure 14-2).

Alternately, choose Filec>OneStep DVD. iDVD displays the dialog box
shown in Figure 14-8.

U . - .
If you want to use OneStep DVD with an existing movie on your laptop’s
hard drive, choose File>OneStep DVD from Movie instead. iDVD
prompts you for the video clip to use.
|
Figure 14-8:
Connect OneStep DVD
your DV To use OneStep DVD, connect your digital video camera to your
computer using a FireWlire cable. Then turn on your camera and
Camcor‘der, ;s make sure it's in VCR mode.
and Click OK and insert a blank disc. OneStep DVD rewinds the
O St tape, imports your video, and burns it to a DVD,
neStep
DVD does o)
the rest.
|

2. Following the prompts, connect the FireWire cable from your DV cam-
corder; then turn on the camcorder and set it to VCR mode.

3. Click OK.
4. Load a blank DVD.
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Exercising control with Magic iDVD

Got a little extra time? For those who prefer to make just a few choices and
let iDVD do the rest, the new Magic iDVD feature just plain rocks! However,
you can’t import clips directly from your DV camcorder like you can with
OneStep DVD — instead, you select one of the following:

v An iDVD theme

v Video clips you've already created with iMovie HD or dragged from the
Finder

v Photos from your iPhoto library or dragged from the Finder

v Audio from your iTunes playlist or dragged from the Finder
Follow these steps to start the OneStep DVD process:

1. Click the Magic iDVD button on the iDVD 6 top-level menu (refer to
Figure 14-2).
iDVD displays the window you see in Figure 14-9.

2. Click in the DVD Title box and type a name for your disc (or project).

3. Click to select a theme from the Theme strip.
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4. Click the Movies button and drag the desired clips into the Drop
Movies Here strip.

5. To add a slideshow, click the Photos button and drag the desired
photos into the Drop Photos Here strip.

6. To add audio for your slideshow, click the Audio button and drag the
desired song into the Drop Photos Here strip (a speaker icon appears
in the first cell of the strip to indicate that you’ve added a sound-
track).

7. Click Preview to see a preview of the finished project, complete with
remote control. To exit Preview mode, click Exit.

8. To open the project in its current form in the main iDVD window,
click Create Project.

9. To record your completed project directly to DVD, load a blank DVD
and click Burn.

To return to the iDVD main window at any time, just click the Close button on
the Magic iDVD window.

Recording a Finished Project
to a Shiny Disc

WING/
&

When you’re ready to record your next Oscar-winning documentary on family
behaviors during vacation, just follow these simple words.

1. Click the Burn button at the bottom of the iDVD window.

[ have to admit, the Burn button that appears has to be my favorite
single control in all my 20+ years of computing! It looks powerful, it looks
sexy ... it wants to burn. (Sorry about that.)

2. After iDVD asks you to insert a blank DVD-R into the SuperDrive, load
a blank DVD-R, DVD-RW, DVD+R, or DVD+RW (depending on the
media your Mac laptop can handle).

Your SuperDrive might be able to burn and read a DVD+R, DVD-RW, or
DVD+RW, but what about your DVD player? Keep in mind that only DVD-Rs
are likely to work in older DVD players. The latest generation of DVD play-
ers are likely DVD+R compatible as well, but I've seen only a handful of
DVD players that can handle rewriteable media at the time of this writing.
Therefore, remember the destination for the discs you burn and choose
your media accordingly.

After a short pause, iDVD begins burning the DVD. The application
keeps you updated with a progress bar.
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Hey, while you’re waiting, how about a timely book recommendation? If you
want to discover how to burn all sorts of data, audio, and exotic CD and DVD
formats, I can heartily recommend another of my books, CD & DVD Recording
For Dummies, 2nd Edition (Wiley). It’s a comprehensive manual for recording
on the Mac. You'll find complete coverage of the popular Toast recording
application from Roxio, too.

When the disc is finished, you’re ready to load it into your favorite local DVD
player, or you can load it back into your Mac and enjoy your work using
Apple’s DVD Player.

Either way, it’s all good!



Chapter 15
GarageBand on the Go

In This Chapter

Touring the GarageBand window

Adding tracks to your songs and podcasts
Resizing, repeating, adding, and moving loops
Adding just the right effect

Recording with a microphone or MIDI instrument

Importing your new hit into iTunes

Do you dream of making music? I've always wanted to join a band, but I
never devoted the time nor learned to play the guitar. You know the
drill: Those rock stars struggled for years to gain the upper hand over an
instrument, practicing for untold hours, memorizing chords, and . . . wait a
second. | almost forgot. You don’t need to do any of that now!

Apple’s GarageBand 3 (included in the iLife ’06 suite) lets a musical wanna-be
(like yours truly) make music with my MacBook Pro — complete with a dri-
ving bass line, funky horns, and a set of perfect drums that never miss a beat.
In fact, the thousands of prerecorded loops on tap in GarageBand even allow
you to design your music to match that melody running through your head,
from techno to jazz to alternative rock.

Oh, and did I mention that GarageBand 3 also produces podcasts? That’s

right, you can record your voice and easily create your own show, and then
share it with others from your iWeb site! Heck, add photos if you like. You'll
be the talk of your family and friends and maybe even your Mac user group.

This chapter explains everything you need to know to create your first song
(or your first podcast). I also show you how to import your hit record into
iTunes so you can listen to it on your iPod with a big silly grin on your face
(like I do) or add it to your next iMovie HD or iDVD project as a royalty-free
soundtrack.



230 PartIv: Living the iLife

Oh, and don’t be too smug when you think of all that practicing and hard
work you missed out on. What a shame!

Shaking Hands with YVour Band

As you can see in Figure 15-1, the GarageBand window isn’t complex at all,
and that’s good design. In this section, I list the most important controls so
you know your Play button from your Loop Browser button.

Podcast artwork track

Track list Playhead  Loop

Window Help Y 5 O o W o4 wed 10:47PM

‘arageBand - Mark's Example Song

@ GaragpBand (File Edit Track Control Share

Figure 15-1:
The Garage-
Band
window —
edgedin |
wood grain,
no less.
|

Timeline Play Time/tempo Volume  Track info
Return to beginning View/hide media browser
View/hide loop browser

Create a new track
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Your music-making machine includes

v Track list: In GarageBand, a frack is a discrete instrument that you set
up to play one part of your song. For example, a track in a classical piece
for string quartet would have four tracks — one each for violin, viola,
cello, and bass. This list contains all the tracks in your song arranged so
that you can easily see and modify them, like the rows in a spreadsheet.
A track begins in the list, stretching out to the right all the way to the
end of the song. As you can see in the upper-left of Figure 15-1, I already
have one track defined — a Grand Piano.

If you're creating a podcast, a Podcast artwork track like the one you see
at the very top of the list in Figure 15-1 can also appear.

v Timeline: This scrolling area holds the loops (see the following bullet)
that you add or record, allowing you to move and edit them easily. As a
song plays, the timeline scrolls to give you a visual look at your music.
(Bear with me; you’ll understand that cryptic statement in a page or two.)

v Loop: This is a prerecorded clip of an instrument being played in a spe-
cific style and tempo. Loops are the building blocks of your song. You
can drag loops from the loop browser to a track and literally build a bass
line or a guitar solo. (It’s a little like adding video clips to the timeline in
iMovie HD to build a film.)

v Playhead: This vertical line is a moving indicator that shows you the
current position in your song as it scrolls by in the timeline. You can
drag the playhead to a new location at any time. The playhead also acts
like the insertion cursor in a word processing application: If you insert a
section of a song or a loop from the clipboard, it appears at the current
location of the playhead. (More on copying and inserting loops later, so
don’t panic.)

v Create a New Track button: Click this button to add a new track to your
song.

v Track Info button: If you need to display the instrument used in a track,
click the track to select it and then click this button. You can also control
settings such as Echo and Reverb from the dialog box that’s displayed.

v View/Hide Loop Browser button: Click the button with the striking eye
icon to display the Loop Browser at the bottom of the window; click it
again to close it. You can see more tracks at a time without scrolling by
closing the Loop Browser.

v View/Hide Media Browser button: Click this button (which bears icons
of a filmstrip, slide, and musical note) to display the media browser at
the right side of the window; click it again to close it. By closing the
media browser, you’ll see more of your tracks. If you're already familiar
with iDVD or iMovie HD, you recognize this pane in the GarageBand
window — it allows you to add media (in this case, still images or video
clips) to your GarageBand project for use in a podcast.
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+ Return to Beginning button: Clicking this button immediately moves
the playhead back to the beginning of the timeline.

v Play button: Hey, old friend! At last, a control that you’ve probably
used countless times before — and it works just like the same control
on your audio CD player. Click Play, and GarageBand begins playing your
entire song. Notice that the Play button turns blue. To stop the music,
click Play again; the button loses that sexy blue sheen, and the playhead
stops immediately. (If playback is paused, it begins again at the playhead
position when you click Play.)

v Time/Tempo display: This cool-looking LCD display shows you the cur-
rent playhead position in secon